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PROLOGUE 

As a guide to in house Capital Projects, this manual is designed to standardize the 

process used to produce Capital Works engineering drawings. Standardization enables 

present employees to work consistently and effectively while giving new employees a 

format to follow when integrating their skills to their new position. 

There is a ‘quick list’ of the City’s in house process starting with Section 1. The City of 

Brampton design & drafting process, outlined in this manual, blends Inroads and 

Microstation commands. Design, profile creation and x-sections creation will be done 

through Inroads. Inroads commands are used to re-display modified features, and can be 

utilized to update x-sections rather than redrawing or regenerating them. Final cleanup, 

base plan preparation, utilities and underground information will be done using 

Microstation commands. This process is to be followed for all in house capital projects. 

There are three basic types of Capital projects covered in this manual... 

1. In house projects 

2. Contracted projects (including Landscaping and Structures work, contracted as 

part of an in house project) 

3. Contracted ‘as constructed’ projects 

Consultants will find a working guideline for Capital Works projects. Capital Works 

‘as constructed’ submissions provided to the City of Brampton must follow specified 

protocol as outlined in this manual. A list of required items for Capital Works projects and 

‘as constructed’ drawings, which will be reviewed in each submission, is included in the 

manual. 

Subdivision development submission of ‘as constructed’ information to the City of 

Brampton must follow specified protocol as outlined in the Development Digital 

Submissions Requirements Manual. A list of required items, which will be reviewed in each 

submission, is included in that manual. 

Any changes that occur to the document will necessitate an updated manual being 

printed for each employee.  This will create consistent and accurate output from, and for, 

Public Works, Capital Construction & Engineering Department at the City of Brampton. 

Processes are outlined for reviewing PUCC, Site Plan and Subdivision/Development 

applications. 

Samples are also provided at the end of this manual for some of the templates, 

forms, spreadsheets and drawings utilized by the Capital Engineering section for 

application reviews and Capital works projects.  
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CAPITAL WORKS DELIVERABLES 

This package is maintained by the Capital Construction & Engineering Department. 

It contains all information required by a consultant to produce drawings for our capital 

projects. 

This folder is updated periodically as processes and / or seed files are modified so 

always burn the CD at the time it is required. 

The package contains the seed files and directions required to achieve City of 

Brampton, Construction & Engineering standards. 

The projects this would apply to include… 

 A contracted Capital works design. 

 Any contracted portion of an In House Capital works design, such as structures 

or landscaping. 

 Any ‘as-constructed’ drawings being completed by a consultant for a 

completed Capital project. 

This folder, with all its sub-folders, is under G:\wtdesign\CONSULTANTs CD burn\ 

For In House Capital projects, all the information and seed files required can be 

found in our Engineering Standard Setups folder and its sub-folders. 

ENGINEERING STANDARD SETUPS 

This is a list of the design related files and folders found in 

G:\wtdesign\Engineering Standard Setups\ 
 256PLOT.CTB 

 256PLOT.TBL 

 BRAMPTON.itl 

 BRAMPTON.pltcfg 

 BRAMPTON.xin 

 BRAMPTONroll.pltcfg 

 font.rsc 

 lstyle.rsc 

 SEED-2DUTM.dgn 

 SEED-3DUTM.dgn 

 \_IN-HOUSE FILE STRUCTURE – Street – From – To 
 Contains all the folders required for a given project and is copied in it’s entirety to create 

the contracts working directory.  

See CONTRACT DIRECTORY STRUCTURE FOR IN HOUSE DESIGN (SECTION 8.3) 

 \_LIGHTING PACKAGE 
 Contains all the files required for lighting drawings 
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 \_TRAFFIC PACKAGE 
 Contains all the files required for traffic drawings 

 \DESIGN CELL LIBRARIES 
 Contains cell libraries utilized for design and patterning, including logos and radius 

templates for turning radius checks 

 \DESIGN DRAWING BASES 
 Contains drawing bases for contract drawings and title sheets as well as bases for required 

miscellaneous drawings that are not necessarily part of a contract set. 

 Contract base drawings are named so as to describe the function and location of the plan 

within the contract set. 

 Miscellaneous drawings are identified as ‘MISC-REQUESTS…’ With the size of plan indicated 

in the title, and for the smaller two sizes the file contains both landscape and portrait 

orientations of the base. 

 \DESIGN SAMPLES 
 Contains samples of completed drawings and spreadsheets 

 \DESIGN SPREADSHEETS 
 Contains spreadsheets for calculation of cut/fill quantities, storm design, hydro elevations, 

circulation comments, CADD review comments, etc. 

 \DESIGN TEMPLATES and CHECKLISTS 
 Contains templates of letters and memos to be used as needed for circulations, 

transmittals, checklists etc. 

 \EXTERNAL LINKS 
 Contains shortcuts and hyperlinks to reference materials, web pages and drawings. 

 \MISC DETAILS—INTERNAL USE ONLY 
 Contains a culmination of details that have been used on previous contracts and may be 

used as needed instead of creating a new detail every time. 

 \PRELIMINARY ESTIMATES 
 Contains an assortment of previous estimates that can be used to generate a preliminary 

estimate. 

 \PROPERTY PACKAGE BASES 
 Contains the Microstation files required for producing the Property Base Map and the IPRP 

drawings, including samples as well as links to the documents & spreadsheet found in the 

Appendix A package under the Property Closeout Report folder 

 \PUCC 
 Contains the application generator for PUCC circulations 
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1. QUICK LIST OF IN HOUSE DESIGN PROCESS 

1) RETRIEVE FROM ENGINEERING STANDARD SETUPS FOLDERS... 

 Retrieve the folder in G:\wtdesign\Engineering Standard Setups\,  ’_ IN-HOUSE FILE 

STRUCTURE - Street - From - To’, with all its sub folders and copy it to the appropriate 

street directory under G:\wtdesign\Street Names – CONTRACTS\”streetname”\. 

Change the main folder name, ‘_IN-HOUSE FILE STRUCTURE…’, to represent the 

project file number, street name and description. (i.e. ##-####-### - Project Street 

Name - Road A to Road B) 

 Retrieve from the G:\wtdesign\Engineering Standard Setups\DESIGN TEMPLATES 

and CHECKLISTS\ folder the Design Criteria template and copy it into the 

COMMUNICATIONS folder within your project folder. Rename it to identify the 

project information and remove the write lock on the file. 

 Retrieve the preference and template files, ‘BRAMPTON.xin’ & ‘BRAMPTON.itl’ and 

copy them to the INROADS folder, you can rename them ‘streetname.xin’ & 

‘streetname.itl’ respectively. 

 From SubFolder \DESIGN DRAWING BASES\ Retrieve the drawing files ‘4-

PLANnPROFILE-sheet-2D.dgn’, ‘1-TITLEPAGE-2D.dgn’ and ‘2-DGN_LISTPAGE-2D.dgn’ 

and copy them into the project’s main directory. Rename them to ‘PnP-

Streetname.dgn’, 00-Dwg#_TITLEPAGE.dgn, 00-Dwg#_DGN_LISTPAGE.dgn’ 

respectively. 

See GETTING READY – GATHERING FILES (SECTION 8.2) 

2) RETRIEVE FROM THE SURVEY GROUP... 

 Retrieve the surface file ‘streetname-base.dtm’ and copy it into the INROADS 

folder. 

 Retrieve the drawing file ‘streetname-base.dgn’ and copy it into the project’s main 

directory. You will place a second, write protected copy, into the survey data 

folder. (as a backup for checking original survey data) 

3) GENERATE NEW DRAWINGS... 

 Working in the main project directory, create a copy of ‘streetname-base.dgn’ 

and rename it ‘streetname-DESIGN.dgn’  

 Open streetname-DESIGN.dgn in Microstation 

 Turn on ALL levels and delete ALL information in this drawing file 

 Reference ‘streetname-base.dgn’ 

 Attach cell library ‘BRAMPTON CELLS V8i.cel’ (in Engineering Standard 

Setups\DESIGN CELL LIBRARIES) 

 Save the settings 

 In drawing ‘streetname-DESIGN.dgn’ Select >File >Save As and create files named 

‘streetname-PROFILE.dgn’, ‘streetname-UTILITIES.dgn’, ‘streetname-SECTIONS.dgn’, 

‘streetname-WORKING.dgn’, ‘streetname-PROPERTY.dgn’ and so on... 

See CREATE DRAWING SHEETS (SECTION 20.5) 
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4) CIRCULATE PRE-ENG PUCC 

 Copy the circulation letter ‘PUCC-1 – PRE-ENG Letter.docx’ to the appropriate 

folder and rename to reflect project information. 

 Forward to the Sr. Secretary (Lucia), via email, for generation of cover letters to the 

utilities’ PUCC coordinator. 

 Sign the letters returned to you. 

 Return the signed letters, along with the folded packages, using strip plans if 

necessary, to Lucia to have the packages prepared for the circulation/courier. 

See ENGINEERING SUBMISSIONS (SECTION 2.1) 

5) GENERATE PROPERTY DRAWING... 

 Populate the property drawing in the REALTY folder, with information from the 

Teranet block files in M:\Vector\Prop\ 

 Include any EA information available for required properties. Ensure that any 

ongoing property acquisitions are included in the process. 

 Ensure that the correct ROW levels are being used. 

 Upon approval of the property plan, from Surveys section, create Individual 

Property Request Plans (IPRP’s) for each affected property. 

See PROPERTY BASICS (SECTION 9) 

6) DESIGN FLOW 

 Open either the DESIGN file or a WORKING file in the main directory 

INROADS COMMANDS… 

 Load preference file (xin) 

 Load template library (itl) 

 Load existing surface (dtm) 

 Create names for geometry (alg) and surfaces (dtm) 

 Create geometry project (rwk) 

 Import property fabric to utilities dtm (draping elements on existing surface) 

 Populate Horizontal alignments (Main Street and Cross Roads or T Intersections) 

 Add Horizontal event points (driveways, connecting walkways...) 

 Display Horizontal alignments to verify 

 Display stations on Horizontal alignment 

 Generate profiles 

 Populate Vertical alignments (Main Street and Cross Roads or T Intersections) 

 Annotate Profiles 

 Annotate Vertical Alignments 

 Use ‘Review Horizontal Geometry’ to cut and paste curve data for plan 

 Create Horizontal / Vertical alignments for the quadrants of any Cross Roads and T-

Intersections 

 

MODIFY TEMPLATES... 

 Modify templates to suit project 
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CREATE ROADWAY FILE 

 Create a new roadway file in Roadway Designer (ird) 

ADD CORRIDORS 

 for Main Street, Cross Roads and T Intersections 

TEMPLATE DROPS 

 Specify which templates are dropped at what stations for each corridor and the 

intervals for the remaining distance to the next template drop 

TARGET ALIASING 

 Set target surface as existing and select clipping corridor for each corridor (the 

alias is the corridor which will be clipped) 

POINT CONTROLS 

 Add point controls to stretch template(s) using features such as EP on storage and 

taper sections (offset is measured from c/l of template) 

TOOLS >> PARAMETRIC CONSTRAINTS 

 Use parametric constraints to modify feature widths such as EP or LTL for turn lanes, 

or KS for working around bus pads. This works like Point Controls but the offset is 

measured from previous feature, instead of the c/l of the template. 

END CONDITION EXCEPTIONS 

 Allows you to override the template for a specified length of the active corridor 

DISPLAY REFERENCES 

 Allows you to display alignments and/or features in the plan view of the Roadway 

Designer interface 

SECONDARY ALIGNMENTS 

 Allow you to redirect the features in the Primary Alignment using an additional 

alignment (horizontal and/or vertical) in Point Controls 

KEY STATIONS 

 Input stations where you specifically want a template to be placed in addition to 

the ones placed at the interval placement specified i.e. critical template drops 

such as taper change point, end of radius 

CREATE SURFACE 

 Name the new surface PROPOSED and specify the corridors to be included in 

surface creation, then apply 

 Adjusting the settings will allow you to create the design surface and an alternate 

surface (LIMESTONE), and display the features in the plan 
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SAVE 

 Save the new surface (PROPOSED) 

 Change surface properties to be displayed as feature style “PROPOSED” 

RE-SAVE GEOMETRY PROJECT 

 Use ‘save as’ to add the new surface to the roadworks file (rwk) and overwrite the 

previous file 

MODIFY FEATURES 

 Create a smoother surface by matching the sidewalk feature to a curb radius and 

adjusting features at intersections and corridor junctions 

DRAWING CREATION... 

 Create Base sheet(s) 

 Populate PnP drawing with all common information (key plan, street name, 

legend...) 

 Create Drawing sheets 

 On an ongoing basis, add Pre Eng utilities circulation information received. 

See CONTRACT DRAWING PREPARATION (SECTION 20) 

GENERATE CROSS SECTIONS 

See CROSS SECTIONS – INROADS |EVALUATION (SECTION 26) 

CALCULATE VOLUMES 

 Generate an End Area Volume Report for granular quantities, then another for 

limestone quantities using the alternate surface LIMESTONE 

See END AREA VOLUMES (SECTION 29) 

POPULATION OF CUT/FILL SPREADSHEET 

 Use values from End Area Volume Reports to populate the cut/fill spreadsheets and 

modify for intersections or other discrepancies, label these calculations as 

GRANULAR or LIMESTONE 

 If an alternate surface was not used, copy GRANULAR sheets and adjust for 

LIMESTONE by measuring the difference on the cross sections and adjusting the 

figures accordingly. 

DRAFTING WORKS... 

 Complete the title page and drawings list page 

 Add shading, patterns and hatching 

 Add labels to plan and profiles 

 Set up profile to match page breaks, duplicate information between sheets 

 Add grading and storm pipe information to profile 

 Adjust elevations and stations on profile so that it will be displayed in the correct 

location on each sheet 

 Create REMOVALS drawings (Sheet#-Dwg#-REMOVALS.dgn) 
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 Create DIMENSIONS drawings (Sheet#-Dwg#-DIMENSIONS.dgn) 

 Create Details and/or Typicals drawing(s) (Sheet#-Dwg#-DETAILS.dgn / Sheet#-

Dwg#-TYPICALS.dgn) 

 Create Pavement Markings drawings (Sheet#-Dwg#-PVMNT-MKGS.dgn) and copy 

all associated files to G:\wtengmain\pavement mkgs\streetname\ 

 Create Pavement Elevations drawings at 1:250 scale, for intersection grading 

(Sheet#-Dwg#-ELEV-STREET.dgn) 

 In streetname-QUANTITIES.dgn outline areas of asphalt, sod, sidewalk, multi use 

path... and reproduce lengths of storm lines and leads to facilitate measurements 

 Create a list of quantities in the drawing from the shapes and lines drawn, this will 

be modified as necessary by crossing out the existing information and adding the 

new measurements 

 Produce a spreadsheet outlining quantities to be provided to the project manager. 

A sample of this spreadsheet can be found in Engineering Standard Setups\DESIGN 

SAMPLES (Streetname-Quantities.xlsx)  

See FINAL CHECKLIST – COMPLETING THE PACKAGE (SECTION 31) 

PLOT CONTRACT DRAWINGS 

 Generate ‘i’ files, and place in the ‘PRINT FILES’ directory, for both full and half scale 

prints (corner points have been set up for both in the base drawings to allow for a 

true half scale plot on 11x17 paper) 

 Create ‘ips’ files in the ‘PRINT FILES’ directory to include all the ‘i’ files for each scale 

set 

 Generate PDFs to be used for printing 

See PLOTTING CONTRACT DRAWINGS (SECTION 30) 

7) PROJECT CIRCULATIONS 30/60/90/TENDER/CONSTRUCTION 

 Provide a hard copy of the master list to the Project Manager to identify those to 

whom the submission is NOT being circulated. These contacts will remain on the list 

with a note in the address area ‘NOT CIRCULATED’. For sections that have two 

names, add a note in the address area either ‘ONE COPY EACH’ or ‘SHARE ONE 

COPY’. 

ISSUED FOR TENDER DRAWINGS 

 Prior to plotting the Issued for Tender Drawings, digital files are to be submitted to 

Doug Lawr (Surveys Group) for property review. Provide surveys with a folder 

location for the property drawing. 

 When an email has been received from Surveys confirming the property 

information, the drawings can be plotted, sealed and signed 

See ENGINEERING SUBMISSIONS (SECTION 2.4) 

DESIGN HANDOVER DRAWINGS (ISSUED FOR CONSTRUCTION) 

 Final sheet drawing files to include only those references which are shown in the 

drawing. Remove any references used for information but not utilized in the final 

product. 
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 Complete the DESIGN CD Handover Checklist and ensure that all information is 

included for the CD. There is a file structure set up for the handover CD, it can be 

found in Engineering Standard Setups. 

See APPENDIX 4 (SECTION 33.4.XII) 

QUICKLIST OF ISSUED FOR CONSTRUCTION CD HANDOVER CONTENTS... 

 Appendix A package 

 Title Page & Drawings List Page 

 Removals 

 New Construction 

 Traffic Control (City & Peel Region) 

 Street Lighting 

 Dimensions 

 Structural 

 Culverts 

 Pavement Markings  

 Landscaping 

 Watermain / Sanitary (Peel Region) 

 Cross Sections 

 Inroads 

 Survey Surface 

 Property Plan and layout file (Provided by Surveys section) 

 PDF set of drawings 
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2. ENGINEERING SUBMISSIONS 

The folders have been set up for all the submissions in the file structure you copied 

from the Engineering Standard Setups folder. 

See CONTRACT DIRECTORY STRUCTURE FOR IN HOUSE DESIGN (SECTION 8.3) 

1) PRE-ENG PUCC SUBMISSION 

 Complete the Pre Eng Letter (PUCC-1 – PRE-ENG Letter.docx) copied from the 

Engineering Standard Setups/DESIGN TEMPLATES and CHECKLISTS to the folder 

named Pre Eng PUCC under DIGITAL SUBMISSIONS. 

o Project number MUST BE INCLUDED on letter. 

 Email completed letter to Sr. Secretary (Lucia) for generation of the letters to the 

utilities’ PUCC coordinator 

 Send project drawings out for copies, you will need eight (8) full size, folded hard 

copies, 

o When you send out the plan(s) for copying, request a PDF copy and place it 

in the folder DIGITAL SUBMISSIONS/Pre Eng PUCC. This will ensure you have a 

static copy of what was sent 

 Sign the letters returned to you 

 Return the signed letters, along with the folded packages, to Sr. Secretary (Lucia) to 

have the packages prepared for the circulation/courier 

Note the Utility File/Reference number on the status sheet, if one is provided…this 

reference is to be used for all future correspondence and circulations to the utilities 

See APPENDIX 3 (SECTION 33.3.V) 

ADD UNDERGROUND UTILITIES TO THE PLANS AS THEY ARE RECEIVED 

The linework will need to be added to either the DESIGN file or the EXISTING base plan as 

well as the UTILITIES plan to be used to add the information as features to UTILITIES.dtm for 

display on cross sections. 

See IMPORTING FEATURES (SECTION 13) 

Copy ...\Engineering Standard Setups\PUCC STATUS.xlsx to the Contract Directory 

under COMMUNICATIONS…rename it to “COLLECTOR PUCC STATUS.xlsx”.  Keep this file 

updated with current status information i.e. dates, information format, special 

considerations, contacts...  

2) 30 & 60 PERCENT SUBMISSIONS 

In Engineering Standard Setups/DESIGN SPREADSHEETS you will find a circulation 

comments spreadsheet to be modified with the appropriate contract information. The 

distribution sheet is always to be retrieved from Engineering Standard Setups, to ensure 

that you are using the latest list, it is updated as contact information changes. 
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 Complete project information in header/footer of the circulation lists (Capital Projects 

– Design Circulation-INTERNAL.docx & Capital Projects – Design Circulation-

UTILITIES.docx) 

o Be sure to place the reference # received from the Pre-Eng Circulation, for each 

utility, in the column provided; these drawings may be bound and rolled  

 Provide hardcopies of the distribution lists to the Project Manager; PM is to strike out 

any contacts that will not be included in the circulation 

 The uncirculated contacts will remain on the list, to identify them, replace and 

highlight, ‘DateS’ in the ‘Date Sent for Review’ column with ‘NOT CIRCULATED’. 

 Circulations will be done through the portal; however contacts that are receiving hard 

copy drawings will require a highlighted note in the address area. Identify the number 

and size of the drawings to be provided… Number of FULL SIZE, Number of HALF SIZE. If 

there are two contacts named, identify the drawing recipient(s) with a highlighted 

note either ‘ONE COPY EACH’ or ‘ONE COPY to Name’ 

 Determine the required number of copies from the distribution sheets reviewed by the 

PM 

 Coordinate with the Engineering Technician (Sandra) to have the drawings sent to MC 

Reproductions for copies, order enough copies for all of the external contacts that 

remain on the circulation list, as well as the internal contacts identified on the inter-

office distribution sheet to receive a hard copy. 

 At the same time, have MC scan the drawings to PDF files to be provided on a CD. 

Standard verbiage on the MC form is to be as follows… 

“Please scan a complete set to PDF format, 300dpi, with drawing number as name.” 

 Provide the Project Coordinator (Shamsul) with the CD (of PDF file(s)), distribution lists, 

the comments spreadsheet (with the project information completed) and the hard 

copy drawings. Shamsul will… 

o Combine the PDF files, if necessary, and place them/it on the portal for review 

by inter-office contacts 

o Distribute the inter-office copies 

o Co-ordinate with Lucia for courier to external contacts 

 Shamsul will send out emails with notification of the circulation with a CC to the 

designer & PM. The email to internal contacts will have a link to the portal location, 

and the verbiage on the internal email is to read… 

 

“Hello All, 

Please be advised that the XX% design drawings for the STREET-LOCATION project, being 

undertaken by the City of Brampton, can now be found on our portal for review. If you 

receive a hard copy, it will be distributed to you shortly. 

Please use the link below to provide your comments, on or before DD/MON/YR. If you 

have not provided your comments by this deadline, it will be assumed that you have NO 

comments. 

If you have designated another to review this project, please ensure that they have this 

email and utilize the link below to review the project and provide their comments on the 

portal. 

 

Portal Link Here 
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Thank you for your cooperation. 

 

Best Regards, 

Shamsul Huda 

Project Coordinator 

Planning & Infrastructure Services Department 

Public Works Division, Capital Works Section 

Capital Engineering 

phone…fax…email….” 

 

 An email, with the following verbiage, and the Excel spreadsheet ‘Capital Projects – 

Design Circulation-Comments.xlsx’ attached, will be sent to the utilities/external 

contacts. 

 

“Hello All, 

Please be advised that the XX% design drawings for the STREET-LOCATION project being 

undertaken by the City of Brampton, will be distributed to you shortly. 

Please use the spreadsheet attached to provide your comments, on or before 

DD/MON/YR. If you have not provided your comments by this deadline, it will be assumed 

that you have NO comments. 

If you have designated another to review this project, please ensure that they have this 

email and utilize the attached spreadsheet to provide their comments. 

Utilities… 

Please be advised that these drawings are being distributed, for your information. 

This is not a markup request; it is to keep you abreast of the design progress for the above 

project.  

A separate circulation will be done for PUCC review. 

 

If you have any questions, or concerns, please feel free to contact me. 

Best Regards, 

Shamsul Huda 

Project Coordinator 

Planning & Infrastructure Services Department 

Public Works Division, Capital Works Section 

Capital Engineering 

phone…fax…email….” 

 

See APPENDIX 3 (SECTION 33.3.VII & SECTION 33.3.VIII) 
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ASSIGN DRAWING NUMBERS 

At the 60% submission stage, provide the Intermediate Engineering Technician with 

a small hardcopy of the drawings on which they will note the assigned drawing numbers. 

Incorporate these numbers in the drawing file name, index sheet and drawing number 

spreadsheet. As new drawings are created, a small copy is to be provided for numbering. 

See ASSIGNING NUMBERS FOR CONTRACT DRAWINGS (SECTION 20.2) 

3) 90 PERCENT SUBMISSIONS AND FINAL PUCC 

At the 90% submission stage, add thirteen folded copies of the plan and profile drawings 

for the Final PUCC. This PUCC submission requires that all contract drawings be included. 

The blank form, found in Engineering Standard Setups/DESIGN TEMPLATES and CHECKLISTS, 

can be copied to this folder and modified with all the pertinent project information. 

See APPENDIX 3 (SECTION 33.3.VI) 

 Repeat steps outlined in the 30%/60%  

 In addition to the internal & utilities circulations, the final PUCC circulation is to be done 

at this time 

 Print and complete the blank form (PUCC-2 – FINAL Submission Form.docx) 

 Provide the completed PUCC form and thirteen (13) sets of folded hard copies to the 

Project Coordinator (Shamsul).  Shamsul will provide the PUCC number, generate the 

PUCC application forms for the utilities and circulate the packages, working with Lucia 

as needed for courier delivery  

 The Project Coordinator will provide a PUCC number, circulate the drawings to the 

utilities and track the responses. You will need to check in with them periodically to 

determine the status of the responses. 

 

Copies being made for all submissions will include the request to provide a PDF copy on 

disk. The note on the order form will be... 

”Please scan a complete set to PDF format, 300dpi, with drawing number as name.” 

These PDF drawing files will be placed in the submissions folder, along with the 

comment sheets, distribution sheet and any other information provided by the reviewers, 

as a static record of the submission and responses. 

For contract circulations having upwards of 100 plans, discuss with the Project co-

ordinator the possibility of providing CDs of the package, in lieu of hard copies, for the 

final PUCC. A hard copy will be required should one be requested by any of the utilities. 
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NEW HEADER/FOOTER LAYOUT FOR CIRCULATION LISTS 

The header has now been set up as a ‘form’, with areas to be completed either 

with text or using a dropdown menu 

 

 

At 30 and 60 percent, the field on the lower right of the header is to be removed 

(highlight and add a space) 

Utilities are to have the corresponding reference number in the last column 

At 90 percent, include the PUCC number Shamsul has provided you 

 

All correspondence is to contain the applicable reference/file numbers; this will 

reduce confusion when submitting the various circulations and improve turnaround times 

for PUCC. The goal here is to connect the utilities’ reference number and our PUCC 

number to provide continuity throughout the project. 
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4) ISSUED FOR TENDER AND ISSUED FOR CONSTRUCTION 

Prior to plotting the Issued for Tender Drawings, digital files are to be submitted to 

Doug Lawr (Surveys Group) for property review. The property will be compared to a plan 

developed in Surveys Group using Realty information with respect to the property 

acquisition status. This plan will ultimately be provided to the CA as a final property 

information package. 

When an email has been received from Surveys confirming the property 

information, the drawings can be plotted, sealed and signed. 

 

 

If this has been completed, the information can be used in place of the previous 

property plan information for the printing of the Issued for Construction drawings. 

 

 

Determine, with the Project Manager, how many full size copies (1:500) will be 

needed and how many half size (1:1000 on 11”x17”). As with the previous submissions, you 

will be adding a note to the printing order form for PDF files. This note will read as follows... 

”Please scan a complete set to PDF format, 300dpi, with drawing number as name.” 

These PDF drawing files will be placed in the appropriate folders as a static copy of 

the drawings provided for these submissions. The PDF files can quickly be printed as a full 

size (24”x36”) or half size (11”x17”) as needed. 

A PDF copy of the construction drawings will also be provided to the successful 

bidder on the Tender along with all the Microstation files and other information as 

indicated on the checklist for the Issued for Construction handover. This form must also be 

signed off by the survey and design supervisors. 

See APPENDIX 4 (SECTION 33.4.XII) 
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3. CIRCULATION FORMS & CHECKLISTS 

1. FORMS 

There have been forms created for most of our circulations. These will be utilized by 

the design group when circulating plans/packages to internal and external reviewers. Our 

form letters are available in Engineering Standard Setups\DESIGN TEMPLATES and 

CHECKLISTS... and are to be copied to the appropriate project folder, as needed. 

 

 

PUCC applications received for review and approval on, or near, a capital project 

that is being done by a consultant are to be circulated to the consultant through the 

project manager. The project manager is to initial the top of the PUCC form to indicate 

that they are aware of the work proposed by the utility in the area of their project. 

See REVIEW OF SUBMISSIONS FROM EXTERNAL SOURCES (SECTION 5) 

Each template is named according to the situation, in which it will be used, with a 

few generic templates for use as needed. If you are required to circulate information, 

check here to find the appropriate template to use. More are created as the need arises. 

 BLANK Letterhead.docx 

 General MEMO Form.docx 

 General TRANSMITTAL Form.docx 

 General UTILITIES Markup Request.docx 

 PUCC-1 – PRE-ENG Letter.docx 

 PUCC-2 – FINAL Submission Form.docx 

 Capital Projects – Design Circulation-INTERNAL.docx 

 Capital Projects – Design Circulation-EXTERNAL.docx 

 PUCC – CONSULTANT circulation – Memo.docx 

 Siteplan – CONSULTANT circulation – Memo.docx 

 Siteplan – INTERNAL circulation – Memo.docx 

 Siteplan Review – SP XXX-XX – COMMENTS.docx 

 Subdivision – CONSULTANT circulation – Memo.docx 

 Subdivision – INTERNAL circulation – Memo.docx 

 Subdivison Review – DSRXX-XX-XX – COMMENTS.docx  

   

  

See APPENDIX 3 (SECTION 33.3) 
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2. CHECKLISTS 

There have been checklists created for each type of review that we do and, as 

with the circulation documents, these are named for their use. 

They have been designed to be easy to follow and fill out, with check boxes for 

each item of review. 

Checklists include… 

Capital Projects – Design In House 

Capital Projects – Design by Consultant 

Capital Projects – As Constructed Review 

Development – As Constructed Review. 

See APPENDIX 4 (SECTION 33.4) 

4. REQUIREMENTS FOR SUBMISSIONS FROM CONSULTANTS 

1. FILE STRUCTURE TO BE USED FOR CONSULTANT SUBMISSIONS... 

This is what you should find on the Issued for Consruction CD received from the 

consultant 

 PROJECT FILE NAME, NUMBER & DESCRIPTION – SUBMISSION STAGE 

 

 CONSTRUCTION - DGNS 

 ALL existing, design and contract drawings including all references 

 

 CONSTRUCTION - INROADS 

 ALL InRoads files associated with the capital works portion of the contract 

 

 DESIGN BRIEF 

 Report of design criteria, project challenges and solutions 

 

 SURVEY 

 One plan containing triangles and contours of the original surface 

Sub folders may be created for any additional information or calculations etc. 

A copy of this page is included in Capital Works Deliverables, in the folder 

(‘_CONSULTANT FILE STRUCTURE - …’ containing all the folders to be used by consultants. 
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2. FILE STRUCTURE TO BE USED BY THE CITY’S TECHNOLOGIST WHEN 

CREATING THE “CD’S FOR HANDOVER”... 

In a folder named ‘_CD for DESIGN HANDOVER FILE STRUCTURE – Street-Date’, the 

following folders will be created and populated. 

 CAPITAL WORKS DELIVERABLES 
     Copy the folder ‘Capital Works Deliverables’, from wtdesign/CONSULTANTs CD burn 

 PROJECT FILE NAME, NUMBER & DESCRIPTION – SUBMISSION STAGE 

CONSTRUCTION - DGNS 

 ALL design and contract drawings including all references 
     From Consultant Submission 

 CONSTRUCTION - INROADS 

 ALL InRoads files associated with the capital works portion of the contract  

    From  Consultant Submission 

 CONSTRUCTION - PDFS 

 ALL contract drawings 
     From  Consultant Submission 

 LAYOUT 

 Final property plan, with aerial and text file of layout points (provided by 

surveys) 

     From  Surveys Group 

 SURVEY 

 One plan containing triangles and contours of the original surface 
     From Consultant Submission 

3. BASIC REQUIREMENTS FOR ALL SUBMISSIONS 
(PRIOR TO ISSUED FOR CONSTRUCTION) 

 All base plans are to be 3D and georeferenced. Elements that have been surveyed, 

and features that have been generated through design programs such as Inroads, are 

to have true X,Y,Z coordinate locations. (Planar information is only acceptable for 

design work at the 30% stage) 

 Elements such as linework placed for utilities, notes, shading and plate information can 

be planar. (Refer to levels chart in this manual for settings and elevations for shading 

and patterning) 

 ALL PLANS MUST BE GEOREFERENCED 

 The following design files may be submitted in 2D. 

o Landscaping 

o Streetlighting 

o Traffic Signals 

o Structures 

o X-Sections 

o Details 

o Pavement Markings 

Review plans in an iso view to find, and correct, linework which is neither planar nor in its 

correct special location. 

See APPENDIX 5 (SECTION 33.5.IV) 

 Base plans and profiles are to be referenced to sheet drawings, not merged. 

 References are to have NO live nesting 

 Each drawing file is to contain only one drawing, view ports are not permitted. 
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 Each folder is to contain both sheet drawings and referenced drawings. Do not 

separate sheet drawings and their references. 

 Digital drawings required for each submission must be consistent with the provided 

hard copy drawings. Each submission must be complete with... 

 Title pages 

 Removals 

 New construction 

 Traffic control 

 Street lighting 

 Dimensions 

 Landscaping 

 Pavement markings 

 Property 

 InRoads files. 

 Watermain, sanitary, structural and culverts to be included if applicable. 

4. REVISIONS SUBMISSIONS PROVIDED AFTER “ISSUED FOR CONSTRUCTION” 

 All changes post “Issued for Construction” will be identified as revisions 

 “Issued for Tender” and “Issued for Construction” notes made in the revisions chart 

shall remain, each group of subsequent changes will be noted under the 

respective revision number 

 Each revision will include all changes made at that time under one revision number 

 Revisions are to be clouded on the drawing(s) and noted in the revisions chart(s) 

 For subsequent revisions, the previous revision clouds will be removed and new 

ones placed around the applicable changes, the chart will be updated to include 

the next revision number All revision numbers and notes in the revisions chart shall 

remain 

See APPENDIX 5 (SECTION 33.5.IX) 

 Only drawings which have been revised, including references, are to be included 

on the CD 

 All revised drawings shall have a revision number, date and description of changes 

 The CD is to have one folder (Named with the project file name, description and 

Revision #) with two sub folders 

o PDF – is to contain all PDF files of the revised drawings 

o CAD – is to contain all Microstation and Inroads files associated with the 

revisions (this includes sheet files and reference files in accordance with 

Capital Works Deliverables) 

 The sheet files are to be named using the following format…dwg#-revision#.pdf or 

dwg#-revision#.dgn 

 The CD is to contain… 

 A Revisions Log document appended with each revision completed 

 A Summary Brief identifying all changes made as part of the current revision 

submission 



City of Brampton - Capital Works Contract Design Procedures - January 2017 

  Pat Z. 

32 

 A spreadsheet with the Quantity Changes outlined for the current revision 

submission 

 Hard copy drawings to be submitted include 

 one (1) full sized original 

 one (1) half sized original (Cross Sections will be full sized only, 1:200 H, 1:100 V) 

EXAMPLE OF FILE STRUCTURE OF CD PROVIDED FOR REVISIONS… 
 Collector St- Arterial Rd A to Arterial Rd B – Revision 2 

Collector St - Revisions Log – REV 2 – 06-AUG-14.docx 

Collector St – Summary Brief – REV 2 – 06-AUG-14.docx 

Collector St – Quantity Changes – REV 2 – 06-AUG-14.xlsx 

 PDF 

C1-11-5-REV 2.pdf 

 CAD 

C1-11-5-REV 2.dgn 

Collector-EXISTING.dgn 

Collector-DESIGN.dgn 

Collector-PROFILES.dgn 

Collector-PROPERTY.dgn 
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5. REVIEW OF SUBMISSIONS FROM EXTERNAL SOURCES 

1) PUCC REVIEW PROCEDURE 

i. Review the PUCC 

ii. Confirm the location and determine if the project falls within 500m of a current or 

future EA or Capital Contract 

iii. If yes, review the application with the assigned engineer and have them apply 

their initials to sign off on any circulation requirements. This is done to document 

that the application has been circulated/reviewed with them. 

iv. Scan the required plans in the application for the information to be forwarded to 

the engineer, who will then circulate it to the consultant assigned to the EA/Capital 

contract. 

v. Review the PUCC to ensure that it meets the city’s requirements 

vi. Note your comments on the application and attach any related correspondence 

that may have been provided by the engineer, or consultant, responsible for the 

EA or Capital Contract. 

vii. If you encounter issues/conflicts with the application, skip to step 12.(xii) 

viii. Once all the issues, if any, are resolved and the application can be approved, 

provide the package to the Design Supervisor for signature 

ix. Scan and email the signed form to the PUCC Applications emailbox (copy yourself 

and the Design Supervisor) 

x. Note the date in the portal spreadsheet, with a hyperlink to the email. 

xi. File the package in the appropriate cabinet, in numberical order, once approved. 

xii. Add a comment in the portal spreadsheet to  outline actions being taken and/or 

status of the review, including the date 

xiii. Work with the consultant and/or the applicant to find a resolution that meets the 

needs of all parties. 

xiv. Once a resolution has been accomplished, follow previous steps 6-11 (vi – xi) 
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2) SITE PLAN REVIEW PROCEDURE 

i. Review the Site Plan drawing(s) 

ii. Confirm the location and determine if the project falls within 500m of a current or 

future EA or Capital Contract 

iii. If yes, review the application with the project engineer and have them apply their 

initials to the cover letter provided by the planner (this is done to document that 

the application has been circulated/reviewed with them) 

iv. Scan the required plans in the application and forward the information to the 

engineer, along with a cover letter; he/she will then circulate the information to the 

consultant. 

See APPENDIX 3 (SECTION 33.3.XI, XII & XIII)  

Include a deadline, set to one week prior to planner’s stated date for responses 

v. Review the Site Plan to ensure that it meets the city’s requirements 

vi. Complete the site plan review memo, found in Engineering Standard 

Setups\TEMPLATES…, there is a shortcut to it in the main site plan review directory. 

Include your comments and attach any related correspondence that may have 

been provided by the engineer responsible for the related EA or Capital Contract. 

vii. Forward an email to the appropriate contacts, as listed on the site plan memo 

viii. Note the date in the portal spreadsheet, with a hyperlink to the email sent to 

Planning. 

ix. File the package in the appropriate cabinet, in numberical order 
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3) SUBDIVISION REVIEW PROCEDURE 

i. Review the Subdivision Package drawings 

ii. Complete a memo for the Lighting section and another for the Traffic section, then 

circulate the respective drawing package to each section with the matching 

section’s cover letter 

See APPENDIX 3 (SECTION 33.3.XIV, XV & XVI) 

iii. Confirm the location and determine if the project falls within 500m of a current or 

future EA or Capital Contract 

iv. If yes, review the application with the project engineer and have them apply their 

initials to the cover letter provided by the planner (this is done to document that 

the application has been circulated/reviewed with them) 

v. Scan the required plan(s) in the application and forward the information to the 

engineer, along with the cover letter; he/she will then circulate the information to 

the consultant. 

Include a deadline, set to one week prior to planner’s stated date for responses 

vi. Review the Development to ensure that it meets the city’s requirements 

vii. Complete the subdivision review memo, found in the templates and checklists 

directory. Include your comments and attach any related correspondence that 

may have been provided by the engineer responsible for the related EA or Capital 

Contract. 

viii. Forward an email to the appropriate contacts, as listed in the memo. 

ix. Note the date in the portal spreadsheet, with a hyperlink to the email sent to 

Planning. 

x. File the package in the appropriate cabinet, in numberical order 
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6. CAPITAL PROJECT REQUIREMENTS & DELIVERABLES - CONSULTANT 

Drawing numbers are to be assigned as drawings are created; drawing files are to 

be named using drawing number. 

Provide the Intermediate Engineering Technician with a small copy of each 

drawing to obtain the correct numbers. 

1) 30% SUBMISSION FROM CONSULTANTS (CAPITAL PROJECTS) 

30% CADD REVIEW 

 Check File Structure Compliance 

 PROJECT FILE NAME, NUMBER & DESCRIPTION – SUBMISSION STAGE 

 CONSTRUCTION - DGNS 
 ALL existing, design and contract drawings including all references 

 CONSTRUCTION - INROADS 

 ALL InRoads files associated with the capital works portion of the contract  

 DESIGN BRIEF 

 Report of design criteria, project challenges and solutions 

 SURVEY 
 One plan containing triangles and contours of the original surface 

 Check format (Microstation) 

 Confirm Georeferencing 

 Check for level compliance (Level use is outline in this manual’s Appendix 1) 

 Check drawings for compliance to drafting standards 

 Check for 3D plan elements (survey, designed roadway and stormpond elements must be 

Geospacially Correct including the ‘Z’ value) 

 Check for Viewport usage in Contract Drawings (Each dgn file is to contain only 1 sheet) 

See APPENDIX 4 (SECTION 33.4.VIII) 

30% DELIVERABLES 

The following must be included on the CD (if applicable to the project) 

 

 1 Original Full Size Hard Copy set 

o Rolled, not folded 

o Unbound 

 1 CD 

The following must be included on the CD 

o Design Criteria 

o Property Plan 

o Title Page(s) 

o Removals 

o New Construction 
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2) 60% SUBMISSION FROM CONSULTANTS (CAPITAL PROJECTS) 

Drawing numbers are to be assigned as drawings are created; drawing files are to 

be named using drawing number. 

Provide the Intermediate Engineering Technician with a small copy of each 

drawing to obtain the correct numbers. 

60% CADD REVIEW 

 Check File Structure Compliance 

 PROJECT FILE NAME, NUMBER & DESCRIPTION – SUBMISSION STAGE 

 CONSTRUCTION - DGNS 
 ALL existing, design and contract drawings including all references 

 CONSTRUCTION - INROADS 

 ALL InRoads files associated with the capital works portion of the contract  

 DESIGN BRIEF 

 Report of design criteria, project challenges and solutions 

 SURVEY 
 One plan containing triangles and contours of the original surface 

 Check format (Microstation) 

 Confirm Georeferencing 

 Check all drawings for compliance to drafting standards 

 Ensure contract drawing reference the plan(s) and profile(s) i.e. NOT merged 

 Check for level compliance (Level use is outline in this manual’s Appendix 1) 

 Check for 3D plan elements (survey, designed roadway and stormpond elements must be 

Geospacially Correct including the ‘Z’ value) 

 Check InRoads files for Compatibility 

 Check Landscape drawings, if applicable, for compliance to drafting standards 

 Check Structures drawings, if applicable, for compliance to drafting standards 

 Check for Viewport usage in sheet drawings (Each dgn file is to contain only 1 sheet) 

 Check for Nested reference files in sheet drawings (No nested references permitted) 

 Check for Missing reference files in sheet drawings (All reference files must be present) 

 Check for Unused reference files in sheet drawings (All referenced files must be displayed) 

See APPENDIX 4 (SECTION 33.4.IX) 

60% DELIVERABLES 

 1 Original Full Size Hard Copy set 

o Rolled, not folded 

o Unbound 

 1 Original Full Size Hard Copy set of the Cross Sections 

 1 CD 

The following must be included on the CD (if applicable to the project) 

o Design Criteria 

o Inroads Files 

o Property Plan 

o Title Page Drawing(s) 

o Removals Drawing(s) 

o New Construction Drawings 

o Traffic Control Drawing(s) 
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o Street Lighting Drawing(s) 

o Landscape Drawing(s) 

o Structural Drawing(s) 

o Pavement Marking Drawing(s) 

o Watermain Drawing(s) (Peel) 

o Sanitary Drawing(s) (Peel) 

o Cross Sections Drawing 

o Storm Design Sheet(s) and Drawing(s) 

3) 90% SUBMISSION FROM CONSULTANTS (CAPITAL PROJECTS) 

Drawing numbers are to be assigned as drawings are created; drawing files are to 

be named using drawing number. 

Provide the Intermediate Engineering Technician with a small copy of each 

drawing to obtain the correct numbers. 

90% CADD REVIEW 

 Check File Structure Compliance 

 PROJECT FILE NAME, NUMBER & DESCRIPTION – SUBMISSION STAGE 

 CONSTRUCTION - DGNS 
 ALL existing, design and contract drawings including all references 

 CONSTRUCTION - INROADS 

 ALL InRoads files associated with the capital works portion of the contract  

 DESIGN BRIEF 

 Report of design criteria, project challenges and solutions 

 SURVEY 
 One plan containing triangles and contours of the original surface 

 Check format (Microstation) 

 Confirm Georeferencing 

 Check all drawings for compliance to drafting standards 

 Ensure contract drawing reference the plan(s) and profile(s) i.e. NOT merged 

 Check for level compliance (Level use is outline in this manual’s Appendix 1) 

 Check for 3D plan elements (survey, designed roadway and stormpond elements must be 

Geospacially Correct including the ‘Z’ value) 

 Check InRoads files for Compatibility 

 Check Landscape drawings, if applicable, for compliance to drafting standards 

 Check Structures drawings, if applicable, for compliance to drafting standards 

 Check for Viewport usage in sheet drawings (Each dgn file is to contain only 1 sheet) 

 Check for Nested reference files in sheet drawings (No nested references permitted) 

 Check for Missing reference files in sheet drawings (All reference files must be present) 

 Check for Unused reference files in sheet drawings (All referenced files must be displayed) 

See APPENDIX 4 (SECTION 33.4.X) 

90% DELIVERABLES 

 1 Original Full Size Hard Copy set 

o Rolled, not folded 

o Unbound 

 1 Original Full Size Hard Copy set of the Cross Sections 

 1 CD 
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The following must be included on the CD (if applicable to the project) 

o Design Criteria 

o Inroads Files 

o Property Plan 

o Title Page Drawing(s) 

o Removals Drawing(s) 

o New Construction Drawings 

o Traffic Control Drawing(s) 

o Street Lighting Drawing(s) 

o Landscape Drawing(s) 

o Structural Drawing(s) 

o Pavement Marking Drawing(s) 

o Watermain Drawing(s) (Peel) 

o Sanitary Drawing(s) (Peel) 

o Cross Sections Drawing 

o Storm Design Sheet(s) and Drawing(s) 

4) ISSUED FOR TENDER OR CONSTRUCTION SUBMISSION FROM 

CONSULTANTS (CAPITAL PROJECTS) 

Drawing numbers are to be assigned as drawings are created; drawing files are to 

be named using drawing number. 

Provide the Intermediate Engineering Technician with a small copy of each 

drawing to obtain the correct numbers. 

ISSUED FOR TENDER OR CONSTRUCTION CADD REVIEW 

 Check File Structure Compliance 

 PROJECT FILE NAME, NUMBER & DESCRIPTION – SUBMISSION STAGE 

 CONSTRUCTION - DGNS 
 ALL existing, design and contract drawings including all references 

 CONSTRUCTION - INROADS 

 ALL InRoads files associated with the capital works portion of the contract  

 DESIGN BRIEF 

 Report of design criteria, project challenges and solutions 

 SURVEY 

 One plan containing triangles and contours of the original surface  

 DOCUMENTS 
 All pertinent documents and permits…Tender, TRCA, MNR, MOE… 

 Check format (Microstation) 

 Confirm Georeferencing 

 Check all drawings for compliance to drafting standards 

 Ensure contract drawing reference the plan(s) and profile(s) i.e. NOT merged 

 Check for level compliance (Level use is outline in this manual’s Appendix 1) 

 Check for 3D plan elements (survey, designed roadway and stormpond elements must be 

Geospacially Correct including the ‘Z’ value) 

 Check InRoads files for Compatibility 

 Check Landscape drawings, if applicable, for compliance to drafting standards 

 Check Structures drawings, if applicable, for compliance to drafting standards 

 Check for Viewport usage in sheet drawings (Each dgn file is to contain only 1 sheet) 

 Check for Nested reference files in sheet drawings (No nested references permitted) 
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 Check for Missing reference files in sheet drawings (All reference files must be present) 

 Check for Unused reference files in sheet drawings (All referenced files must be displayed) 

See APPENDIX 4 (SECTION 33.4.XI) 

ISSUED FOR TENDER OR CONSTRUCTION DELIVERABLES 

 1 Original Full Size Hard Copy set 

o Rolled, not folded 

o Unbound 

 1 Original Full Size Hard Copy set of the Cross Sections 

 1 CD 

The following must be included on the CD (if applicable to the project) 

o Design Criteria 

o Tender document 

o Quantities 

o Inroads Files 

o Property Plan 

o Title Page Drawing(s) 

o Removals Drawing(s) 

o New Construction Drawings 

o Traffic Control Drawing(s) 

o Street Lighting Drawing(s) 

o Landscape Drawing(s) 

o Structural Drawing(s) 

o Pavement Marking Drawing(s) 

o Watermain Drawing(s) (Peel) 

o Sanitary Drawing(s) (Peel) 

o Cross Sections Drawing 

o Storm Design Sheet(s) and Drawing(s) 
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5) CADD REVIEW OF CAPITAL PROJECTS WHERE “AS CONSTRUCTED” WORK 

IS BEING DONE BY CONSULTANTS 

REVIEW THE FOLLOWING... 

 Check format (Microstation) 

 Check for Georeferencing and 3D elements 

 Check for level compliance 

 Check to ensure that the contract drawings reference the strip plans & strip profile 

and are not merged. Base plate may, or may not, be referenced to contract 

drawings. 

 Check contract drawings for missing reference files 

 Check contract drawings for nested reference files...these are not permitted 

 Check contract drawings for unused references, there are to be no files referenced 

to the contract drawing that are not required for that drawing 

 Check contract drawings for use of layout views or portals to create multiple 

numbered drawings in one drawing file, these are not permitted 

 Check drawings for compliance to City requirements 

See REQUIREMENTS FOR CAPITAL “AS CONSTRUCTED” DRAWINGS (SECTION 7) 

 Cross check against redline drawings to ensure field changes have been reflected 

in the drawings 

 Provide Traffic Section with their digital and hard copy traffic drawings for review  

Traffic requires that the cells for proposed information be replaced with cells for existing 

information...See ‘Traffic Drawings’ (SECTION 7.5) 

 Provide Lighting Section with their digital and hard copy lighting drawings for field 

review 

Lighting must do an onsite verification of the installation...See ‘Lighting’ (SECTION 7.6) 

See APPENDIX 4 (SECTION 33.4.XIII) 
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6) CADD REVIEW OF “AS CONSTRUCTED” DEVELOPMENT DRAWINGS 

This section of the manual, pertaining to Development As Constructed drawings, 

has been extracted to a separate document. Refer to ‘Development Digital Submissions 

Requirements Manual’ for the specifics of, non-capital, Development As Constructed 

submissions. 

The review checklist can be found in Standard Setups under DESIGN TEMPLATES 

and CHECKLISTS\. 

See APPENDIX 4 (SECTION 33.4.XIV) 

7. REQUIREMENTS FOR CAPITAL “AS CONSTRUCTED” DRAWINGS 

See APPENDIX 3 (SECTION 33.3) [memos, circulation letters and transmittals]  

 

See APPENDIX 4 (SECTION 33.4) [checklists to be completed during review] 

 

See APPENDIX 5 (SECTION 33.5) [Examples of finished product] 

1) GENERAL REQUIREMENTS 

 Indicate, using ‘redline’ on applicable sheets, all changes made during construction. 

 One complete, bound, hard copy set of drawings, with redline information, is to be 

verified, and initialed. (by CA/Inspector) This drawing set will be retained by the Public 

Works, Capital Construction and Engineering Department. 

 The note “As Constructed”, including date and project file number, shall be placed on 

all drawings. 

 A signed engineer’s stamp to be on all “as constructed” drawings. 

 All plan and profiles should have at least one benchmark as a reference for elevations. 

 All as constructed drawings must be submitted in digital format and must comply with 

the latest version of the Appendix A document (Sections 2.0 and 6.0). 

 One complete set of As-Constructed Cromaflex / Mylar reproductions to be retained 

by the Public Works, Capital Construction, Engineering Department. 

***Mylars to be approved for quality by Intermediate Engineering Technician prior to 

acceptance of package.*** 
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2) DIGITAL REQUIREMENTS 

 Drawings to be provided in “.pdf”, scanned from completed drawings 

 Drawings to be provided in Microstation V8 (or V8i) “.dgn” 

 Microstation drawings, engineering base plans to be “3D” 

 Microstation drawings, traffic/lighting/landscaping/structures, may be “2D” 

 Level system to follow current Capital Works Deliverables seed file. (SEED-3DUTM.dgn) 

 Drawing elements to be georeferenced and 3D, i.e. in correct spacial co-ordinates, 

and shall include surveyed information, proposed/as constructed roadway information 

and ditch lines. 

 Drawing elements to be placed in a planar fashion include property lines, utility lines, 

shading, notes and borders. 

 Elements to be deleted from the drawings, during the “as constructed” process, shall 

include any items which have been removed in the field i.e. pre construction edge of 

pavement, shoulders, curbs, MHs, trees… 

 All proposed shading is to be deleted with the exception of rip rap, gabion baskets 

and engineered fill (profile). 

 Submission shall include a COMPLETE drawing set with references intact including 

strip/base plans and profiles. 

 NO live nested references are permitted 

 NO view ports are permitted, each sheet plan must be it’s own CAD file 

See APPENDIX 1 (SECTION 33.1) 

3) PLAN VIEW-ENGINEERING DRAWINGS 

 All construction notes are to be removed. 

 Identifying notes are to have “PROP” or “PROPOSED” removed from the text. 

 Any elements that have been modified or added during construction are to be 

identified with a note outlining the change. i.e. moved MHs or additional DICBs 

 All street names shall be indicated as per registered plans. 

 Manhole identifications are to be left on. 

 Items to be changed if different than proposed: 

 Sewer Locations 

 Curb widths 

 Sidewalk locations 

 Manhole locations 

 Catchbasin locations 

 Curb radii 

 All street lighting infrastructure and pole/fixture details are to be shown on a separate 

plan. 

 Lot grading elevations are to be as constructed and proposed elevations are to be 

removed. 

 All sewer connections must be shown. 
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4) PROFILE VIEW-ENGINEERING DRAWINGS 

 All as constructed sewer invert elevations are to be shown. If difference is greater than 

300mm between the as constructed and the proposed sewer then the sewer shall be 

redrawn. Invert information is to remain with any changes to the designed invert 

identified by crossing out the proposed invert and placing actual invert adjacent to it. 

 Any manhole location that differs by 1.0m or more from proposed position on the plan 

is to be re-drawn and shall include a note identifying the change to design location. 

 Items to be changed if different than proposed by crossing out proposed information 

and adding as constructed information: 

 Types of manholes 

 Pipe Information (Size, Slope, Length, Class) 

 Road grade 

 Sewer material 

 Type of bedding 

 Manhole identifications are to be left on. 

 Sanitary sewer and watermain information should have Regional approval prior to City 

acceptance. 

 Remove obsolete road profile, culverts and ditches.  

See APPENDIX 5 (SECTION 33.5.VIII & SECTION 33.4.X) 

5) TRAFFIC DRAWINGS 

 All permanent design drawings are to be “As Constructed” 

 Temporary design drawings, which have not been replaced by a permanent design 

drawing, are to be “As Constructed” 

 Temporary design drawings, which have been replaced by a permanent design 

drawing, will remain unchanged but will be reproduced on mylar as part of the “As 

Constructed” package 

 Removals drawings do not need to be “As Constructed” but will be reproduced on 

mylar as part of the “As Constructed” package 

 All drawings are to be georeferenced 

 All design symbology on the main plan is to be replaced with existing symbology, as 

shown in the main legend 

 All symbology on the schematic wiring diagram is to be dashed for existing 

infrastructure 

 A legend, if one is not present, is to be added to the schematic indicating a dashed 

line as existing and a solid line as proposed 

 No note pertaining to moved items is required, items are to be placed accurately 

based on any changes indicated on the redline drawings and/or during a field 

investigation 

 Signal pole, mast arm, Handwell, Manhole, street lighting, traffic controller, transformer, 

power supply and signal head details chart information is to be changed based on 

any changes indicated on the redline drawings and/or during a field investigation 

 Maintain 0.4m offset between duct runs & wiring in schematic diagram 

 Provide horizontal and vertical distance from the curb or property line for the conduit 

path (between Hydro one Brampton transformer and power supply) 

See APPENDIX 5 (SECTION 33.5.XI & SECTION 33.5.XII) 



City of Brampton - Capital Works Contract Design Procedures – January 2017 

Pat Z. 
45 

6) LIGHTING DRAWINGS 

 All construction notes are to be removed. 

 Identifying notes are to have “PROP” or “PROPOSED” removed from the text. 

 Any elements that have been modified or added during construction are to be 

identified with a note outlining the change. i.e. Luminaire wattage , bracket length, 

duct size/location 

 All street names shall be indicated as per registered plans. 

 Details chart to be updated with any field changes. Cross out the designed value and 

add the revised value in the same box. 

 Final “as constructed” drawings require an engineer’s stamp & signature verifying 

accuracy of drawing information. 

See APPENDIX 5 (SECTION 33.5.XIII & SECTION 33.5.XIV) 
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8. IN HOUSE PROCESS FOR CAPITAL WORKS DESIGN  

1) EXAMPLE PROJECT 

This is the example being referred to in the following sections. A full explanation of 

drawing preparation and numbering, using this example, can be found in Contract 

Drawing Preparation. 

See CONTRACT DRAWING PREPARATION (SECTION 20) 

2) GETTING READY – GATHERING FILES 

Capital Works Projects begin with the Pre-Engineering Process. An overview of this 

process is as follows: the site to be constructed (or reconstructed) is surveyed for relevant, 

up-to-date information. The survey information collected is downloaded, processed and 

then quality checked under the direction of the Survey Supervisor. The information is then 

provided to a technologist for Base Plan Preparation and detailed design. 

FOLDER TO BE RETRIEVED/COPIED FROM “…\ENGINEERING STANDARD SETUPS\” 

Copy the folder ‘_ IN-HOUSE FILE STRUCTURE - Street - From – To’, with all its sub 

folders, from “G:\wtdesign\Engineering Standard Setups\” to G:\wtdesign\Street Names 

- CONTRACTS\” 

There is a separate folder, in Capital Works Deliverables, for the consultant’s file 

structure, as it is a simplified version for external Capital submissions. 

Make sure you are COPYING and NOT MOVING this directory, using the right click 

to drag the folder to the new location will allow you to select copy/move/create 

shortcut/cancel. Because it is being copied from one location to another within the same 

drive i.e. G:\, the default is to move it. Using the right mouse button you can cancel the 

action if you inadvertently let go before getting to the correct location. 

 Rename with the Project file number, street name and description, in this example the 

renamed folder would be...G:\wtdesign\Street Names – CONTRACTS\Collector\13-

3251-213 Collector St-Arterial A to Arterial B\  
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 The project file number is to be obtained from either the co-ordinator or the supervisor 

of the Engineering Design group. 

 Anywhere there is a sub folder labelled with a non specific name such as “Consultant 

Name” or “Project file number”, rename the folder with the appropriate information, 

once it is obtained. Not all of these folders will be used all of the time, however, for 

consistency they should not be deleted. This will ensure that all Technologists will have 

virtually identical file structure setups and drawings can be readily located should you 

be out of the office when they are needed. 

 The full list of directories, and what will be kept in them, is detailed in this manual. 

See CONTRACT DIRECTORY STRUCTURE FOR IN HOUSE DESIGN (SECTION 8.3) 

FILES TO BE RETRIEVED/COPIED FROM “…\ENGINEERING STANDARD SETUPS\...” 

COPY THESE FILES TO THE “INROADS” FOLDER IN THE MAIN CONTRACT DIRECTORY. 

Library file - “BRAMPTON.itl”  

 This file is the road template library or typical section library; it contains basic 

components and templates for the “200 series” City of Brampton Standards. 

 These templates will need to be modified for each specific project and set of 

conditions, thus you can rename this file to “COLLECTOR.itl”, making it project specific. 

This file will also need to be changed to read/write access to allow these modifications 

to be saved. 

Preference file - “BRAMPTON.xin” 

 This will be the latest preference file available and contains the setup for all the 

features, alignments, profiles, sections etc. that will be generated / displayed during 

the design process. 

 The preferences will be modified to be project specific and can be renamed 

“COLLECTOR.xin” Ensure that the file properties show read/write access. Variables may 

include elevation ranges for profile and x-sections, station ranges within the x-sections 

to more fully cover critical areas of the project, titles for the sections and event points 

(i.e. driveways, HP’s). These variables will be saved back to this preference file within 

the contract directory structure. 

COPY THE FOLLOWING DRAWING FILES TO THE MAIN CONTRACT DIRECTORY; 

CHANGE THE PROPERTIES TO “READ/WRITE”. 

“4-PLANnPROFILE-sheet-2D.dgn”  

 This file is the base for all drawing sheets; it will be referenced to the numbered sheets 

created. Once copied to the contract folder this file can be re-named “PnP-

COLLECTOR-sheet.dgn” 

“1-TITLEPAGE-2D.dgn” 

 This file is the base for the Title Sheet and has Truebram.dgn referenced. Once copied 

to the contract folder, ensure that the properties are set to read/write, it can then be 

re-named using the drawing number assigned to it “00-C1-8-15-TITLEPAGE.dgn”  

“1-DGN_LISTPAGE-2D.dgn” 
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 This file is the base for the Drawing List Sheet. Once copied to the contract folder, 

ensure properties are set to read/write, it can then be re-named  using the drawing 

number assigned to it “00-C1-8-16-LISTPAGE.dgn”  

FILES TO BE RETRIEVED/COPIED FROM SURVEY GROUP  

 Survey will create four files; these are a surface file, a base plan / design file, an 

alignment file and a preference file. 

 The alignment file is Survey’s equivalent to our surface file and is not utilized in our 

design process. 

 The preference file may, or may not, be the latest depending on when the survey was 

done relative to the start of the design process. 

COPY THIS FILE TO THE “INROADS” FOLDER IN THE MAIN CONTRACT DIRECTORY 

The surface file… named “Collector-base.dtm”  

 This file contains all the feature and surface information and is generally identified as 

the “survey” surface, it will be used in roadway design and for the display of features in 

cross sections i.e. headwalls, gardens, buildings etc.. 

COPY THIS FILE TO THE MAIN CONTRACT DIRECTORY. 

The design file… named “Collector-base.dgn” 

 For roads that extend through multiple areas, there may be an additional letter or 

number after the Streetname.  i.e. Collector St… could be named “Collector-BC” 

representing the City quadrants the street is in (B1 & C1). 

 This file will contain the surveyed information that was cleaned up with information 

added such as tree sizes, CSP sizes, corrections and additions plus any other 

information thought to be pertinent to the design of the road. The cleanup is primarily 

done by the survey section and this existing information drawing is provided to be 

referenced to the drawing sheets. There may be some cosmetic changes required for 

clarity on the drawings, to adjust labels at page breaks and around design and 

property linework. 

See SECTION 20.2 & SECTION 21 [For the assignment, and registration, of 

drawing numbers by the Engineering Technician] 
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3) CONTRACT DIRECTORY STRUCTURE FOR IN HOUSE DESIGN 

...As set up in Engineering Standard Setups 

13-3251-213 Collector St-Arterial A to Arterial B 
This main directory will contain all Microstation files directly associated with the 

project. Once copied, this folder will be renamed, as indicated here, with the 

appropriate contract information.  

 _CD for DESIGN HANDOVER FILE STRUCTURE – Street-Date 

Use this folder to compile all files associated with the contract, including Consultant 

produced drawings i.e. structures, landscaping and Regional works being done as part of 

the contract. Copy all of the contract files and drawings to the appropriate folders. Ensure 

that only the reference files that are being used in each numbered drawing are 

attached; detach any references not needed. As an example, for a typical plan and 

profile drawing the only reference files attached/used would be Property, Existing, Design, 

Profile, Base, Hydro. 

This folder will be for the Issued for Contruction drawings and files. The form can be 

found in Engineering Standard Setups and must be signed off by the Supervisor of CADD 

and Surveys Group. 

See Appendix 4 (SECTION 33.4.XII) 

Once all the files have been compiled, this folder can be copied to a CD, or CDs 

for distribution to the contractor and an additional CD will be created for the files, as a 

record of what was provided. 

 Capital Works Deliverables 

Ensure that the latest ‘Capital Works Deliverables’ package is included on the 

CD, creating a shortcut to the “Consultants CD Burn” folder will help you locate it 

quickly when making the CD(s) 

 LANDSCAPING 

Files provided by consultant for landscaping work done on behalf of the City 

 MICROSTATION FILES 

Microstation files associated with the contract drawings, this would include 

Plans, Profiles, Property, Sections, Numbered Drawings, Base Drawings 

 PDF FILES 

Use this folder for a PDF copy of the Issued for Construction drawings 

 REGIONAL WORK 



City of Brampton - Capital Works Contract Design Procedures - January 2017 

  Pat Z. 

50 

Files provided by the Region, or a consultant on their behalf, for Region works 

 STRUCTURES 

Files provided by consultant for any structure/bridge work done on behalf of the 

City 

 SURVEY 

Drawing files with the contours and triangles of the original surface displayed. 

 AUTOTURN 

Contains any files used or created during the running of Autoturn 

 BACKGROUND 

Tiff/PDF files and Previous Contract(s) Drawing files retrieved during background 

research for the contract. Create sub folders for each source of information i.e. contracts, 

as constructed. 

 COMMUNICATIONS 

Contains files such as drawing numbers lists, progress notes, design criteria with sub 

folders added for any site plan or development reviews adjacent to the project 

 E-MAIL 13-3251-213 

Contains all e-mail correspondence, creating a “pst” file in this folder will ensure 

that all have access to information relayed through e-mails. 

Access can be attained by others through Outlook...File> Open> Open Outlook Data File   

Browse to the communications folder of the contract and select pst file 

 CONSERVATION AUTHORITY 

Files related to permitting, including any drawing files, permit submissions and 

responses. 

 CREDIT VALLEY 

 TORONTO REGION 

 CONSULTANTS 
 GEO-TECH 

Files to/from Consultant for Geo-Tech work i.e. reports and drawings 

 LANDSCAPE 

Files to/from Consultant for Landscape work i.e. drawing files and PDF files 

 REGIONAL WORKS 

Files to/from Consultant for Regional work being done as part of the contract 

i.e. drawing files and PDF files 

 STRUCTURES 

Files to/from Consultant for Structures work i.e. drawing files and PDF files 

 DEVELOPERS 
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Areas surrounding the contract site may be required for calculations and 

matching alignments & storm systems. Rename the sub folder to the subdivision name 

and add a folder for each additional subdivision. 

 Subdivision Name 

Files to and from Consultants for areas surrounding project 

 DIGITAL SUBMISSIONS 

Sub folders are to contain pdf files of all submissions, as a static record of what was 

circulated.  A Pre-Eng PUCC letter, blank distribution documents and comment 

spreadsheets shall be copied and filed in the appropriate folder; modify as needed, with 

file number & name, prior to circulation. As comments are returned, compile one 

spreadsheet with all stakeholders’ comments for each submission. 

 1 – Pre Eng PUCC 

 2 – 30 Percent 

 3 – 60 Percent 

 4 – 90 Percent 

 5 – Final PUCC 

 6 – ISSUED FOR TENDER 

 7 – ISSUED FOR CONSTRUCTION 

See ENGINEERING SUBMISSIONS (SECTION 2) [Processes] 

 

See APPENDIX 3(SECTION 33.3) [TEMPLATES] 

 

See APPENDIX 4 (SECTION 33.4.V) [Capital Projects –Design Circulation-

Comments.xlsx] 

 EAs 
 Consultant Name 

This folder is for links to, and/or, files pertaining to, any relevant EA study. 

Change the folder name from “Consultant Name” to the consultant’s name and EA 

information. An example would be “ABC Engineering–Arterial Rd A–Region of Peel” 

Add a folder for each additional EA, if applicable. 

 INROADS 

All associated Inroads files...dtm, xin, rwk, ird, itl, alg. Sub folders can be created for 

backup purposes and to keep trial designs, they will be identified by description and date. 

For example “BACKUP 03OCT13”. 

 OBSOLETE 

Old designs and other files no longer relevant to the current design, this is your “just 

in case” folder. Sub folders can be created for different versions of a project; these can 

also be identified by description and date. 

 PDFs 

Massive numbers of PDF files can be generated throughout the working term of any 

given contract; these files may be created for information exchanges, clarification, 

problem areas requiring consultation or any number of other reasons. These should be 

named logically and dated for quick location when needed. When there are multiple 
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plans created specifically for a particular issue/development/utility, they can be placed in 

the corresponding folder(s), the “one offs” can be placed in this folder. 

 SECTIONS 

Creating a PDF of each section and then combining them into one PDF for 

printing is an effective way of generating hard copies on demand. It is easier to select 

and combine these individual files if they are in a separate folder where they can be 

selected en mass. 

You can also set up an “ips” file with the individual sections saved as “i” files in 

case changes/additions need to be made and the sections reprinted.  Follow the 

same procedure as Plotting Contract Drawings. 

See PLOTTING CONTRACT DRAWINGS – USING IPLOT (SECTION 30.1)) 

 PRE ENG PHOTOS 

This folder contains any photos or videos taken prior to construction. 

 PREPARATION 

When preparing drawings for stakeholders, merging files, clipping or converting 

files, copying them to this folder before working on them, will reduce the chances of 

mistakenly modifying your working files. Create folders for each new group of files 

i.e. “TO FTP 15FEB15” or “TO HYDRO 22MAR15” 

 PRINT FILES 

“.i” files and “.ips” file(s) to be set up with contract information for generation of 

PDF files used for printing full size or half size plans, this is fully explained under Plotting 

Contract Drawings 

See PLOTTING CONTRACT DRAWINGS – USING IPLOT (SECTION 30.1)) 

 PDFs 

Utilizing the “ips” file, you can create PDF files for printing various submissions, 

individual drawings or parts of the contract for review by others or as check prints 

without the need to open the drawing each time. 

 SECTIONS 

Creating a PDF of each section and then combining them into one PDF for 

printing can be a tedious process, especially, if it needs to be done more than once. 

Generating and storing the print files and creating an “ips” file, while still tedious, only 

needs to be done once. Regeneration of PDF files can be done en mass and printed 

from one file. 

 QUANTITIES 

Drawings/shortcuts, spreadsheets, documents or links associated with quantity take 

offs. 

 TENDER 

Any documents or spreadsheets prepared or received relating to the tender 

package. 
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 REALTY 

Files would include property plan, property acquisition mapping, and owners’ lists. 

Sub folders can be created for specific properties of particular concern identified by ID 

number assigned, pin number or address and name of owner. These may be needed 

during negotiations for property when additional plans and/or explanations are required. 

SEE PROPERTY BASICS (SECTION 9) 

 IPRPs 

Individual property request plans for each property affected by the contract 

i.e. areas where property is required from landowners. 

 PDFs 

PDFs of IPRPs used for distribution and printing. 

 STORM 

Drawing file of storm plan, or shortcut to storm plan drawing if it is filed in the main 

folder. Spreadsheets/drainage sheets generated as part of the contract or attained for 

background information. 

 REPORTS 

Storm water management reports, or links to the reports, pertinent to the 

project. 

 STREET LIGHTING 

Files received pertaining to street lighting design. To be checked against design 

files for conflicts with storms, structures, hardware and for obvious errors and omissions. 

 SURVEY DATA 

Raw survey data files, dgn, alg, dtm, including drawings with triangles and contours 

generated from the dtm. 

 CONTROL 

 LEGAL PLANS 

 PREENG SURVEY – TOPO 

Drawing file(s) containing displayed contours and triangles of original surface. 

 TRAFFIC SIGNALS 

Files received pertaining to traffic signals design. To be checked against design files 

for conflicts with storms, structures, hardware and for obvious errors and omissions. 

 TRANSIT 

Files transferred between Transit Dept and Designer identifying Transit requirements. 

These may include notes, PDFs and drawing files. 

 UTILITIES 

Each utility has two sub directories...”Pre Eng PUCC” and “PUCC Approvals” 
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Files found in the “Pre Eng PUCC” folder of each utility would be any CAD files 

received in association with the pre-eng PUCC request you send out to gather 

information. The information in these files will be used to populate the “Collector-UTILITIES” 

drawing with linework to be used to import them as features to a utilities surface. It can 

then be copied into the existing plan for display in the numbered drawings. 

Files found in the “PUCC Approvals” folder of each utility would be related to new 

construction or relocations required for the commencement of construction, including but 

not limited to drawing files. It contains PDF files and documents with comments made on 

PUCC submissions received, for each utility; this would include information exchanged to 

clarify comments and finalize the submission. Sub files can be created, if necessary, for 

each PUCC submission and named based on the submission number. 

Hydro One Brampton is provided, as soon as functionally possible, drawings with 

the existing information, proposed or EA information and a blank plan to work in. In return, 

you will receive their design, geo-referenced, which can be referenced into the sheet 

drawings for the contract.  

 WORKING 

When multiple options are required you can create a separate folder for each trial 

with a description and date. 

4) CONTRACT DIRECTORY FOR EXAMPLE IN HOUSE DESIGN 

...A sample of how a typical contract directory would be populated 
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5) CREATE MAIN WORKING FILES 

Copy “COLLECTOR-base.dgn”, to “COLLECTOR-DESIGN.dgn”  

In “COLLECTOR-DESIGN.dgn” attach cell library “BRAMPTON CELLS V8i.cel” (Found 

in the directory ...\Engineering Standard Setups\DESIGN CELL LIBRARIES) if it is not already 

attached. Turn on all levels and delete all information. 

Reference “Collector-base.dgn” to the DESIGN file. 

Compress the DESIGN file and save settings (Ctrl + F).  

Check the options setup under the Compress command. 

>> File>Compress>Options… 

We don’t have any of the 

boxes selected because we 

want to keep all cells, 

linestyles and levels. The 

process removes the ghosted 

linework changes applied to 

the files, as a result, once 

compressed; there is no undo 

function available. 

 

 

 

 

 

 

 

 

Copying the cleaned up survey file to a newly named file brings with it all levels and text 

styles as well as any view rotations that have been set up which saves time in trying to set 

up the exact rotation of the view to match the text placed by survey section. This file has 

been created using a seed file which has the overrides set for printing without using pen 

tables. 

The colour/weight overrides of the seedfile are to be kept, or reinstated, in the 

active file for printing purposes. The Working levels may be adjusted as needed. 

If “BRAMPTON CELLS V8i.cel” is not attached to the file, the feature style manager will not 

be able to find the cells associated with items to be displayed.  This becomes extremely 

important when generating a profile & x-sections since these processes require access to 

these cells for the proper display of the features. 
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LIST OF DRAWINGS THAT CAN BE CREATED USING “COLLECTOR-DESIGN.DGN” 

COLLECTOR-DESIGN.dgn 

COLLECTOR-SECTIONS.dgn 

COLLECTOR-PROFILES.dgn 

COLLECTOR-STORM.dgn 

COLLECTOR-UTILITIES.dgn 

01-B1-11-1.dgn” 

(Where 01 is the sheet #) 

…these can all be created at this time by copying “COLLECTOR-DESIGN.dgn” to 

create as many of the blank design files needed, this will save time later. Keep the 

drawing names consistent…”COLLECTOR-???”. The result will be a series of drawing files, 

each having the correct rotation, attached cell file & referenced base plan. 

If, in future, you are called upon to produce specialty drawings, copying one of 

these files to a new name will give you a head start in setup. 

Extras may be required for resident interaction, legal plan clarification…the 

drawing bases named “MISC-REQUESTS-2D-**size**.dgn” can be used for these drawings. 

When working in 3D it is helpful to have a dedicated iso view in order to monitor linework 

to ensure your lines are being placed correctly. Linework which has elevations ranging 

from the existing surface elevation to zero is not acceptable and can throw off your 

quantities calculations. 

See APPENDIX 5 (SECTION 33.5.IV) [3D Linework – ISO Views] 

Inroads files can be called the same name, each is a different type of file and 

different extensions will be assigned by Inroads, the exception being surfaces, which will 

be saved to “EXISTING” (or COLLECTOR-EXIST), “PROPOSED” or “UTILITIES”.  

The alignments will be named based on the street or intersection they are created 

for, a list of typical alignment names can be found in the following pages. 

See INROADS – CREATING GEOMETRY & SURFACE NAMES (SECTION 12) 
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A TYPICAL LIST OF NAMES THAT WILL APPEAR IN THE CONTRACT DIRECTORIES 

INROADS FILES… 

COLLECTOR.rwk [project file] 

COLLECTOR.itl [template library] 

COLLECTOR.alg [alignment] 

Collector-base.dtm [exist surface] 

COLLECTOR.ird [roadway designer] 

COLLECTOR.xin [preferences] 

PROPOSED.dtm [prop surface] 

LIMESTONE.dtm [prop subsurface] 

MICROSTATION FILES… 

Collector-base.dgn (provided by survey) 

COLLECTOR-DESIGN.dgn 

COLLECTOR-SURFACE.dgn 

COLLECTOR-PROFILE.dgn 

COLLECTOR-SECTIONS.dgn 

COLLECTOR-QUANTITIES.dgn 

PnP-COLLECTOR-sheet.dgn 

COLLECTOR-STRIP.dgn (strip Plan/Profile) 

COLLECTOR-PVMNT_SIGNS.dgn 

COLLECTOR-WORKING.dgn 

PROPERTY FILES… 

COLLECTOR-ROLLPLAN.dgn 

COLLECTOR-AERIAL.dgn (aerial only) 

COLLECTOR-PROPERTY.dgn 

Property#-Pin#-Owner.dgn (IPRPs) 

Anyone required to access the contract can determine, quickly and with no 

trouble, which files are current & connected to the contract and what each file contains. 
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9. PROPERTY BASICS 

1) INCLUDED IN THE PROPERTY PACKAGE WILL BE… 

 an excel spreadsheet 

 a strip plan with aerial photo attached - all the properties will be identified with a 

sequential number & pin number 

 a roll plan with multiple strip plan attachments within the base 

 an Individual Property Request Plan (IPRP) for each property. (Named “Property#-

Pin#-Owner.dgn”) 

Samples of the drawings can be found in Engineering Standard Setups\PROPERTY 

PACKAGE BASES\.. Also to be found in this folder, are the bases to be used for the strip 

plan and IPRPs. 

General guidelines for colour, a blank spreadsheet and cover letters can also be 

found in the Property Closeout Report folder in Capital Works Deliverables. Specific levels, 

colours, weights and styles are outlined in this manual for the linework and hatching to be 

placed in these drawings. 

See APPENDIX 1 (SECTION 33.1) [LEVELS & SYMBOLOGY] 

Examples of the names for these plans would be as follows: 

COLLECTOR-PROPERTY.dgn - the strip plan that is referenced to Sheet Drawings, ROLLPLAN and 

IPRPs, has aerial plans attached for IPRP references 

COLLECTOR-AERIAL.dgn - can be referenced to other plans & clipped as a reference file 

COLLECTOR-ROLLPLAN.dgn - will have the strip plan attached, possibly multiple times…always 

keep at least one reference in its original position 

04-14209-0018-JONES.dgn  

05-14209-0017-SMYTHE.dgn - IPRP for property identified as numbers 4 & 5 on Roll Plan 

2) PROPERTY STRIP PLAN 

The property strip plan is the first drawing to be completed; it will include the 

required property and easement linework, owner information, number assignments for 

each property affected and hatching. Aerial information is to be attached to this file as 

well. The strip plan will not generally be plotted with aerial information on it, however, 

when the IPRP’s are being done, the aerial information will follow when the property strip 

plan is referenced to the IPRP. Standard naming convention is to be used. “COLLECTOR-

PROPERTY.dgn”.  Use information from levels 1 and 7 in the block files, these can be found 

in M:\Vector\Prop\. 

To determine which blocks are required, attach bramkey.dgn from the portal, as 

the reference file, “\\ourbrampton.brampton.ca \ sites \ 025 \ Business-Services \ TS \ 

TRUEBRAM \”, to find the block numbers for the area you are working in. This drive is in your 

network places on the portal. The property drawing will be the base property information 

referenced to the rollplan and IPRPs, as well as the various contract drawings. 

 Confirm property ownership, include any registered plans that may be in process and not 

yet on the Teranet database. 
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3) ROLL PLAN 

The roll plan will have multiple segments of the strip plan placed above one 

another on larger sheets. The size of these sheets will be determined by the length of the 

project area, for very long projects there will be multiple drawing sheets to keep the hard 

copies to a manageable size. The Roll Plan will also have a chart identifying the owners 

(on each sheet) along with their identification number, the PIN and the address. There is a 

plate in the package that can be used as a starting point and stretched to fit the length. 

4) IPRPS 

Drawings are to be letter sized, portrait where possible. Reference the roll plan, 

multiple times if necessary, to cover the identified property. Complete the titleblock with 

the pertinent information 

When the IPRP’s are being done, the aerial information will follow when the 

property strip plan is referenced to the IPRP. In cases where the property is too long to be 

effectively shown as one piece, or if enlargements are needed on the IPRP for clarity, 

there can be more than one referenced section on the drawing.  

IPRPs do not have a set scale, adjust the included frame/border to surround the 

applicable property and print to fit a letter size sheet. 

The aerials will be displayed with each piece that is referenced, including the 

additional one(s) that are moved and/or scaled to be arranged clearly on the page. 

See APPENDIX 5 (SECTION 33.5.I)[Realty Plans] 

10. STARTING WITH INROADS V8I 

Open the InRoads Suite from your start button 

Microstation will open first; select the design file 

COLLECTOR-DESIGN.dgn 

 

You can Rightclick InRoads Suite to pin it to the task 

bar to make it quicker to initiate in future. 

You can reload Inroads, using the key-in, by 

typing… “mdl l civustat” (this can be set up under an 

“F” key for faster access).  
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If InRoads does not start up...Go to Workspace >Configuration >Primary Search Paths 

>MDL Applications Edit to add “;C:\Program Files (x86)\Bentley\InRoads Group 

V8.11\bin\” (Or the location of your MDL applications), to the end of the list of directories. 

OK to close Edit Configuration Variable dialog, OK in configuration dialog, YES to save the 

changes.  

The main menu will open and it and will be accessible at all times… 

 

 

 

 

 

 

 

 

 

 

 

Open your preference file, surface file and template library … These files should all 

have been copied to the INROADS folder in the Contract Directory and reset with 

read/write access. They can be renamed as they will need to be customized for each 

project. 

>> File > Open… 

“COLLECTOR.xin” Preference file 

“Collector-base.dtm” Surface file 

“COLLECTOR.itl” Template file 

You may notice a difference in the names for the surface created by Survey…although 

the name listed in your Windows Explorer directory (the one you load) may be “Collector-

base.dtm”, when it is listed under the surfaces option in the main menu may read “Survey” 

this is normal.  The external name and the internal name can be different however this 

does become confusing if none of the names match. 

Inroads will create a surface from the corridors selected and save it to the name given by 

you when generating the surface. “PROPOSED” would be the name for the surface 

created using InRoads, an alternate surface, “LIMESTONE”, can also be created. 

The name “survey” can be changed to match the dtm name by right clicking and 

selecting ‘properties’, modify the name to be “COLLECTOR-EXIST” or “EXISTING” then save 

the surface.  By re-naming the survey surface it will be less confusing when working with 

multiple survey surfaces that may be needed for comparisons.  

Multiple survey surfaces, i.e. additional survey information collected after construction in 

the area, may be listed as “survey” “survey1” “survey2”… 
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1) LOAD / SAVE PREFERENCES  

City of Brampton Drawing Standards for level, colour, fonts, cell and text sizes, to 

name a few, are all set up, in the preference file “COLLECTOR.xin” [formerly 

BRAMPTON.xin], under the name “default”.  At this point determine the scale the drawings 

will be plotted and set this up under Tools.  

>> File > Project Options >  

Preferences 

Load  Default 

Close Preferences Dialog 

Set Scale factors for drawings at a scale of 

1:250 or 1:500 (urban or rural) 

>> File > Project Options 

Select Factors Tab, Input Scale Factor of 1 or 2, 

Tab on keyboard, Then Apply and  

Close 

To save the selected scale factor, open 

the preferences dialog box again… 

Preferences 

Save Default 

Close Preferences Dialog 

By returning to the preferences dialog 

box and saving them, the information regarding 

scale factor has been written to the preference file you opened, presumably in the 

Contract Directory, “COLLECTOR.xin”. 

>> File > Project Options  

Unlike other dialog boxes, the options can be accessed even when other dialog 

boxes are active allowing you to check the scale factor at any time before beginning any 

process in InRoads that may be affected. (i.e. Feature Display, Profile or X-Section 

Generation (sections always have a scale factor =1)…)  
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2) INROADS GENERAL SETUP 

This step needs to be done only one time, modifications of this sort do not need to be 

saved every time, the general look and configuration of InRoads will remain, any tool bars 

and lock settings active when Inroads is exited, will re-display as they were when it is 

opened the next time. Tools used most frequently can be customized by docking the 

toolbars for quick and easy access. 

>> Tools > Application Add-Ins… 

ACTIVATE  THE FOLLOWING ADD-INS… 

 Active Project Settings Add-In – provides a floating dialog that displays the active 

surface, horizontal and vertical alignments and superelevation. [Commands 

placed in Tools menu] 

 Compare Surface Add-In – compares the elevations of two surfaces at user-

specified points.  [>> Surface>Utilities>Compare Surfaces…] 

 Copy Preference Add-In – copies a portion of another preference file into the 

active preference file. [>> Tools>Copy Preferences…] 

 Cross Section ASCII Report Add-In – lets you output reports to ASCII, binary, and 

GEOPAK format. [>> Evaluation>Cross Section>Cross Section ASCII Report…] 

 Design Checks Add-In – includes criteria, which are used in design formulas 

whenever the Design Checks Lock is turned on while using alignment design 

commands. [>> Geometry>Utilities>Design Checks…] 

 Display Superelevation in Plan Add-In – displays superelevation data along the 

alignment in plan view. [>> Drafting>Display Superelevation in Plan…] 

 Drive Roadway Add-In – allows you to view the path along a roadway as if you 

were driving along it. [>> Modeler>Drive Roadway…] 

 Find Near Points Add-In – finds DTM points that are near each other within user-

specified tolerances. [>> Surface>Utilities>Find Near Surface Points…] 

 Generate Grade Contour Add-In – displays the path of a specified grade across a 

surface. [>> Surface>Utilities>Generate Grade Contour…] 

 Horizontal and Vertical Elements Add-In – provides commands for the powerful 

component method of creating and modifying alignments. This method differs from 

the PI method of design because you define linear and circular components, or 

elements, instead of by locating, adding and inserting points of intersection and 

curve sets. These components are then computed and fit together to form an 

alignment. [This method is not covered in this manual] [>> Geometry>Horizontal 

Element>Add… / >> Geometry>Vertical Element>Add…] 

 Hydrology and Hydraulics Add-In – lets you display features that affect water flow 

on a DTM, display flow paths (trickles) and tributaries, compute water volume in 

retention ponds, and generate water surface decks for HEC-2, WSPRO, and HEC-

RAS. [>> Evaluation>Hydrology and Hydraulics>…] 

 Import Subsurface Add-In – imports a surface based on the selected surface and 

alignment. [>> File>Import>Import Subsurface…] 
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 Multiple Horizontal Element Regressions Analysis Add-In AND 

 Multiple Vertical Element Regression Analysis add-In – provide commands for 

horizontal/vertical alignment creation and editing with the inclusion of regression 

by least squares analysis. [>> Geometry>Vertical Regression…Geometry>Horizontal 

Regression…] 

 Named Symbology Tools Add-In – provides commands for verifying, editing, 

exporting and importing named symbologies. [>> Tools>Named Symbology 

Tools>Verify Named Symbology… / >> Tools>Named Symbology Tools>Global 

Named Symbology Edit… / >> Tools>Named Symbology Tools>Export Named 

Symbology to CSV… / >> Tools>Named Symbology Tools>Import Named 

Symbology from CSV…] 

 Remove User Data Add-In – removes user data from elements singly or by 

layer/level or region/fence.  [>> Tools>Remove User Data…] 

 Thin Random Points Add-In – removes random points from a DTM based on user-

specified parameters. [>> Surface>Utilities>Thin Random Points…] 

 Update Design Add-In – allows the user to update a selection a selection of design 

surface graphics without rerunning Roadway Designer. The surfaces must be 

created by Roadway Designer initially, and the correct alg and ird files must be 

loaded. [>> Modeler>Update Design Settings…Modeler>Update Design] 

 Variable Manager Add-In – allows the user to enable or disable user specific 

enhancements. These enhancements alter the behavior of specific commands 

based on a specific point solution for a single or limited number of customers. [>> 

Tools>Variable Manager…] 

 View Drainage as Solids Add-In – displays Storm and Sanitary structures as 3D solids. 

[>> Drainage>View>Drainage as Solids…] 
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11. STARTING THE DESIGN PROCESS 

1) DETERMINE PROJECT DESIGN PARAMETERS 

 Design Speed 

 Road Cross Section and any modifications to it 

 Lane Configuration Requirements [Through, Rt Turn, Lt Turn] 

 Taper Lengths 

 Island Locations [if applicable] 

 Transit Requirements 

 Traffic Signal Requirements 

 Lighting Requirements 

 Structures 

 Property Requirements 

 Storm requirements 

 Other services [if applicable] 

2) DETERMINE EXTERNAL INVOLVEMENT 

Notify the Project Manager (PM) of any external involvement required, as soon as it 

is known. The PM will co-ordinate meetings with the affected parties. These may include… 

 Utility conflicts with Gas, Hydro, Water, Sanitary, Bell… 

 Regional intersections where sanitary, water, signals or lighting are affected 

 Conservation Authorities for any waterway works or restricted areas 

 Consultant Bridge Crossings 

 Archaeological Assessments 

The PM will also create RFPs (Request for Proposals) and co-ordinate meetings with 

outside agencies or consultants for things like landscape work and structures work. 

3) DESIGN CRITERIA SPREADSHEET 

Complete Design Criteria Spreadsheet, with all known information. i.e. criteria 

developed through the EA process, or through other directions. Provide to PM for 

confirmation, changes and signature. 

See APPENDIX 4 (SECTION 33.4.I) [In House DESIGN CRITERIA.docx (2pages)] 

4) MINIMUM DESIGN CRITERIA SUMMARY 

STORM SEWERS 

 Minimum pipe size to be 300mm diameter 

 Minimum 1.5 meters of cover below centerline of road to obvert. 

 Co-efficient of 0.9 to be used for all Right of Ways 

 Concrete pipe under roadway, NO PVC pipe is permitted under roadway 

 PVC Leads are accepted 

FLOW VELOCITY 

 Maximum flow velocities 4.5 m/s 

 Minimum flow velocities 0.75 m/s 
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MAINTENANCE HOLES 

 Minimum size 1200mm 

 Maximum manhole spacing 100m for pipe diameter less than 1200mm 

 Maximum manhole spacing 150m for pipe diameter 1200mm or larger 

 Maximum change in direction 90 deg for pipes 900mm or less 

 Maximum change in direction 45 deg for pipes over 900mm 

 Minimum required drop vs change in direction 

o 20mm – 0 deg 

o 50mm – 1-45 deg 

o 80mm – 46-90 deg 

o Obverts to match where pipe size changes 

o Drop pipes provided where difference in obverts between incoming and 

outgoing pipes exceeds 500mm 

CATCHBASINS 

 Max. catchbasin height, grate to pipe invert to be no greater than 2.4m 

 Min. Cover from finished road grade to obvert of lead to be 1.2m 

 Lateral minimums - single 200mm @ 2%, double 250mm @ 2% 

 Maximum spacing... 

o 10m pavement –  4.5% , 75m 

o 10m pavement –  4.5% , 60m 

o 10m pavement –  4.5% , 90m 

o 10m pavement –  4.5% , 75m 

Refer to the Subdivision Design Manual for complete list of criteria. 
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5) TYPICAL CITY STREETSCAPE COMPONENTS 

SIDEWALKS  

 125mm concrete / 150mm driveway / 200mm industrial driveway 

 OPSD 310.010, 310.030, 310.050. 

MULTI USE PATH 

 Asphalt as per Parks standard L511 

KILLSTRIP AND MEDIAN 

 150mm concrete + 200mm Granular A 

PATTERNED CONCRETE KILLSTRIP AND MEDIAN 

 150mm concrete + 200mm Granular A 

 at major intersections for a distance of 75m 

 or to the nearest change i.e. end of island, taper 

GRASSED MEDIAN 

 minimum 3m width, accessible by mowing vehicle, minimum 50m length 

CURBS 

 OPSD 600.040 for roadway 

 OPSD 600.080 for islands 

 OPSD 600.011 for parking lots 
 OPSD 600.060 depressed for bus bays 

See APPENDIX 6 (SECTION 33.6) [Commonly Used OPSD] 
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12. INROADS – CREATING GEOMETRY AND SURFACE NAMES 

BEFORE BEGINNING, ENSURE THAT... 

 InRoads is loaded  

 You are in the design file “COLLECTOR-

DESIGN.dgn” 

 Preferences are loaded 

 Template Library is loaded 

 Existing surface is loaded 

1) CREATE GEOMETRY NAMES... 

Only the names are being created in 

this step, information will be added later. 

To create names for geometry and 

surfaces 

>> File > New|Select the Geometry Tab…fill in 

the name (“COLLECTOR”)  

and add a description…>Apply 

Select the  to the right of “Geometry 

Project” to select Horizontal Alignment, then 

Vertical Alignment, filling in the name/description/style for each and Apply for each.  The 

style selected refers to information set up in “COLLECTOR.xin” to determine how it will 

display later. 

Horizontal Alignment style = “DESIGN-H” /  Curve definition = “arc” 

Vertical Alignment style = “DESIGN-V” /  Curve definition = “parabolic” 

Alignments names can be created for the Main alignment (Collector St) and any 

crossing road alignments (Local Rd, Sample St, Short Cres….) 

Don’t forget to save the alignments as they are created… 

>> File > Save > Geometry Project (“alg”) 

Type in the names or select them  in the dropdown list, then Save. 

Saving the Geometry Project will save all the Horizontal and Vertical Alignment names you 

have just created. 
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2) CREATE SURFACE NAMES... 

Select the Surface Tab and 

create a file named UTILITIES. This file 

will eventually have imported 

information such as utility linework that 

will be needed to display cells in the 

cross sections at the appropriate 

locations. 

Now that the names have been 

created, Close the dialog box and 

then save them to the INROADS folder 

in the contract directory… 

>> File > Save > Surface (“dtm”) 

Type in the names or select 

them  in the dropdown list, then 

Save. 

Saving the Geometry Project will save 

all the Horizontal and Vertical 

Alignment names you have just 

created. 

 

3) MULTIPLE ALIGNMENTS WITHIN A GEOMETRY PROJECT 

For simplicity, the Geometry Project, Main Horizontal Alignment and Main Vertical 

Alignment will all have the same name i.e. “COLLECTOR”.  There is only one Geometry 

Project, however, there can be multiple vertical and/or horizontal alignments linked to the 

Geometry Project. 

Multiple options can be tried at any time by creating new horizontal or vertical 

alignment names. A separate horizontal alignment for each alternate horizontal layout 

under the same Geometry Project name can be created, likewise for the Vertical 

alternatives under each Horizontal Alignment. 

You may use combinations of vertical & horizontal…Select the Horizontal Alignment 

then Select a Vertical Alignment from the list displayed. Only associated vertical 

alignments are available under each horizontal alignment. 

 i.e. you would not be able to select vertical alignment “SE Local” if the active 

horizontal alignment was anything other than “SE Local” in the list shown on the next 

page.  
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4) POSSIBLE GEOMETRY ALIGNMENTS CREATED FOR EXAMPLE PROJECT 

 

 

 

 

 

 

 

 

 

A partial list, for the example project, may look like this… 

*COLLECTOR  -  [GEOMETRY PROJECT] 

*COLLECTOR, ( Collector Road – Main alignment)  -  [horizontal alignment name - description] 

*COLLECTOR  -  [vertical alignment name] 

*Local, (Local Road – Cross Road alignment) 

*Local 

*Arterial A, (Arterial Road A – Cross Road alignment) 

*Arterial A 

*Small, (Small Street – Cross Road alignment) 

*Road B 

**SW Local, (SW corner - curb radius at Local Road) 

**SW Local 

**SE Local, (SE corner - curb radius at Local Road) 

**SE Local 

**NE Arterial A, (NE corner - curb radius at Arterial Road A) 

**NE Arterial A… 

**NW Small, (NW corner - curb radius at Small St) 

**NW Small… 

* The creation of the Project name and Geometry names (for the main alignment and any Cross Road 

alignments) will be done as per the directions under Creating Geometry & Surface Names. 

See INROADS – CREATING GEOMETRY & SURFACE NAMES (SECTION 12) 

** The curb radius vertical & horizontal alignments will be created, along with their names, once the 

horizontal and vertical alignments have been established for the cross roads and the main road. This is 

covered under Create Horizontal/Vertical Alignment 

See CREATE HORIZONTAL/VERTICAL ALIGNMENT (SECTION 19.1) 
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5) SAVING A PROJECT FOLDER 

At this point the preference file, the survey/existing surface and the template library 

are all open and the newly named geometry project and surface have been saved… 

It is now time to save the Project Folder…this is not the same as the Geometry 

Project…the Project Folder, also refered to as the roadworks file, will contain all the links to 

the pertinent files for this particular project i.e. preference file, template library, surfaces… 

>> File > Save > Project > Options 

Select each tab in turn, 

verify the file name then activate  

the add/update boxes beside 

each filename. The existing/survey 

surface will not be updated so 

activate only the Add box. 

Select OK to get back to the 

previous dialog box. 

Type in a filename, you 

guessed it…“COLLECTOR.rwk”  

Save it.  

The next time Inroads is 

loaded, this is the file to be 

opened first; it in turn will open all 

the associated files you have 

identified here. 

At any time during work, 

any of these files can be saved by 

right clicking on the name and 

saving, OR through the pull downs 

>> File > Save… then select the 

type. Alternately the Ctrl+ keys are a quick way to save the active file… 

Project -- Ctrl + P Surface -- Ctrl + S Geometry Project -- Ctrl + G 

Typical Section Library -- Ctrl + T Roadway Library -- Ctrl + R 

It is always a good idea to save periodically as each surface or design phase has been 

completed.  As new components are created, overwriting the Project Folder with 

add/update activated for each addition will be necessary if they are to be loaded with 

the Project Folder (roadworks file “rwk”). Keeping the roadworks file up to date allows 

others to use the correct files, should they be required while you are away. 
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13. IMPORTING FEATURES 

Using the City’s property information (Teranet), copy or place linestrings to 

duplicate property locations. Modify the levels and symbology to coincide with the City’s 

Level and Symbology standards. 

See APPENDIX 1 (SECTION 33.1) 

These elements can now be imported as a feature to the surface as described 

below. Any element can be imported this way to any surface. 

BEFORE BEGINNING TO IMPORT FEATURES, DETERMINE… 

 the surface to create the feature in 

 whether to use the element’s elevation or drape the element onto a selected 

surface 

 whether it is a Random point or Breakline 

 the feature style (how it will display on screen) 

 if these added elements can be included in the triangulation of the surface, or 

excluded.   

IMPORT PROPERTY FABRIC AND UTILITIES LINEWORK… 

>> File > Import > To Surface… the R.O.W. elements 

Surface: UTILITIES This is the surface the feature will be saved in 

Load From: single element/fence/layer 

Elevations: Drape to Surface  Use elevations from surface, not the element elev. 

Intercept Surface: COLLECTOR-EXIST Surface to drape linework on 

Seed name: ROW or P_ROW  Feature names to be used for existing & proposed 

Feature style: ROW_ROW or ROW_ENG_ROW  Style dictates how it will look when plotted 

Point Type: Breakline Indicates feature as linework not random points 

Check off  Exclude from Triangulation 

Apply and follow the prompts >> File > Save > Surface (“dtm”) 

Type in the name or select it   from the dropdown list, then Save. 

Utilities such as bell, water, gas etc. and Regional Conservation Authority (RCA) Regulation 

& Flood lines can be added in a similar manner as may be necessary. As each Pre-Eng 

PUCC response arrives, with the utility locations marked, add the underground linework for 

existing & proposed utilities to the existing & proposed drawing files. All utilities can be 

added to the drawing “COLLECTOR-UTILITIES.dgn” to be imported to the surface you have 

created named “UTILITIES.dtm”. As a feature they have been set up in the preferences file 

to be displayed as a cell, only in the cross sections. This can be used to avoid conflicts 

when designing details in troublesome areas such as where services may be in close 

proximity to storm design. 
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IMPORT FEATURES / NAMING OF IMPORTED FEATURES… 

>> File > Import > Surface 

Under "Duplicate Names" for the treatment of duplicate names... 

Append 

Replace 

Rename 

determines how to resolve naming conflicts in the event a feature already exists 

with the specified name. 

APPEND 

adds the points from the new feature being added to the existing feature. 

...e.g. 

you need to add some ROW lines not included originally... 

use APPEND with the 'seed name' 'ROW' linework added in this manner will be 

added to the original set of lines without adding a new feature name for each selection 

REPLACE 

deletes the existing feature and replaces it with the new one. 

...e.g. 

using the same scenario with the exception that the old ones were removed... 

use REPLACE with the 'seed name' 'ROW' lines added in this manner will be added 

as a new ROW feature using the same name but without saving the previous one...in the 

end you will have only one ROW line that being the last one added.  

RENAME - **Primarily use this one as it allows you to remove individual lines with 

ease. 

renames the new feature, using the specified name as a seed name.  The name of 

the original feature goes unchanged. 

...e.g. 

using the same scenario 

names would change... ROW, ROW1, ROW2, ROW3...all features, old and new are 

saved. 

Feature ROW would hold the initial linework, ROW1 would have a single ROW line or 

linestring, ROW2 would have a single ROW line or linestring and so on. 

Segments can be removed / replaced without re-doing all of the ROW or placing 

discontinuity points 
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14. MICROSTATION WORK WARNING 

1) START MICROSTATION PROCESSES 

This means that any manipulation of individual elements completed will need to be 

re-done. Any information or elements added to the design file independent of the 

generated elements will not be affected since they are not connected to the feature. 

A copied feature is still connected to the original feature by a data tag and it will 

vanish in a “re-display”. Features such as lanes that may be offset (parallel copy) will 

revert back to the single line feature saved within the surface. 

2) REMOVE USER DATA 

InRoads must be active with the appropriate files open to remove the user data 

tags from copied elements… 

>> Tools > Remove User Data 

Select by single element, fence or level to remove the link. 

As with the existing plan information, done by survey, there will need to be some 

cleanup and labelling for the proposed information in the strip plan “COLLECTOR-

DESIGN.dgn”. You may also need to do some cleanup on the existing plan provided by 

survey to duplicate information at sheet breaks. 

Both existing and proposed drafting and cleanup will be done on the profile 

drawing “COLLECTOR-PROFILES.dgn” 

Shading / patterning for proposed features will be done either on the design plan 

(if the roadway is straight and all portions are in the same alignment) or in the individual 

drawing sheets (if there are multiple orientations of the primary roadway or for crossroads). 

So sidewalks, multi use paths, killstrips and medians can be done in the strip plan if all 

drawings are oriented the same way, if not; they will be done in the individual sheets. 

Storm lines on the profile can be patterned in the profile drawing. The profile is 

always displayed in the same orientation for each sheet drawing. 
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15. WORKING AND PATTERNING IN 3D 

1) WORKING IN 3D 

When working in 3D it is advantageous to have a window open with an iso view of 

the project shown. This allows you to spot immediately if the snap lock is not on and your 

linework is going astray. 

Note, in the lower view of the example (3D Linework – ISO Views) in APPENDIX 5, 

that the utilities have been placed in a planar fashion below the working surface and 

above the patterning and property. Priorities are not active in the 3D environment; 

elements are shown at relative elevations. This means that if your roadway linework is at 

an elevation of around 250m and the pattering is generated at an elevation of around 

260m, the patterning will display above the design linework. If the patterning is an opaque 

shape, such as for the proposed asphalt surface, the roadway linework will be blocked 

from displaying. 

 To ensure opaque shading is behind design linework, set your active depth prior to 

placing shapes. To set the active depth to negative fifteen, key in the command 

‘AZ=-15’ enter, and then select the view. 

 To ensure the white opaque island shape displays above the pavement…Set your 

active depth, to negative ten, prior to placing the shape. 

(Command line is ‘AZ=-10’ then select the view) 

 To have the patterning for centre median display above the opaque island 

shape…Set your active depth, to negative five, prior to placing shape for median 

patterning. (Command line is ‘AZ=-5’ then select the view) 

The level names will be ‘ENG_SH_*’  Shading / patterning levels and 

symbology information is outlined in Shading and Patterning Levels. 

See APPENDIX 1 (SECTION 33.1.XIV) [Shading and Patterning Levels] 

To ensure patterning displays properly, all points on the shape must 

be planar, i.e. all on the same elevation. Set ‘ACS Plane Snap’ lock 

ON prior to placing shapes, this will allow you to tentative snap to 

roadway linework, for accuracy, while maintaining the desired 

elevation plane for these elements.  

Placing patterns and shades below zero will allow them to display 

behind the property linework which is generally on elevation zero. If you inadvertently 

place your shape at an elevation which places it above the design elements you can 

move it to a lower elevation by selecting the shape and using the command line ‘dx=0,0,-

Z’ where ‘Z’ is a distance which will place the shape at an elevation below the lowest 

design element, preferably at zero or negative five or ten. You can also use the 

information button to display the shape segments and edit the elevation(s) there. 
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2) A WORD ABOUT ROTATION 

 

A View can be rotated… 

A Reference File can be rotated… 

An Element can be rotated 

 

Rotating a View does not modify any elements; it is comparable to rotating a matt 

frame to display a better view of the picture, the elements have not been moved relative 

to the original frame. 

Rotating a Reference File moves a temporary copy of the original file within a 

design file. (The design file is the file currently active i.e. the elements can be modified) this 

moves the origin, and changes the location, of the “link” to the original file; it does not 

move the original file’s elements. 

Rotating Elements actually moves the individual elements (or a group of elements 

by fence or graphic group); it is comparable to erasing and replacing information in a 

different location/orientation.  Doing this will cause the information to not be 

GeoReferenced, GeoReferencing must be maintained for all information. Some 

manipulation of survey information is needed to correctly reorient single elements such as 

CB’s, IB’s, Guy Wires or Posts, to name a few, this must be done using the origin of the 

element being rotated. 
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1) BASIC DRAFTING GUIDELINES... 

DIMENSIONING FOR STORAGE/TAPER LENGTHS, LANE WIDTHS ETC... 

 TEXT STYLE = “PR-250” OR “PR-500” 

 LEVELS will be ENG_DIMENSIONS and ENG_TX_DIMENSIONS 

LABELLING FOR PROPOSED STORM WILL INCLUDE A DESCRIPTION OF THE PIPE… 

 “PROP 675mm STORM SEWER” with a direction of flow arrow for plan portion. 

 “PROP 52.6m - 675mm CONC STORM @ 0.5% CL 50-D” for profile portion 

ROAD NAMES  

 TEXT STYLE = “STREET-250” OR “STREET-500” 

 LEVELS for linework and text are identified in the list of levels and symbology 

See APPENDIX 1 (SECTION 33.1.III) [PROPERTY LINEWORK AND LABELS] 

ADJUST ALL LABELS AROUND PROPERTY LINES FOR LEGIBILITY. 

Text Styles have been created and can be imported into your drawing, if they are 

not already there.  These are set up based on the plot scale… 

EX-200 exist info for X sections 

EX-250 existing info 

EX-500 existing info 

PR-200 prop info for X sections 

PR-250 proposed info  

PR-250-BOLD proposed info for profile 

PR-500 proposed info  

PR-500-BOLD proposed info for profile 

STREET-250 Street name  

STREET-500 Street name  

. 

. 

. 

**The number (200/250/500) represents the scale of drawing the text will be plotted on. 

All levels/over-rides & text styles are in the City’s seed file (Seed-2DUTM.dgn) and 

can be imported to provide/replace drafting standards. This seed file can be found in 

Engineering Standard Setups for internal users. Consultants will find it in Capital Works 

Deliverables\Engineering Standard Setups\MicroStation v8i\Blank DGN.  
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TO ACCESS STANDARD TEXT STYLES 

Select Place Text 

Then the        next to the Text Style selection 

>> Style > Import 

Select the file SEED-3Dutm.DGN from 

the directory ...\Engineering Standard 

Setups\ 

OPEN  

You should now have all the styles 

listed above in your text styles list.  Save 

your settings and the next time you need 

to change from existing to proposed or 

plan to profile or x-section you can 

select the text style by using the drop 

down list beside text style under ‘place 

text’ 

A list of levels including symbology, patterning & cells, is included in this manual 

See APPENDIX 1(SECTION 33.1) 

A list of some engineering cells, used for design work [ BRAMPTON CELLS V8i.cel], is 

included in this manual 

See APPENDIX 2 (SECTION 33.2) 
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16. INROADS - GEOMETRY 

1) CREATING & MODIFYING HORIZONTAL ALIGNMENTS 

BEFORE BEGINNING, ENSURE THAT... 

 Inroads is loaded 

 You are in Design file “COLLECTOR-DESIGN.dgn” 

 “Collector-base.dgn” is referenced 

 Project is open 

 Preferences are loaded 

 Surface “Collector-base.dtm” is open 

 Horizontal Alignment is active [the alignment is empty at this point, the active name 

will be the one points will be added to] 

2) CREATE HORIZONTAL ALIGNMENT 

Use “Collector-base.dgn” referenced information for the Horizontal Alignment… 

 determine a starting point at the lower chainage, stationing will start at the first 

point indicated 

 determine the intersection point(s), 

 determine the end point…ignore any curve information at this time. 

 It may be advantageous to place a line from each of these points to a point well away 

from the bulk of the information.  On a long project this allows all of the points to be shown 

in one window when adding them to the alignment. This can also be done for the Vertical 

Alignment 

The lines are guidelines only and can be on a miscellaneous level and/or removed later.  

Once these points have been determined, start adding them to the geometry / horizontal 

alignment, in the direction of increasing chainage. 
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3) ADD POINTS TO HORIZONTAL ALIGNMENT. 

>> Geometry > Horizontal curve set > Add PI  

There will be no additional display window, but the prompt in the message area of 

Microstation window indicates the need to… 

>Identify First Point – Indicate first [starting] point in alignment…from this point the 

alignment will dynamically follow any moves connecting the last PI and the cursor. Always 

use tentative selection to identify points. 

 

>Identify Point/Reject – Indicate next point in alignment…continue until the last [end] 

point of the alignment has been identified 

>Identify Point/Reject – Reset 

>Identify alignment end – Reset 

You must reset the second time to exit from the ADD PI mode.  

At this point check to see if the Alignment is where it is intended it to be… 

>> Geometry > View geometry > Active horizontal 

The horizontal alignment will be displayed on the level named “ENG_ALIGNMENT” 

Ctrl + G to save the geometry once verified. 
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4) MODIFY HORIZONTAL ALIGNMENT 

>> Geometry > Horizontal curve set 

Add PI  - allows the initial placement of the horizontal alignment points, it also allows a PI 

to be added on either end of the alignment, it will not allow the placement of a point 

between the two end points.  

 

Insert PI  - allows a PI to be added between two other PI’s 

 

Move PI  - allows any PI to be moved along the alignment between the two PI’s adjacent 

to it, InRoads will select the nearest PI to the data point. 

 

Delete PI – allows the deletion of any PI. 

 

Define Curve  - allows a curve to be placed between two tangents. 

If the alignment is to be modified, zooming in to the area in question to move or insert PI’s 

may make the task easier. 

 

>> Geometry > Horizontal curve set > Add PI  

The prompt in the message area of Microstation window indicates the need to … 

>Identify alignment end 

Place a data point where you would like to extend your alignment, a data point between 

the alignment ends, will automatically select the closest end of the alignment.…message 

will then read 

> Identify point / reject 

Accept, with another data 

point, and the alignment 

extension will dynamically 

follow your cursor.  

Continue adding your PIs to 

complete the alignment, and 

then reset. 

The next message is… 

>Identify alignment end 

Reset again to finish. 
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>> Geometry > Horizontal curve set > Insert PI  

The prompt in the message area of Microstation window indicates the need to … 

>Identify element 

Place a data point anywhere between 

two existing PIs and another PI will be 

created with the linework dynamically 

displayed. If your selection is beyond 

either end of the alignment, “No 

element found” will display.  

>Identify point / reject 

Place your data point where you would 

like the new PI to be.to identify the new 

PI location 

>Accept overall solution / reject 

Accept with a data point 

>Identify element 

Place another data point to select another PI to move OR 

Reset to end the command 

 

>> Geometry > Horizontal curve set > Move PI  

The prompt in the message area of Microstation window indicates the need to … 

>Identify element 

Place a data point in the area of the PI 

to be moved, it will select the closest PI 

to your data point, accept the PI with 

another data point, to confirm the 

selection, and the alignment PI will 

dynamically follow your cursor.  

>Identify point / reject 

Select the new PI location 

>Accept overall solution / reject 

Accept the displayed change with a 

data point 

>Identify element 

Place another data point to select another PI to move OR 

Reset to end the command  
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>> Geometry > Horizontal curve set > Delete PI  

The prompt in the message area 

of Microstation window 

indicates the need to … 

>Identify element 

Place a data point in the area 

of the PI to be removed, it will 

select the closest PI to your data 

point and remove it  

>Accept overall solution / reject 

Accept the displayed change 

with a data point, to confirm the 

selection, or reset to reject the 

selection and the PI will be 

restored. 

>Identify element 

Place another data point to select another PI to remove OR 

Reset to end the command 
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5) ADD HORIZONTAL CURVES 

>> Geometry > Horizontal curve set > Define Curve 

In order to define a curve, there must be at least two tangents in the alignment. 

The Define Horizontal Curve Set dialog allows direct input of the radius of the curve 

between any two tangents.  

The two tangents and associated PI will be highlighted, in the design file, to 

indicate the location of the intersection.  

The Display starts with the first set of tangents and by inputting a radius and 

selecting apply then next > you will temporarily save the curve information just added 

and move to the next possible location for a curve. 

Setting the radius equal to zero will, in effect, remove the curve. When annotation 

of the alignment is initiated, PI’s are shown as a radius of zero. 

Apply for each addition in turn 

Close when all the curves have been added 
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6) RE-DISPLAY THE MODIFIED GEOMETRY... 

>> Geometry > View Geometry > Active Horizontal 

The current alignment configuration will be displayed in the design file, check the 

results, and if all is well…SAVE!!! (Ctrl +G or > File > Save > Geometry) 

REVIEW ALIGNMENTS 

>> Geometry > Review Horizontal 

>> Geometry > Review Vertical 

These commands allow you to review any horizontal or vertical alignment, whether 

active or not.  If there is no vertical alignment created, obviously there is nothing to review 

and only the name and style created would be displayed. 

Use the  to the right of the Alignment Name to select an alignment or use the   

to select one graphically from the design file. 

On either Horizontal or Vertical Alignments Set Mode to Element to see individual 

tangent or curve information. 

This information can be used to label the plan with the required curve data, display the 

data in the design file and move it to label the alignment. 

Current display & text settings are used to display the alignment text. 

Annotating the Vertical Alignment will display this information on the Profile. 
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7) CHANGE THE INITIAL STATION 

BEFORE BEGINNING, ENSURE THAT... 

 Inroads is loaded 

 You are in Design file “COLLECTOR-DESIGN.dgn” 

 “Collector-base.dgn” is referenced 

 Project File is open 

 Preferences are loaded 

 Surface “Collector-base.dtm” is open 

 Geometry Project and Horizontal Alignment are active 

Once the Horizontal Alignment has been determined, and SAVED, the stationing 

can be displayed. 

There are times when the starting station is something OTHER THAN ZERO, an 

example of this would be a continuation of another project where the chainage must run 

continuous throughout the two projects.  If this is the case and the initial station must 

match the previous baselines… 

>> Geometry > Horizontal curve set > Stationing 

Indicate 

Horizontal Alignment [COLLECTOR] 

Indicate 

Starting Station [in this case = 

“1+250.00”] 

Apply 

Close 
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8) ADD HORIZONTAL EVENT POINTS 

BEFORE BEGINNING, ENSURE THAT... 

 Inroads is loaded 

 You are in Design file “COLLECTOR-DESIGN.dgn” 

 “Collector-base.dgn” is referenced 

 Project is open 

 Preferences are loaded 

 Surface “Collector-base.dtm” is open 

 Geometry Project and Horizontal Alignment are active 

There will always be instances where extra cross sections are required, these 

sections could be needed for Hydro Poles, D/W or field access, cross roads or where 

grading may be a problem.  

With a list of Stations on hand… 

>> Geometry > Horizontal curve set > Events 

Indicate Define By Single Station 

Input Station 

Apply 

Continue adding stations & Select Apply each time.  

Conversely you can use the  

to the right of the input field and 

select the location graphically. 

To select a single point 

graphically… 

>> Geometry > Horizontal curve set 

> Events 

Indicate Define By >Single Station 

Select the , the dialog box will 

collapse 

Place a data point at the 

event (D/W, HP), the dialog box will 

expand Apply 

As before, continue adding 

event points graphically, selecting 

Apply each time. 

As event points are added, the 

information will be listed in the area on the 

bottom of the dialog box, they can be 

accessed for editing or deleting by highlighting them in the “Events” box. 
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EVENT POINTS FOR HYDRO POLE LOCATIONS 

Adding event points for driveways or field entrances using the main alignment is 

common practice, however, for Hydro pole locations, you may want to copy your main 

alignment to one called “Streetname-Hydro” and use this alignment when identifying HP 

locations. For these points make sure you identify  Compute Elevation from Active 

Vertical Alignment, and again you may select them graphically, or type in the stations. 

When the Cross Sections are being created, set the interval to zero ( > General) 

and only display the horizontal event points ( > Controls > Critical Sections), this will give 

you a set of sections which is totally devoted to the hydro pole locations. 

Advantages to a separate alignment/section set for Hydro Pole locations... 

 It can be identified as Hydro sections in the set title 

 It is easier to provide as a “dgn” to Hydro with only their sections 

 It is more efficient when generating PDF files of each section 

 It avoids either mixing the hydro pole sections in with the main body of 

sections (which makes it more tedious to identify them for printing), or 

displaying each location as a set of one cross section (which would require 

annotation or updates to be done on each section individually) 

 It is easier to annotate or update them as a group, rather than individual 

sections 

9) DISPLAY STATIONS IN THE DESIGN FILE 

BEFORE BEGINNING, ENSURE THAT... 

 Inroads is loaded 

 You are in Design file “COLLECTOR-DESIGN.dgn” 

 “Collector-base.dgn” is referenced 

 Project is open 

 Surface “Collector-base.dtm” is open 

 Geometry Project and Horizontal Alignment are active 

 Preference files are loaded and Factor is set correctly for the plotting scale of the 

working drawings. 

See LOAD / SAVE PREFERENCES (SECTION 10.1) 

>> Geometry > View geometry > Stationing… 

GENERAL 

Identify the horizontal alignment to be annotated by selecting either the dropdown 

list   or graphically   Station limits can also be set here.  
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REGULAR STATIONS 

Variables allow the chainage to be re-oriented to display either up-station or 

down-station.  Remember that the preferences have been set up to our standard in 

BRAMPTON.xin (which you have renamed COLLECTOR.xin) and are utilized by selecting 

the default preferences. Modifications may need to be made to suit the project, make 

sure your factor has been set correctly for your drawing scale. Changing the orientation 

can be done by double clicking on the far right of the ‘Object’ you want to modify. 

Apply 

Close 
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MODIFY THE STATION DISPLAY 

The preferences have been set up to display stationing linework and text on the 

correct levels with City Standard colours etc.  If the style “DESIGN-H” was indicated when 

the horizontal geometry name was created; the Stations will be displayed at an interval of 

50m, with ticks every 10m along the alignment.  Intermediate stations are on level “MISC” 

where they can be utilized for reference but will not plot on the final drawings. 

UP-CHAINAGE STATIONING IN THIS CASE IS NOT ACCEPTABLE 

 

 

 

 

 

 

 

DOWN CHAINAGE STATIONING IS PREFERED 

 

 

 

 

 

 

The station numbers can be adjusted to align the “+” of 

the station with the “tick” on the chainage line by modifying 

the offsets under Major and Minor Stations.  The stationing 

may have to be displayed a number of times, with minor 

adjustments each time until the text displays in the correct 

location. Once the offsets have been setup, save the 

preferences, stationing can be re-displayed indefinitely without 

the need to move the station text. This is strictly for aesthetics; the “tick” is the 

actual station location-not the label.  

Alternately, the individual station text can be moved to be on the tick; however, if 

the stations are re-displayed they will need to be moved again.  
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17. PROFILE - INROADS | EVALUATION 

1) GENERATE A PROFILE 

BEFORE BEGINNING, ENSURE THAT… 

 Inroads is loaded 

 You are in Design file “COLLECTOR-PROFILES.dgn” 

 “Collector-base.dgn” is referenced 

 “COLLECTOR-DESIGN.dgn” is referenced 

 “BRAMPTON CELLS V8i.cel” has been loaded 

 Project File is opened 

 Preferences are loaded 

 Surface “Collector-base.dtm” is open 

 Geometry Project and Horizontal Alignment “COLLECTOR” are active 

2) CHECK SURFACE PROPERTIES 

Before starting, check that the existing surveyed surface has the style “EXISTING” 

assigned to it, generally it does. A proposed surface should be style “PROPOSED” to 

correctly display the surfaces in profile and cross sections; it will need to be changed 

each time it is generated. The limestone surface will be generated by InRoads as an 

alternate surface and will have the style “LIMESTONE”. 

>> Surface > Surface Properties > Advanced Tab 

Also in the advanced area you can identify distances for offsets you may want 

displayed along with how they will be displayed.  

These offsets will generate a line in the profile representing the surface along a line 

parallel to the main alignment at the distance specified here.   
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3) SET UP THE PROFILE 

Before getting into the setup for the 

profile generation, make sure that 

your options have the scale factors 

set to two (2), for 1:500 scale plans. 

 

>> Evaluation > Profile > Create 

Profile 

GENERAL 

Provide a Set Name…In 

this case “COLLECTOR”  

If stationing runs Left to 

Right, make sure Direction is also 

set to Left to Right, the profile 

should always be generated in 

the same direction as the 

chainage. 

Vertical Exaggeration is 

10:1 for 1:500 scale, 5:1 for 1:250 

scale. (Set up in the xin)  

Surfaces…Identify 

surface(s) to be displayed in the 

profile 

SOURCE 

Identify the Alignment using either the dropdown   or graphic , method of 

selection. 
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INCLUDE 

 Add or remove the crossing Features and/or Projected Features, then set the 

Bandwidth within which these features must reside. 

These would be features 

such as ditches, CSPs and 

bridges. 

OFFSETS 

If you wish to display a 

profile on a line parallel to the 

alignment as well, you can turn 

on and set that offset and how 

it displays under Offsets, if you 

did not do it under “Check 

Surface Properties”. 

CONTROLS > LIMITS 

Generally, a profile 

for the entire alignment will 

be generated, however, if 

only a portion of the profile is 

to be generated, say, to 

check on some numbers in 

a problem area, set the 

station limits here to 

produce a smaller portion of 

the profile. 

Adjust your elevation 

limits to specify 

maximum/minimum elevation to be shown, or you can use the “Window Clearance” 

option to set the number of grid lines above and below the features displayed in the 

profile.  

 To determine the minimum and maximum elevations on a surface… 

On the InRoads Main menu, expand “Surfaces” then highlight the surface, the first two 

lines will display the minimum and maximum information for random elements and 

breakline elements. 
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AXES AND GRID 

These parameters, including symbology, have been set up in the preference file. 

DETAILS > TITLE 

Change the Title Text: on the profile to be descriptive of the profile i.e. use the 

street name, date and contract limits. 

Once the setup has been tailored for your project, save the preferences… 

Preferences 

Save 

Close 

These changes to the profile setup (stations, elevations, title...) will be saved to the 

loaded preference file, “COLLECTOR.xin” Any time you need to generate a profile, in this 

project, these parameters will be used. 

When these preferences have been loaded, modified to meet the requirements of 

the contract, and saved, select… Apply 

The profile will be generated relative to the top view; make sure there is clearance for the 

entire length and height, make note of the direction it will be generated (right to left or left 

to right).  The point selected will become the lower Elev/Sta corner of the grid (lower right 

or lower left); place the profile in such a location so as to avoid conflict with the plan 

information (including any referenced files). 

The Create Profile dialog box will be reduced and the prompts in the message 

area of Microstation window indicate the need to … >Identify Location 

 

 



City of Brampton - Capital Works Contract Design Procedures - January 2017 

  Pat Z. 

94 

Select the location of profile origin. 

You can regenerate the profile as many times as needed to “tweak” the display, 

delete them, using your graphic group lock, as you make changes, once you have it the 

way you want it, save the preferences and make sure you have the final one displayed.  

Place information to identify what drawing number it will be on, street name and 

the date it was generated and any other information which may be useful in identifying 

the use for the profile i.e. specialized or alternate profiles.  You can scale/copy the profile 

title, or place the text independently.  

Any profile generated should be labeled with large enough text that it can be read 

when they are all shown, this way it is not necessary to zoom in to each one to figure out 

which is the one you are looking for. 

The profiles generated will eventually look something like this… 
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18. INROADS - USING ALIGNMENTS AND CORRIDORS 

ALIGNMENTS… 

can be defined as a series of tangents, PIs and curves defining a centerline. 

CORRIDORS… 

are identified by the swath of land outlined by the template limits along an alignment. 

Alignments, and then Corridors, will be created for 

 the Main Alignment (Collector) 

 the Cross Road Alignments (Little, Thru, Small…) 

 the Curb Radius and connecting Alignments (Little-NW, Little-N-Cross, Little-

NE…) 

The preliminary layout and design work can be done in 2D, on a working level such 

as ENG_WK_MISC-#, in the DESIGN file. This will be done, as a drafting exercise, to produce 

linework that can be used as a guide for the changes along an alignment. i.e. tapers, bus 

bays, bus pad/shelters, intersections etc. You will notice that there are a number of levels 

which can be used to do alternatives, construction linework, background information, 

and notes to self (or others) and so on. 

During your InRoads design phase, do your trials in a working drawing (COLLECTOR-

WORKING.dgn) with the DESIGN file referenced.  

Since much of the work to be done, in this exercise, is information that will be displayed, 

evaluated, modified and utilized to produce multiple alignments and corridors, it is a 

good idea to do this in a WORKING drawing. i.e. COLLECTOR-WORKING.dgn 

 Any trial work being done is best to be done in the working drawing where you will not be 

interfering with the preliminary design linework and/or other design information, notes and 

dimensioning. The working file can be wiped clean as often as needed to work out the 

details of the design without risk of loosing any finalized linework. 

 Create names and define Horizontal Alignments for roadways… 

 COLLECTOR 

 LITTLE 

 THRU 

 SMALL 

 SAMPLE 

 LOCAL

 Create names and define Vertical Alignments for roadways…  

 COLLECTOR 

 LITTLE 

 THRU 

 SMALL 

 SAMPLE 

 LOCAL 

 Define corridors for the roadway alignments 

 Identify Template Drops for each corridor, using standard templates (200 series) 

 Generate surfaces for the cross roads corridors to provide accurate 3D information 

with which you can work to define the connection between radius ends.  You will use 

the EPs, CROWN and any lanes or other changepoints between the EPs to define a 

cross connection Vertical / Horizontal Alignments between the ends of the curb radii 

at each cross road. (Curb radius at this point will be the working level initial 

information.) 

 Create Horizontal / Vertical Alignments along the edge of pavement for each curb 

radius on all o f the cross roads. 
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19. ALIGNMENTS - INROADS | GEOMETRY 

1) CREATE HORIZONTAL/VERTICAL ALIGNMENT 

BEFORE BEGINNING, ENSURE THAT... 

 Inroads is loaded 

 You are in Design file “COLLECTOR-DESIGN.dgn”  

 “Collector-base.dgn” is referenced 

 Project is open 

 Preferences are loaded 

 Surface “Collector-base.dtm” is open 

 Horizontal/Vertical Alignment “COLLECTOR” is populated 

 Horizontal/Vertical Cross Road Alignment is populated  

>> Geometry > Utilities > Multicenter Curve 

This command allows you to create a Horizontal / Vertical alignment using two 

existing Horizontal and Vertical alignments by specifying offsets and gradients from the 

existing alignments. The options are self explanatory, the Example shown on the “Main” 

tab identifies what each option represents. 

Before starting this command, use rough linework, drawn on a miscellaneous level, 

determine the radii, offsets and slopes for the intersection. 
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Main Tab & Advanced Tab 

Select the Curve Type:  One Center  Input the determined values for Radius and 

Widths as measured on your rough work from E/P to Alignment. 

Select the Advanced Tab and fill in the Name / Description / Style for the new 

alignment. You can use “DESIGN-H” and it will display the same as the main alignments on 

the plan. 

To create a Vertical Alignment, based on the two alignments being used and the 

crossfall of the roads, make sure the check box beside Create Vertical Alignment is 

marked, choose Gradient and input the slope 

required. Remember that negative values fall 

from the alignment and positive values rise 

from the alignment. 

Select Apply and the dialog will 

disappear so that you can select the first, 

then second alignment, work in the direction 

of the chainage and follow the prompts in 

the message area. 

>Identify first alignment / Reset 
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Place a data point in the 

vicinity of the first alignment, if the 

intended alignment highlights, 

place a data point near the 

second alignment, if the intended 

second alignment highlights, place a data 

point in the area of the correct quadrant 

for the placement of the radius. Place a 

data point to accept the displayed results 

and a Results Report dialog will display 

with the alignment information. 
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The curb radii and connecting alignments will be used to create corridors along the 

EP of the intersections. Define 

corridors for the curb radii, and 

the connection across the 

crossroad. Place your template 

drops, using templates LEP-

MATCH / REP-MATCH, the the 

entire length of the three 

alignments. 

Generate surfaces for 

the Corridors defined for the 

curb radii and cross 

connection, the Curb elements 

will be displayed in plan 

(EP/GUT/FC/BC). 
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Working in Microstation, and using the EP line, make sure that there are no gaps at 

the ends of the three features displayed. 

These features 

need to provide a 

continuous link from the 

EP on the main corridor, 

along the first curb radius, 

the cross connection, the 

second curb radius and 

finally back to the main 

corridor EP. 

The ultimate goal 

of this exercise is to create 

accurate linework to be 

imported to generate a 

Horizontal/Vertical 

alignment, along the EP 

of the cross road radii. The 

newalignment, LITTLE-N, will be followed using Point Controls in the Roadway Modeler 

This Iso View shows the result of the manipulations, you can see how it is in relative 

proximity to the existing information in the area. 

>> File > Import > to Geometry… select the three linestrings… 
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Use the settings as shown here… 

 Select Horizontal and Vertical 

Alignment from the Type 

dropdown 

 Name the new Alignment with an 

appropriate description 

 Style is DESIGN-H 

 As with the alignments created 

previously, the Curve Definition is 

Arc for Horizontal and Parabolic for 

Vertical. 

 Make sure the Target is set to the 

main Geometry Project 

 Check off the boxes for … 

 Resolve Gaps’ 

 ‘Resolve Nontangencies’ 

 ‘Join Elements’ 

 ‘All Selected Elements 

Added to Single alignment’ 

Select Apply and follow the 

prompts… 

> Identify element (with Data point) 

> Accept / Reject (Data / Reset) 

> Identify element (Data)) 

> Accept / Reject (Data / Reset) 

Continue until you have 

identified and accepted all three 

elements, then Reset to stop the 

process. 

The new alignment, with stationing shown, will look like this… 
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Now that you have a single geometry (vertical/horizontal alignment) for the edge 

of pavement through both radii and the connecting pavement crossing, you can utilize 

this as a second alignment to redirect the EP, on your main corridor, around the 

intersection smoothly. 

As a second alignment, this will ‘bend’ the template to be perpendicular to the EP / 

secondary alignment and produce a more accurate section through the radii.  

The radius and crossing corridors will not be used in the creation of the final surface and 

can be removed when the combined alignment has been utilized and verified. This will 

remove clutter from the alignment list and make it easier to find the corridors that are 

being used to generate the final surface. 

This will be done for each cross road. 

Sometimes there will be a need to go beyond the radius on a cross road, for 

matching purposes. If this is the case, a corridor (or corridors) can be created using the 

cross road alignment and specifying a station range which begins/ends at the radius ends 

and will clip the main alignment using Target Aliasing. 

 Create a corridor for each of the quadrants of an intersection and have them clip 

the main alignments in the roadway modeling process, producing one surface with 

all the corridors.  

 Use as a secondary alignment in conjunction with control points, or paremetric 

constraints, to have the edge of pavement follow the horizontal alignment, with (or 

without) the vertical alignment. 
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2) CREATE VERTICAL ALIGNMENT 

BEFORE BEGINNING, ENSURE THAT… 

 Inroads is loaded 

 In Design file “COLLECTOR-PROFILES.dgn” 

 “Collector-base.dgn” is referenced 

 “COLLECTOR-DESIGN.dgn” is referenced 

 Project File is open 

 Preferences are loaded 

 Surface “Collector-base.dtm”  is open 

 Geometry Project and applicable Horizontal / Vertical Alignments are active  

[An alignment can be active but empty, at this point the vertical alignment is 

empty, horizontal alignment must have at least two tangents / one PI.] 

 Profile has been generated 

ADD POINTS TO VERTICAL ALIGNMENT (CREATE VERTICAL ALIGNMENT) 

Working on each profile, place and modify the vertical alignment in the same 

manner as the Horizontal Alignment. Ignore curves at this point. 

>> Geometry > Vertical curve set > Add PI    Follow the prompts… 

> Identify first point 

 The alignment will be shown dynamically and the station, elevation and slope 

displayed numerically at the bottom. 

 Any attempt to place points outside the profile grid or where the alignment would 

cross itself, the dynamic display will stop until you are back to an area in the profile 

acceptable for the next point. 

 Place points in the same direction as the Horizontal Alignment (left ->right / right ->left). 

>Identify Point/Reject – Indicate the next point in the alignment…continue until the last 

[end] point of the alignment has been identified. 

>Identify Point/Reject – Reset 

>Identify Point/Reject – Reset 

It is necessary to reset twice to exit from the ADD PI mode, 

the “Add Vertical PI” dialog box will return 

Close to exit 

SAVE (Ctrl +G) 
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ADD CURVES TO VERTICAL ALIGNMENT 

Now that you have the basic vertical alignment completed, you can go back and 

add the vertical curves and/or move the PIs to better fit the alignment to the project. 

>> Geometry > Vertical curve set > Define Curve… 

The two tangents will be highlighted in the design file starting with the first PI, this is a 

visual check of the active PI location.  

 

 

 

 

 

Complete the Calculate By: 

and Update By: fields. 

Vertical Curve…Calculate By:  

specifies the method for calculating 

curves. 

***This is where the selection of curve type, made when 

creating the alignment name, comes into play. Choosing 

the Parabolic curve will provide options to calculate by 

Length of Curve, r (rate of change), K value, middle 

ordinate, pass through point or Unsymmetrical length.  

Using a circular curve gives radius, pass through and tangent options. 

 Adjacent Curves…Update By:  

specifies which parameter to preserve in recalculated adjacent curves. The 

adjacent curves may be recalculated by Length of Curve, r= (g2-g1)/L, or K=L/ (g2-g1). 

For example… 

If Length of Curve is selected, the length of curve is preserved and the software will 

recalculate the curve. 

Select r= (g2-g1)/L, and the software recalculates the curve length based on the 

original rate of change. 

Select K=L/ (g2-g1), and the software will recalculate the curve length based on 

the original K. 

>> Adjacent Curves 

  Distance  …rounds the recalculated length of vertical curves up or down to the 

nearest multiple of the value specified.  This applies only when Update By is set to r= (g2-

g1)/L or K=L/ (g2-g1).  A zero value (0.0) has no effect; a positive value will restrict the 

changes to increments of that value. If you wanted to, for some reason, restrict the curve 

length to whole meters, you could do that here. 

Select Report to display current element, Ctrl+ Report to display whole alignment. 
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USING THE DESIGN CALC… OPTIONS 

Select…“Design Calc…”  

The Vertical Design Calculator dialog window will appear. You can utilize the 

parameters and methods in this dialog to 

calculate the optimum vertical curve using 

the design speed, K factor, or length of 

curve, whatever the limiting factor is.  

InRoads provides two ASSHTO options, 

1990 & 2001. 

Select the method Compute from 

Speed , input the design speed and place 

a data point anywhere in the drawing and 

the K value and Lengths will be 

calculated, then either… cancel to reject 

the calculations or select OK to accept 

the calculation and it will place the 

calculated values in the Define Vertical 

Curve Set dialog box and close the Design 

Calc… dialog box.   apply 

Select the method Lookup K to 

select the ‘K’ value and the calculations 

are automatic, then either… cancel to 

reject the calculations or select OK to 

accept the calculation and it will place 

the calculated values in the Define 

Vertical Curve Set dialog box and close 

the Design Calc… dialog box. 

apply 

The program will attempt to match 

the parameters indicated, to the PI, there 

will be a Microstation window message 

indicating if the process was completed, 

“successful completion” or not 

completed, “solution overlaps or contains 

discontinuities” 

Using a ‘K’ value for the Adjacent 

Curves…Update By: will maintain the ‘K’ values as previously set at the other PI’s. Continue 

modifying the parameters until you have a successful completion. 
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USING VERTICAL DESIGN CALCULATOR 

In this example, using Lookup K, K value is chosen to correspond with design speed 

of project roadway. OK was selected and the values are transferred to the Define Vertical 

curve Set dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is not until you select Apply 

on this dialog that you know if the 

values are acceptable, in this case, 

they are not… 

Keep trying and once satisfied, 

select Next>  to get to the next 

possible curve location 

in the 

vertical alignment 

and follow the same 

procedure for each 

location… 

Apply 

Close  

To exit. 

>> File > Save > 

Geometry Project 

OR Ctrl +G 

to Save the 

alignment 
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3) ANNOTATE VERTICAL ALIGNMENT 

…displays PI’s, tangent distances, and vertical curve data.   

>> Geometry > View Geometry > Vertical Annotation 

 

 

The tabs for Points, Curves 

and Tangents allow modifications 

to the display parameters for the 

vertical annotation.  

 

 

 

 

 

 

 

Default preferences have been set up for this information… colour, level, number of 

decimals, text height and font; they are saved in “COLLECTOR.xin” (formerly 

BRAMPTON.xin) 
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20. CONTRACT DRAWING PREPARATION 

1) SETTING UP THE PROFILE FOR SHEET BREAKS 

Page break locations should be marked on the plan and on the profile, these break lines 

can be on a “misc” layer and are not to be shown on the final drawing.  (ENG_WK_MISC-2 

for example) Information will need to be duplicated on either side of each break line, in 

Plan and Profile views, so that it will be shown on both drawing sheets sharing the 

information. 

 

This example demonstrates how the profile can be set up when, over a distance, 

the elevation range of the first sheet is not suitable for the entire road length or where the 

slopes change considerably.  

For the elements covered in drawing sheets 2 & 3, in this example, changes will be 

needed for the rotation to match the sheet orientation.  Because the area affected is only 

a portion of the whole project, this re-orientation may have to be done by rotating 

individual or fenced cells rather than graphic groups as was done initially, and as always 

around the origin of the cell. 
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Further and final cleanup of all plans is to be done in “COLLECTOR-??????.dgn” 

using standards as set out in City of Brampton Standard level Setup and Symbology. 

See APPENDIX 1 (SECTION 33.1) 

Some information will need to be completed on the individual drawing sheets, i.e. 

information that is not common to all drawing sheets, including… 

 some of the information in the titleblock 

 proposed asphalt surface and island areas 

 match lines with text and chainage 

 elevations (if not the same on all drawings) 

 Limit of Contract notes and lines 

 profile connective information (pipe ends etc) 

 a typical section (if there will be no “typical sections” sheet created). 

2) ASSIGNING NUMBERS FOR CONTRACT DRAWINGS 

Now that you have determined your main horizontal and vertical alignments and 

displayed your stationing, the individual drawings can be segmented at even chainages 

i.e. at a 10m mark. 

The drawings can be created and the names changed to reflect the sheet and 

drawing numbers as they become available. Consultant drawings provided for structures, 

landscaping etc… will require numbers by the 60% stage, and for each drawing created 

thereafter. 

The new drawings may update currently listed drawings (thereby assuming their 

numbers) or may be completely new drawings for details, removals dimensions or where 

no drawings exist for the stretch of road to be worked on. 

A small hardcopy of the drawings, including the stationing and descriptions in the 

title blocks is to be supplied to the Intermediate Engineering Technician to assign the 

drawing numbers and input the information into EDDI. Be sure to include the project’s file 

number and job description as these will also be included in EDDI so that they can be 

used as part of the search function when looking for these drawings later.  

If you know the order, area & street #, the list could be started with something like 

this…with the sheet number assigned sequentially as the drawings are order in the 

contract placed first to allow for a properly ordered drawing list in the main directory. 

File No. 13-3251-213 Collector Street, Arterial Rd ‘A’ to Arterial Rd ‘B’ 

SHT   DGN # STATION DESCRIPTION 

01   B1-11-  Sta 1+270 to Sta 1+550 165m W to 115m E of Arterial Rd ‘A’ 

02   C1-11-  Sta 1+550 to Sta 1+830 115m E of Arterial Rd ‘A’ to 70m E of Thru Rd… 
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If you are not sure of the area or street numbers, this chart can be created using 

the information provided by the Intermediate Engineering Technician. He/She will return 

the set that you have provided, with the numbers assigned on each page. As new 

numbers are needed and assigned they can be added to the list and this list can be used 

to populate the contract’s index page. 

See APPENDIX 5 (SECTION 33.5.III) [Drawing Numbers List / Spreadsheet] 

3) OVERVIEW OF EXAMPLE PROJECT 

Collector Street is the project target street, it is in areas “B1” & “C1” and the 

assigned street number in each of those areas is 11. The main street of the contract will 

require five (5) drawing sheets in area C1 and one (1) in area B1, shown in magenta. 

There is no curve in this example that would require a rotation of the plate drawing, 

however, the cross roads will require drawings to be prepared for them, in this case, Little 

Trail, Thru Road, Small Street, Short Crescent, Sample Street and Arterial Roads A & B, 

shown in blue. 

There are a couple of methods of doing base sheets or “plates”. Both ways start 

with a drawing plan that will cover the orientation of the greatest number of drawings, 

using the example project it would be drawing…B1-11-1 which would cover all of the 

Collector St drawings. 

One method references the base sheet to each of the numbered drawings, the 

other, has the base sheet information in each of the numbered drawings (copied, or 

merged, into numbered drawing from reference). 

Copy, from Engineering Standard Setups\DESIGN DRAWING BASES\, the design file 

“4-PLANnPROFILE-sheet-2D.dgn” (if you haven’t already done so) and rename it “PnP-

COLLECTOR-sheet.dgn” 

Enter ALL COMMON information on the Base Sheet (plate) to make it as complete 

as possible for this project. Start by rotating the P&P information to be in line with the plan 

drawings, which are referenced, and move plate information to the appropriate location 

for stationing and orientation using a reference of the design alignments. 
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4) KEY PLAN 

Complete the key plan, a border for the keyplan is provided in this drawing, utilizing 

information from the street map in the City Portal. (My Network Places...TRUEBRAM\ 

truebram.dgn) Reference Truebram, then clip, scale/copy the appropriate area to fit 

within the key plan border. This can be done in a separate keyplan drawing and 

referenced into the plate and scaled to fit the border before copying the linework. 

Highlight the copied information and change the levels to match City of Brampton 

Standard Level Setup and Symbology for key plan information. [ENG_KEY & ENG_TX_KEY] 

See APPENDIX 1(SECTION 33.1.I) [GENERAL LINEWORK AND TEXT LEVELS]  

The key plan should...  

 include at least one city quadrant 

 have at least the collector and arterial streets and the project street(s) identified 

 identify major landmarks in the vicinity and watercourses 

 have a North arrow 

 identify drawing locations (basic outlines on base sheet, hatching on individual dgns) 

Orient the drawing’s main North arrow, based on the plan information, use the 

most common direction and adjust it in the individual drawing sheets as needed. 

Complete the legend and as much of the title block as is common to the 

drawings… 

 Road --- Collector Street 

 Proposed Construction Information… 

 Drawing No. --- -11- 

 Scale, Dates, Names and File Number 
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A basic Legend has been provided, 

modify the notes and Benchmark information 

as needed. 

This setup may take some time but it will 

ultimately save time by reducing the 

unnecessary duplication of information input. 

This drawing “PnP-COLLECTOR-

sheet.dgn” will either be...Referenced to the 

numbered drawings... 

This method is preferred as much of the 

repetitive work required for changes to the 

base is eliminated by referencing the base, 

along with the exist & design plans & profile. 

...Or copied to the numbered 

drawings... 

If you are using the copy method, the 

more information you complete here, the 

fewer times you will need to repeat any future 

changes or additions. 

Move and rotate the profile reference 

to line up with the information on the plan & 

profile sheet (plate). Ensure that the stationing 

matches the plan portion and that the 

elevation linework matches. 

 

 

 

There are three types of rotation in 

Microstation. Rotate the VIEW to match the 

border of the plan and profile sheet if 

necessary. 

See A WORD ABOUT ROTATION (SECTION 15.2) 

LATEST CITY 

LOGO / 

DEPARTMENT

… 
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When the information has been added and manipulation is complete in the 

sheet/plate drawing... 

>> File > Compress Design 

When compressing a design, do not eliminate unused levels, styles etc. Check the setup 

to make sure there is nothing checked off… 

>> File > Compress > Options 

 

 

 

 

 

>> File > Save Settings 

 

 

 

>> File > Save As 

 

“PnP-CROSSROADS-sheet.dgn” (For use with the crossing road drawings) 

In the Design file “PnP-CROSSROADS-sheet.dgn” 

Rotate the base information to match the orientation of the cross roads for the 

project, change the titleblock to modify any information specific to the cross roads i.e. 

north arrow…Follow the process as outlined for creating the drawings for the main project 

street to create drawings for each of the cross roads. 

For the typical sections, details, removals, dimensions and so on, there are drawings 

set up in Engineering Standard Setups. 3-REMOVALS-sheet-2D.dgn, 5-DIMENSIONS-sheet-

2D.dgn, 6-DETAILSnTYPICALS-sheet-2D.dgn and so on. These can be utilized for all of the 

different detail drawings associated with the contract. Each base has been slightly 

tailored to the use of the drawing. The “typicals” drawing has some of our standard details 

already drawn, pavement markings and removals each have their own legend. Rename 

the files to reflect the street name and the type of detail. 

These base sheets / plates can be used as references, just as the P&Ps are. (COLLECTOR-

REMOVALS-sheet.dgn, COLLECTOR-DIMENSIONS-sheet.dgn...) 
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5) CREATE DRAWING SHEETS 

BEFORE BEGINNING… 

 Copy design file “COLLECTOR-base.dgn” and rename it to one of the contract 

drawing numbers… “’sheet#’-‘dwg#’.dgn” 

…In this example that name would be “01-B1-11-1.dgn” 

 Open the newly named Design file “01-B1-11-1.dgn” 

 Turn on all levels and Delete all information 

 Reference design file “PnP-COLLECTOR-sheet.dgn” 

 Reference design file “Collector-base.dgn” (If it isn’t already) 

 Reference design file “COLLECTOR-PROPERTY.dgn” 

 Reference design file “COLLECTOR-DESIGN.dgn” 

 Reference design file “COLLECTOR-PROFILES.dgn”  

 Reference design file(s) received from Hydro 

Move reference file “PnP-COLLECTOR-sheet.dgn” to match the desired location & 

chainage on reference file “COLLECTOR-DESIGN.dgn” 

The ultimate result for this initial drawing is to move the referenced sheet (plate)drawing 

and profile drawing(s) to the correct chainage position for the first drawing, based on the 

referenced existing strip plan. 

To manipulate a reference file, you will be working within the Reference Files toolbox. 

When satisfied with the position of the referenced plate on the strip plan and the 

position of the referenced profile(s), in relation to the plate and the strip plan chainage... 

>> File > Save Settings 

Make note of the stations you will use for the match lines at the beginning the end 

of each drawing sheet. 

Not all drawing sheets are required to have the full 280m (140m in a 1:250 scale 

drawing), page breaks may need to be adjusted to avoid splitting an intersection. 

If you have opted to copy the plate information into the numbered drawings, this is 

the point at which you can do that. Although not the preferred method, it may be 

unavoidable in some situations. 

CREATING DRAWING SHEETS  

Once your first sheet has been set up to your satisfaction, with the settings saved, 

you can begin to copy it to create the rest of the numbered drawings. 

Use “save as”, from within Microstation, to create the other drawing sheets in the 

project (02-C1-11-5,03-C1-11-4,04-C1-11-3,05-C1-11-2 and 06-C1-11-1) By moving either 

the reference file of the plate, and/or the plate information, along the referenced file 

“COLLECTOR-DESIGN.dgn” you will be creating a design file for each of the numbered 

drawings. Save the settings before using “save as” to create the next drawing sheet. 
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If you use an element (shape) to clip the reference files, the drawing will 

automatically be adjusted to show the new area of the reference files as you move the 

shapes along the alignment. There are shapes in the PnP sheet on level ENG_WK_MISC1 

that can be used for this purpose. 

6) CLIPPING INFORMATION FOR DRAWING SHEETS 

The drawings should now be set up for clipping the referenced files. Fence an area, 

using the match lines as a guide and snapping to the line ends, or copy the shape from 

the PnP drawing, modify and use it to clip the referenced strip plan(s). The referenced 

profile can be clipped using the profile linework as a guide for fence/shape placement. 

The referenced base sheet will not be clipped. 

The profile may be attached multiple times for extreme elevation changes; it may 

also be attached an additional time to display the elevations/stations/storm information 

on the bottom. 
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The necessary reference file(s) should now be trimmed to the rectangle or shape 

set by the fence/element. Work through each drawing sheet in turn…make sure the 

profile reference is correctly aligned with the stations on the strip plan references and the 

base sheet lines up with both the plan and profile portions required for each drawing. Clip 

the strip and profile plans using the fence/element. 

 

The strip plan and profile design files will remain unchanged during the reference 

file manipulation; only a “snapshot” of the file is manipulated and clipped using the 

reference file toolbar. The reference file can be un-clipped or re-clipped to enlarge or 

reduce the portion that is shown. 

When the clipping has been completed, display the entire sheet in one view, set 

up the levels you want on/off for printing, then save your settings to secure the work 

settings completed, the view will be displayed as it is saved when you, or anyone else, 

next open the drawing. 

Any changes made to a design file will be reflected in all the files to which it is 

referenced. What you see on the screen in this design file is only a snapshot of the original 

drawing file therefore you will need to open the original design file to modify any elements 

in a referenced file.  

  

LATEST CITY 

LOGO / 

DEPARTMENT 

… 
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7) ACTIVATE A REFERENCE FILE 

There is also a mechanism to ‘activate’ a highlighted reference file. Once 

activated, you can modify the reference file elements without leaving your current design 

file. This is handy when you need to do a quick adjustment in a referenced file such as 

remove a stray line or add/move some text.  

When you modify property lines or design elements in “COLLECTOR-*.dgn”, these 

changes will display in any numbered drawings that reference it (in this case B1-11-1). 

When the first drawing has been completed... 

>> File > Compress Design 

>> File > Save Settings (Ctrl + F) 

>> File > Save As …“02-C1-11-5.dgn”  

Adjust the base information as required for this drawing; check the position of the 

plan and profile sheet information on the plan portion and ensure that the position of the 

profile in relation to this sheet is correct. 

Make sure each reference file is correctly oriented and aligned with the stations 

then clip the references using the match lines and profile lines as guides for a fence or 

shape. Placing a shape on a misc level (ENG_WK_MISC-1) to be used for clipping the 

references allows modifications to the area being clipped. Moving or modifying the shape 

will automatically display the new section of the reference file. 

>> File > Compress >Design 

>> File > Save Settings (Ctrl + F) 

>> File > Save As … “03-C1-11-4.dgn”  

Repeat these steps until there is a drawing file for each sheet required. 

For the cross roads, the base will need to be rotated and moved to match Arterial 

Rd A for the first drawing, 07-B2-12-12.dgn, the view can be rotated to show the base in 

the correct orientation, then save it and follow the same method to create the remaining 

drawings. 
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21. NUMBERING DRAWING SHEETS 

Individual sheets will still be needed for the other drawings in a project. There are 

bases created for ‘plan only’ drawings…these have the profile grid removed and contain 

some of the City’s standard details or legends based on the use of each base. Copy to, or 

save as, a numbered sheet, or a generic base plate named to reflect the drawing type 

i.e. “COLLECTOR-DETAIL-sheet.dgn”, “COLLECTOR-REMOVALS-sheet.dgn”... 

As with the plan and profile drawings, you will need to modify information pertinent 

to each drawing in the numbered drawing and the primary information such as key plan, 

titleblock, common information etc can be completed in, and referenced with, the plate. 

Drawing Numbers will be set up as follows… 

Structures Plans “area – 0 – page.dgn” 

General Plans “area – 1 - page.dgn” 

Lot Grading “area – 2 - page.dgn” 

Storm Drainage “area – 3 - page.dgn” 

Sanitary “area – 4 - page.dgn” 

Easements “area – 5 - page.dgn” 

Watercourses “area – 6 - page.dgn” 

Watermains “area – 7 - page.dgn” 

Contract Details “area – 8 - page.dgn” 

WTC / FDC “area – 9 - page.dgn” 

Traffic “area - 10 - page.dgn” 

Plan and Profile “area - # - page.dgn...from this point the centre figure (#) 

would represent the street number. 

These numbers are assigned by the Intermediate Engineering Technician who will 

also add the new drawings to EDDI so that there is no duplication 

 

See ASSIGNING NUMBERS FOR CONTRACT DRAWINGS (SECTION 20.2) 

 

You will prefix each drawing file name with a sheet number you will assign to it in 

the contract. 

See ASSIGNING THE CONTRACT SHEET NUMBER (SECTION 21.2)  
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1) DRAWINGS TO BE CREATED OR MODIFIED 

This README document is found in the City Drawing Templates folder (CAPITAL 

WORKS DELIVERABES) and in the DESIGN DRAWING BASES folder (Engineering Standard 

Setups), and explains, in detail, the required information to be shown on each type of 

drawing sheet. This information is also within each drawing template. 

As with the plan and profile drawings, add each drawing to the list you have saved in 

COMMUNICATIONS, as it is created. Provide a description to the Engineering Technician 

for each drawing to be numbered. 

TITLE PAGES 

(00-C1-8-15-TITLEPAGE.dgn, 00-C1-8-16-LISTPAGE.dgn) 

The title page has been set up with the City map (TRUEBRAM) and text placement 

as well as all the submission stages i.e. 30%/60%/90%/100%/tender/construction. Each 

stage is on its own level so you will need to display only the one which applies for each 

submission. The drawing list page has also been set up with the text placement and the 

submission stages. 

ENGINEERING PLAN & PROFILE DRAWINGS 

(01-B1-11-1.dgn, 02-C1-11-5.dgn …) 

Plan and Profile sheets will have the bulk of the design information on them; new 

curb lines, sidewalks and other street furniture along with shading and hatching. The 

stationing, vertical and horizontal alignment information and construction notes to direct 

contractors are to be provided on these pages. 

NOTE:  Pipe sizes equal to, or greater than, 900mm shall be shown (in plan view) by 

offsetting linework to display an accurate diameter. Center line to remain as the bylevel 

linestyle, outer linework will changed to be LS=0 

Storm underground will be represented in the profile with linework, shading and 

information to identify and describe MHs and storm pipes. i.e. numbers, size, length, 

inverts, OPSD#. 

Any CB/DCB that cannot be placed at the standard elevations i.e. minimum cover 

of 1.2m from obvert to finished c/l and minimum slope of 2%, will also be detailed on the 

drawing, as close as is reasonably possible to the CB/DCB in question. Also to be included 

on these drawings are charts of CBs and MHs contained on each drawing, these will 

include the MH, or CB, number, station, offset, OPSD and MH top, or edge of pavement, 

elevation  

See APPENDIX 5 (SECTION 33.5.V) [Storm Information Charts for DESIGN Drawings 

& Quantities] 
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REMOVALS 

(Sheet#-C1-8-##-REMOVALS.dgn) 

These drawings identify all items to be removed, relocated or adjusted and are 

generally the first to be created. As a general rule, there will be two or three sections of 

the roadway (one above the other). This will necessitate referencing the strip plans 

multiple times and moving some of the references for all but the top one. Give them 

logical names such as...TOP-EX, BOT-EX, TOP-PROP, BOT-PROP, TOP-DES, BOT-DES 

The removals drawings, once created, can be copied to produce the Dimensions, 

Pavement Markings drawings, and any other plan only drawings required since the basic 

setup will be the same on all the plan drawings. 

 When creating the removals drawings...attach the strip plans for existing, design, 

property and pavement markings, then adjust the level display for each series 

(Removals, Dimensions, Pavement Markings) as needed. 

 Removals drawings will not display the design information, but you will need the design 

for determining the limits of the removals. 

 Dimensions drawings will display the proposed roadway and property linework, but will 

not usually display the existing information. 

 Pavement Markings drawings will need to have the base plan for the pavement 

markings attached and will also display the proposed roadway and property linework. 

DIMENSIONS 

(Sheet#-C1-8-##-DIMENSIONS.dgn) 

Show on the dimensions drawings, centerline elevation every 20m, plus vertical 

change points, and dimensions at all horizontal change points to centerline and/or 

property line. Identify the storage-taper stations and lengths. 

PAVEMENT MARKINGS 

(COLLECTOR-PVMNT_MKGS.dgn, Sheet#-C1-8-##-PVMNT_MKGS.dgn) 

The main file, COLLECTOR-PVMNT_MKGS.dgn, will have no information in it, at this 

point, but will reference the design, property and existing files with the levels adjusted to 

show the pavement marking levels in the design file, and basic information on the 

references. This is the file that Traffic Dept will work in. Set up the pavement markings sheet 

drawings with all the files required, generally you can copy either the removals or 

dimensions drawings since the arrangement will be the same, and then adjust the 

references and levels as needed for the pavement markings. 

These drawings will have, in addition to placement of pavment markings, signage 

and pavement markings removals. 

Create a folder in G:\wtengmain and provide all the drawings required to produce 

the pavement markings sheet drawings i.e. Pavement Markings, Property, Plan, Design 

and Base sheet [G:\wtengmain\pavement mkgs\ COLLECTOR – Arterial A to Arterial B] 
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In future, a process will be set up to allow Traffic Dept. to have read access to the 

“wtdesign” folders thus allowing them to reference our strip plans directly and eliminating 

the need to keep the “wtengmain” files updated. 

DETAILS & TYPICAL SECTIONS 

(Sheet#-C1-8-##-DETAILS.dgn or Sheet#-C1-8-##-TYPICALS.dgn) 

These drawings will contain any details required for the contract including, but not 

limited to, typical cross sections, pavement structure and site specific details for items such 

as headwalls. 

PAVEMENT ELEVATIONS 

(Sheet#-C1-8-##-ARTERIAL-A-ELEVATIONS.dgn, 

Sheet#-C1-8-##-LITTLE-THRU-ELEVATIONS.dgn…) 

These drawings will be done for all intersections at a 1:250 scale, some drawings will 

contain only one large intersection, others may have more. Elevations are to be shown at 

the BC, EC and quarter points around the radii, High Points and Low Points. The slope and 

direction of flow arrows will be shown around the radii and through the intersection. 

REFERENCING THE BASE SHEET VS IMPORTING THE BASE SHEET 

There are advantages and disadvantages to each method…which one is chosen 

for use on any given project will be determined by horizontal changes, minimum / 

maximum elevations and intersections, among other criteria. 

The preferred method is to use one plate (base sheet), referenced to each 

drawing sheet. The drawing sheets themselves will have little information in them as most 

of it will be referenced. i.e. plan drawings, profile drawing(s), plate drawing. By 

referencing as much as possible, changes are made once and shown everywhere 

without the need for duplicating the changes in each drawing. There may be multiple 

plates considering cross road sheets will need to be rotated. 

If there is a large elevation change along the road, a valley perhaps, having the 

plan & profile sheet information within each drawing may be advantageous to allow the 

versatility of splitting the profile and changing the elevations for half of the drawing or 

changing the elevation numbers from drawing to drawing for steep inclines. However, you 

could still reference the plate to each drawing if you copied the elevations into the 

numbered drawings and modify them as you do the sheet numbers and description in the 

title block. Extreme vertical changes can be accommodated by referencing the profile 

twice and shifting one of them up, or down, as needed and adjusting the elevation 

labels. 

A roadway where there is little change in vertical or horizontal alignment is an 

excellent candidate for the reference method where changes can be made on a single 

base sheet that is referenced to numerous drawing sheets without a lot of individual sheet 

changes required. 

To use only one plan & profile base sheet, the titleblock information and north 

arrow would need to be done in each individual drawing to accommodate the differing 
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orientations, street names, numbers and descriptions. A profile with a grade change of 

more than fourteen meters over the length of the project, will require multiple elevation 

ranges as you work your way along the street, creating drawing sheets. 

In either method, changes to the legend…things like filling in a drawing number for 

typical sections sheet, detail sheet, dimension etc, as they are created, or adding special 

notes or symbology, can be done by creating a cell of the legend and replacing it at 

each occurrence as needed to reduce the amount of repetition of changes. In the 

reference method, there will be a lot fewer occurrences, as the base sheets are 

referenced. 

2) ASSIGNING THE CONTRACT SHEET NUMBER… 

These numbers are assigned by the Design Technologist, in sequence, to the 

contract drawings once the package has been assembled. When referring to a specific 

drawing, referencing the sheet number makes it easier to locate in the package as the 

drawing numbers may not be ordered sequentially. 

This is how it would look in the Drawing List sheet; the number on the far right is the 

assigned sheet number. The number left of the sheet number is the drawing number 

assigned by the Intermediate Engineering Technician. 

 

The File Number, formerly called a Project Number, is to be obtained at the 

beginning of a project from either the Supervisor, or the Co-ordinator, of Engineering 

CADD, and consists of three parts… 

 The two digit Year 

 The four digit Street Designation 

 The Type of project. 

The Bid Call Number, formerly called a Contract Number, will be assigned by 

purchasing at time of tender. 
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22. INROADS - TEMPLATES 

Templates have been created for each of the City of Brampton 200 series 

standards, some variations, as well as components and half templates for intersection 

corridors. 

Points in the templates are used to allow you to “stretch” the template at 

appropriate locations.  Pre-determined lane configurations and transition lengths can be 

used in the creation of the roadway library. 

The Points within the templates are used by InRoads to create features of the same 

name. 

Examples of Points/Features… 

 REP Right Edge of Pavement 

 RGUT Right Gutter 

 RFC Right Face of Curb 

 RBC Right Back of Curb 

 RFSW Right Front of Sidewalk 

Each feature is unique and has a feature style assigned to it to allow a different 

appearance for plan, profile and x-section instances of each feature. “RBC”, as an 

example, will display in the plan view as per the City of Brampton levels and symbology…it 

will be displayed as a linestring in plan view but will not be displayed in profile. Templates 

do not allow duplication of names so there is another feature created for the left back of 

curb (LBC). 

Feature styles can be modified to display in any aspect, if required for particular 

situations. 

Each template consists of 

components & end conditions; 

each component represents part 

of the road structure. These 

components, along with the end 

conditions, are combined to 

produce the templates.  

The templates will be 

modified to suit specific project 

needs, where pavement width or 

depth, as an example, may have 

been changed, or the sidewalk 

has been moved from the 

standard location to avoid conflicts with other services. Copy the template to a similar but 

descriptive name with an outline of the changes in the description field.  Since the 

template library file name has been changed to “COLLECTOR.itl” in the INROADS folder of 

the Contract Directory, it can be cleaned up, with any unnecessary templates removed, 

and the templates used for the contract will remain with the contract files. 

Templates and components can be imported from another library, ‘.itl’, if things 

don’t go the way you planned or you have accidentally removed a needed template. 

Another contract’s library can be utilized if it is a closer match to your needs. 
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Each point in the template, and its parts, is colour coded to indicate what 

constraints are placed on it. 

Red indicates two 

constraints 

 indicates Yellow

one constraint 

Green is 

unconstrained. 

 

 

 

 

 

The properties for the 

point selected here (Left Back 

of KillStrip) indicate two 

constraints, one distance and 

one slope, from a single point 

(Left Back of Curb). 

These constraints allow 

you to modify a portion of the 

template and have the 

associated points follow the 

change. 

It also indicates that the 

point is shared by two 

components, in the “Member 

of” field. 

 

 

 

End condition components allow you to dictate a portion of the segment and have it 

search for a target, i.e. matching the active surface; it also sets a priority to determine 

which end condition will search first, second and so on.  
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23. INTERFACE - INROADS | MODELER 

1) UNDERSTANDING THE ROADWAY MODELER INTERFACE 

The Roadway Modeler working windows provide a lot of information and allow 

access to many avenues of change. These will be outlined in the following pages.  

There are three main windows in the dialog, Plan, Profile and Cross Section, each 

has a series of view adjustments on the bottom left corner of them. As with Microstation, 

you can zoom in/out, fit all and window an area. In addition, you can change the vertical 

/ horizontal exaggeration for the profile view. 

These views are supported by fields in the remaining area of the dialog box where 

you can input information, change your location, corridor, surfaces etc. 

The top of the dialog box provides the sequence to follow for setting up Corridors, 

Template Drops and so on… these will be outlined in the following pages to guide you 

through the current practices for creating corridors and surfaces. 
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The bottom of the dialog box is where you can specify the corridor, active surface 

and select stations to review in the cross section view. The interval and template name for 

the selected section are shown below the station. 

Overall the modeler provides a good overview of the project with the options to 

modify many aspects of the design corridors and surface. 
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2) ROADWAY MODELER PLAN VIEW 

 

 

 

 

Linework 

 

 

 

 

Transition Zone 

 

 

COLOUR CODING FOR LINEWORK 

 The cyan line in the centre represents the alignment. 

 The brown lines crossing the alignment represent template drops. Right clicking on one 

of these lines will bring up a menu with the choice to “edit”, “delete” or “add 

transition” the template drop. Selecting “edit” will bring up the Template Drops window 

to allow you to edit the drop locations, interval, templates etc.. Selecting “delete” will 

remove that template drop. Selecting “add transition” will provide a transition 

between template drops. 

 The  crossing the alignment represents the current station as identified in yellow line

and below the TEMPLATE/SECTION VIEW. This line can be dragged along the alignment 

to any location chosen. 

 The  and white lines running the length of the alignment represent the edge of yellow

the backbone and limit of grading of the template(s) respectively. 

 The white crosses on the alignment line represent change points on the horizontal 

alignment. In this example, even though it appears straight, the points represent BC & 

EC of a large horizontal curve. Hovering the cursor over them will display the station 

and identification for that point. 

COLOUR CODING FOR TRANSITION ZONES 

 The dark blue areas signify that the template backbone points match. 

 The light blue (cyan) areas signify that the template backbone points do not all match 

but that it has been reviewed or edited at least once. 

 The  areas signify that the not all the template backbone points match. yellow

 If there are red areas, it indicates that you are way out to lunch and none of the 

backbone points from the template connect to any of the backbone points on the 

next template. 
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EDIT TRANSITION 

Double clicking on one of the transition zones will bring up a window with the connections 

between templates shown. This example has one template with a bus bay, one without, 

so there will be unconnected points. 

The bordering stations are identified in the header. 

InRoads will compare the templates and match names for connection. Each 

connection point is represented with a cross, fine crosses are already connected, and 

heavy crosses are not connected. As in the template dialogs, the colour of the cross 

(Green/ /Red) indicates the number of constraints on each point (0/1/2). Yellow

Hovering over a point will display the template name and point name, by selecting 

a heavy cross on one template it will allow a dynamic connection to follow the cursor to 

the other template where you can select a second cross, a new connection will be 

made. 

Zoom in, select the first point with a left click, zoom out, with the mouse wheel, and back 

in to select the corresponding point on the opposite template. 
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This dialog also allows you to connect multiple points to a single point. An 

unconnected subgrade point on the one template can be connected to a subgrade 

point on the other template even though there is already a connection on the second 

template subgrade.  

The first point selected must be an unconnected point (heavy cross), but once the 

dynamic linework starts, it can be connected to an already connected point on the 

opposing template. It will not allow you to select two points in the same template to 

connect. Right clicking on a connecting line will allow you to remove a connection. 

It may be necessary to go back to the templates to make changes after they have 

been assigned to a corridor. 

If templates are modified, you will need to go to the Template Drops for each 

corridor, to syncronize the templates & update the corridors.  

 
Highlight the red template names and select Syncronize with Libray 
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3) ROADWAY MODELER PROFILE VIEW 

As with the PLAN VIEW, the profile view displays a  line representing the yellow

current station location and a cyan line representing the alignment profile with white 

crosses at the change points on the vertical alignment.  

Hovering over the alignment will display the alignment name. 

Hovering over the points will display the change point stations and identification. 

The Active Surface is shown as a white line. 

  

Alignment: COLLECTOR 

POT 
Station: 2+425.277 
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4) ROADWAY MODELER TEMPLATE / SECTION VIEW 

The information below the window identifies the station, interval and template at 

that location. This view displays the template at the station specified and as shown in the 

previous two views as a  line. By dragging the  line in the PLAN VIEW or yellow yellow

PROFILE VIEW it will dynamically change this section, including the information provided 

below it. 

The components of the template are shown in the colours as defined by the 

feature styles. 

The Active Surface is shown as a red line. 

A vertical dashed orange line indicates a Secondary Alignment. These can be 

used to have a feature follow a specific vertical and horizontal alignment and any 

features generated outside the Secondary Alignment will be perpendicular to the 

Secondary Alignment rather than the Primary Alignment. 

Hovering over components / points will display an information block identifying the 

component / point, elevation, style, offset etc..  

A small magenta 

square identifies a point 

that is being influenced 

by a point control. 

Right clicking on it will 

bring up a menu that 

allows you to choose to 

“edit horizontal point 

control” or “edit 

station”. The first option, 

when selected, will 

open the appropriate 

point controls window 

where you can review 

or adjust the 

parameters. 

Selecting the 

“edit station” option will 

bring up a window with 

that section and allows 

you to modify that 

single station. 

This does not 

modify the template, 

only this occurrence of 

the template. 
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5) USING THE ROADWAY MODELER 

BEFORE STARTING YOU WILL NEED… 

 Horizontal and Vertical alignment(s) or a surface feature which defines the location 

of the design 

 Existing surface for the extents of the design 

 Cross section Templates created / modified with the Create Template command 

>> Modeler > Roadway Designer 

>> File > New 

Create a new “ird” file, “COLLECTOR.ird”  

In the main working window, the basic process is to follow the icons from left to 

right, following the prompts to create the various files. This window displays the progress in 

three views, when you Process All. Reviewing the sections displayed allows you to detect 

problems without having to regenerate each time a modification is made. 
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6) MANAGE CORRIDORS... 

…allows you to create corridors from the alignments you have previously created.  

These alignments have already been populated for the main horizontal & vertical 

alignments and the cross roads horizontal and vertical alignments. See Create Horizontal 

Alignment & Create Vertical Alignment 

Then the corner radii vertical & horizontal alignments were created using the multi 

centre function under the Geometry Utilities. See Create Horizontal/Vertical Alignment. 

Use the main alignments (Primary Road and Cross Roads) to create a corridor for each 

roadway. These corridors will be used in the next step to set your template drops. Assign a 

descriptive name for each corridor; specify the horizontal and vertical alignments as well 

as stations along the alignment (usually the entire alignment). Add each corridor as it is 

defined; it will appear in the list on the bottom of the dialog window. When the major & 

minor corridors have been defined, close the Manage Corridors dialog box and select a 

corridor in the main dialog. 
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7) TEMPLATE DROPS… 

…allows you to specify which templates are dropped at what stations, and a 

specified interval before the next template drop, for each corridor. It also allows you to 

change any of these parameters while modifying the corridors. 

Identify each of the corridors created in a previous step in turn, populate the 

station, specify an interval at which to drop subsequent templates. (The interval for a curb 

radius could be <1m since they will be short alignments).  Select the template from the 

drop down list and Add, repeat as needed to complete each corridor. Close will return 

you to the Roadway Designer dialog. 

You should now have the main and crossing corridors completed. 

Note: If the template is highlighted in blue, it means that no template was found and it 

needs to be replaced with an alternate If highlighted in red, the template has been 

changed and needs to be synchronized with the template library. Highlight the affected 

template(s) and select Synchronize with Library 



City of Brampton - Capital Works Contract Design Procedures – January 2017 

Pat Z. 
135 

8) TARGET ALIASING…  

To set target aliasing, select each corridor in the list; one after another, ensure that 

the active surface is the existing surface as it will be the “target surface”. 

Clipping Corridors, while an effective way to create a single surface from multiple 

alignments/corridors, will sometimes cause the subgrade to fail to display in the cross 

sections beyond one of the clipping sites. This has an adverse affect on the volume 

calculations in that you will need to manually draft and measure the missing areas. 

>> Tools > Target Aliasing 

…highlight, and then add/remove the corridor(s) that you wish to clip with the 

active corridor. The ‘aliases’ column is the list of corridors that will be clipped. 

The major alignment / corridor will generally be clipped by the minor corridor and 

all the radius corridors for cross streets or ‘T’ intersections. As shown here the selected cross 

street corridor “LITTLE” will clip the major (COLLECTOR) Click OK after the alias selections 

have been completed. Set active the next corridor and repeat alias selections until all 

corridors have been done. 

The selections made here will determine which aliases are clipped by which 

corridors when generating your final surface. 
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9) POINT CONTROLS 

...allow you to stretch the templates, in the active corridor. 

A feature can be directed to follow a horizontal, and/or vertical, alignment such as 

a curb radius. 

To have the edge of pavement follow the Vertical and Horizontal alignment 

created for a curb radius, and make the template ‘bend’ at the radius alignment… 

 Provide a description of what this point control is being directed to do 

 Identify the point to drag (LEP) 

 Select the Mode (Both) 

 Select the Control Type (Alignment) 

 Identify the Horizontal and Vertical alignment names 

 Check ‘Use as Secondary Alignment’ 

 Station Limits (will populate automatically using the active corridor chainage, 

based on the limits of the secondary alignment), do not include any offsets for this type of 

manipulation.  Add 

SEE “SECONDARY ALIGNMENTS” (SECTION 23.13) 

Features in a template can also be offset to create a turning lane or to move a 

sidewalk around an obstacle for example. 
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The horizontal offsets are from centre line, in this instance there is a sidewalk 

connection required so the back of the sidewalk is being stretched to meet the 

subdivision sidewalk. 

If you 

know you need 

a right turn lane, 

you can identify 

the point ‘REP’ 

at the start of 

the taper, by 

station and an 

offset from 

centre, then the 

end of 

taper/start of 

storage, by 

station and an 

offset, that is 

greater by 3.5m, 

then finally by 

the final station, 

usually 

somewhere into 

the intersection, 

and the same 

offset as the start of storage, or ‘LEP’, but with the storage taper sequence in the reverse 

order and the offsets will be negative.  Add after each new set of information. This will 

stretch the template’s right edge of pavement out to the limit of the right turn lane. This 

can also be utilized for bus pad locations etc. 

 

 

 

 

 

 

If the point control is highlighted in orange, it means that you have overlapped your 

stationing i.e. Your LBSW stationing for example has been identified as “1+828.501 to  

1+830” AND “1+830 to 1+830” ...changing one of the offsets from 1+830 to 1+830.001 will 

likely resolve the issue 
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10) PARAMETRIC CONSTRAINTS 

...allow you to stretch the templates, in the active corridor. 

Similar to Point Controls, a feature can be directed to follow a series of offsets. 

Situations where this 

is used could be to 

adjust a killstrip 

around, or pull the 

back of the 

bikepath out 

behind, a bus pad. 

Unlike Point Controls 

the offsets are 

measured from the 

previous feature in 

the template, not 

the centerline of the 

template, again 

working from the 

center outward. 

 

>>Tools > Paramentric Constraints… 

As with Point Constraints, templates work from the center outward and overlaps in 

stationing will display in orange. Stations that do not fall within the alignment being used 

will display in red. 

When determining the offsets, keep in mind what the related/previous feature is 

doing. The example below shows the offsets using Point Controls and Paramentric 

Constraints. 

Using Parametric Constraints, the back of the killstrip is offset from the back of curb, 

the front of sidewalk is offset from the back of killstrip. 

This situation would lend itself to using Point Controls for the back of the sidewalk 

because the front 

of the sidewalk is 

being controlled 

by Parametric 

Constraints, the 

changepoints do 

not occur at the 

same chainages 

for the back of 

sidewalk and front 

of sidewalk which 

would make for a 

more difficult 

transition. 
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11) END CONDITION EXCEPTIONS 

This tab will allow  

you to override the template 

 for a specified length 

 of the active corridor.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12) DISPLAY REFERENCES 

This tab allows you to turn 

 on/off the alignments and/or 

 features displayed in the plan 

 view of the Roadway Designer 

 window. This can be useful for 

 comparison of Right Of Way 

 to disturbance limits 

 as an example. 
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13) SECONDARY ALIGNMENTS 

Use this tab to identify the 

 secondary alignments to be 

 utilized for each corridor. 

Secondary alignments 

 are a good way to redirect 

 the features in the Primary /  

Active Alignment. As in this 

 example, you could create 

 an alignment along the 

 proposed edge of pavement 

 to be followed through an 

 intersection. 

 

 

 

 

Creating a 

horizontal/vertical 

alignment around the 

curb radii allows the 

template to bend at 

the 

feature/alignment to 

produce linework, 

beyond the edge of 

pavement, which has 

a more accurate 

offset than if the 

template were to run 

straight through. The 

edge of pavement 

follows around the 

radii through the 

intersection.The 

 line shows yellow

bend in template 

drop.  

However, running the secondary alignment around a curb radius can sometimes 

produce a situation where the alignment turns back on itself. This may cause error 

messages or wild points. For these intersections, you may need to modify the affected bit 

to mitigate the overlapping stations. If all else fails, clipping corridors may be a more 

effective method.  
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14) CLIPPING CORRIDORS 

There may be instances when you will need to use this method of creating a 

surface. In the diagram shown here… 

 MAIN CORRIDOR would be COLLECTOR in our working example 

 MINOR CORRIDOR would be any of the cross roads 

 NW/NE/SW/SE CORRIDORs will be created using the radii alignments. 

Remember that a “corridor” is the result of running a template, or templates, along an 

“alignment”. 

For each alignment, corridors will be defined using stations and templates to 

produce a surface within their limits. These corridor surfaces will be merged and clipped, 

based on the Target Aliasing defined, under Tools, for each corridor. 

See TARGET ALIASING (SECTION 23.8) 

This will produce a single surface as the end result.  

See CREATE SURFACE (SECTION 23.16) 

The MAIN CORRIDOR and MINOR CORRIDORS will be continuous through the intersections, 

the corridors created at intersections using the radius alignments, will be set up to clip 

them.  These radius alignments were created in “Create Horizontal/Vertical Alignment”, 

using multi center curve.. 

>> Geometry > Utilities > Multicenter Curve  

See CREATE HORIZONTAL/VERTICAL ALIGNMENT (SECTION 19.1) 
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15) KEY STATIONS 

This tab allows you to input stations where you specifically want a template to be 

placed above and beyond the interval placement specified in the corridors. 

Places these station may be needed… 

 The end of a curb radius (as shown below) 

 At taper/storage change points or at any change in width of roadway 

 At points of change in direction/bends in the horizontal alignment 

 At points of change in direction of sidewalks or multi use paths 
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16) CREATE SURFACE 

Ensure Active Surface is the Existing surface prior to selecting Create Surface. Select 

alignment(s) in “Create Surface(s) from” list to identify alignments to use for generating 

surface. 

 

 

Use the Create Surface 

function, identify the main corridor 

(COLLECTOR), to be used to create 

the surface. 

All of the corridors you have 

will be listed here. If you have not 

removed the ones used to create 

the secondary alignment(s) to clean 

up the list, they will be shown as well. 

If you recall, we used the “LITTLE***” 

corridors to create the secondary 

alignment (LITTLE-N) to guide the 

edge of pavement through the 

intersection. These are listed, even 

though we will not be using them for 

the surface. They can be deleted in 

the roadway modeler once the 

secondary alignment has been 

created, saved and verified. Once 

deleted, they will not appear in this 

list. 

If you have opted to not use 

a secondary alignment for this 

intersection, you will need to 

highlight all these corridors to 

combine them as per the clipping 

options set up when you assigned 

target aliases. You can override the 

clipping function by selecting 

Clipping Options and changing the 

options. 

Be sure to check the Create 

Alternate Surfaces box as there is a 

limestone surface identified in the 

templates. This surface will be used for volume calculations allowing you to more easily 

provide both granular and limestone quantities. 
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When your proposed surface has generated, exit the modeler and define the 

feature style for the new surface. 

>> Surface > Surface Properties > Advanced (tab) 

Select your proposed surface and set the symbology to PROPOSED for the Cross 

Sections and Profiles. Also check off the “Use Features Only” box, this will ensure that when 

you generate your sections the surface will stop at the grading limit and not continue on 

using the extra triangles formed at intersections. These triangles are not an accurate 

representation of the surface. 

 

**At this point save the proposed surface and  re-save the geometry project file using 

“save as” and add the options for the newly created surface(s) if they are  to be loaded 

each time the geometry project is opened.** 

Also be sure to save the preferences if they have been modified. 

Any design surface generated will need to have the properties modified to reflect the 

PROPOSED style so when you regenerate the surface multiple times to tweak the design, 

you will need to change the properties of the design surface prior to generating or 

updating the profile or cross sections. 
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24. FEATURE MODIFICATION - INROADS | SURFACE 

1) ANNOTATING THE CENTERLINE 

When the surface has been generated and finalized, annotate the C/L every 20m 

in the plan, and also include any High or Low points and PI’s. These elevations will be 

displayed on the Dimensions drawings. 

2) MODIFY FEATURES 

EDIT FEATURE POINT 

Before triangulating a surface in InRoads, lines can be joined for smooth contouring 

– this would include things like matching the sidewalk feature to a curb radius or adding a 

sidewalk connection to a subdivision (if you have not done so using Point Controls or 

Parametric Constraints). Anywhere there is a need to manually complete connections or 

make additions. 

>> Surface > Edit Surface > Edit Feature Point 

To correct or adjust information the information can be input directly…

 

Place a tentative point on the ultimate position (the end of the line to be matched) to 

obtain the co-ordinates and/or elevation for direct input. 

The  to the right of a field allows graphical selection in the design file of a 

location, elevation or the feature, reset will jump to the next feature. Each feature will 

highlight in the design file as it is selected and the name of the feature is displayed in the 

message area of the MicroStation information bar, use the data button to accept the 

desired feature.  The feature point corresponding to the number, in the dialog box, will 

highlight in the design file to identify specifically which point on the feature is being 

modified.  
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INSERT OR DELETE POINTS ON A LINEAR FEATURE. 

Delete will remove the highlighted point 

Insert will place a new point midway between the current point and the previous 

point. By definition, the midway point is the precise centre of a line drawn between the 

current and previous points, horizontally and vertically. 

 

After each modification…Apply 

The points ahead of and behind the currently selected point are identified at the 

bottom by its location relationship to the current point. i.e. (distance / direction / slope / 

elevation) 

Occasionally, as work continues… Apply then Close 

Ctrl+S [to save the surface] 
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Redisplay the features that have been worked on to verify accuracy. 

Again…we are doing these trials and modifications in the “WORKING” file… 

>> Surface > Update 3D/Plan Surface Display 

Highlight the features to be displayed; only those features selected will display. 

This is a change from the previous versions where additional features could be selected to 

display/refresh. Any features currently displayed, but not selected, will be removed from 

the drawing so all required features must be selected at one time. To help the selection 

process, the features can be re-ordered by name or style. Elements will display, or be 

removed, as each selection is made. 

There is no Apply option here, it is a dynamic process. 

Other surface modifications may include adding linework, which has been drawn 

in the correct spacial location, for the second curb radius on a bus bay as an example. 

This can be added the same way as Importing Features for utilities but using the element 

elevation instead of draping to a surface. 

Create backup surface files under \contract directory\BACKUP or \contract 

directory\INROADS\date  Redisplay features as they are modified to ensure accuracy, 

and then save the surface and copy a backup to a backup directory, rename it by 

appending the date/time to the surface name. 

These files can become corrupt and any changes made since the last backup can 

be lost.  At the end of a day of many changes, make sure the features are displaying 

properly and create a dated backup directory of the InRoads files. This can be done prior 

to making major changes or trials to save a working copy that can be used if the 

experiment does not work. If this step is not taken, the surface can be regenerated and 

changes repeated should the need arise.  To minimize repeating work, save multiple 

copies. 
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25. PROFILE ANNOTATION - INROADS | EVALUATION 

1) ANNOTATE PROFILE  

The newly created PROPOSED surface elevations will need to be displayed in the 

profile, along with the stationing information. 

>> Evaluation > Profile > Annotate Profile… 

…places the road grade and station information on the profile where it can be 

manipulated into a position that will display on the base sheet it is referenced to, as per 

the City of Brampton standard drawing requirements.  

This is saved in the preference file “COLLECTOR.xin 

GENERAL 

Select the vertical alignment and surface to be annotated as well as whether you need 

vertical events, generally vertical evens and station intervals are displayed to include BCs, 

ECs and High and Low points. 

SELECTION 

Choose what you wish to be annotated; in this case the proposed elevation and station 

are to be annotated. 
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The rest of the options listed in Annotate Profile have been set up with City 

Standards for how the items are to be displayed. i.e. font size, levels, colours etc. (in 

COLLECTOR.xin) 

Apply and the result will be stations and elevations of the proposed surface along 

the bottom of the grid. 

 

26. CROSS SECTIONS – INROADS | EVALUATION 

CROSS SECTION REQUIREMENTS 

This is the minimum amount of information required on cross sections… 

 Directions, for viewer orientation (N, S, W, E) 

 Existing surface 

 Proposed surface 

 Slopes (where typical is not used) 

 Station 

 Title / Date 

 C/L Elevation 

 E/P Elevation 

 Property Lines (Proposed, Existing, Grading – as 

imported to the Utilities surface) 

 Utility locations (as imported to the utilities surface) 

 Fence location (from surveyed surface and/or 

proposed fence imported to the utilities surface) 

 Vegetation (Woodlot, Impacted trees or trees not to 

be impacted – from surveyed surface) 

Cells have been created with cross section borders 

to be used when generating sections. Three sizes are 

available to suit the width of section needed. 

See APPENDIX 5 (SECTION 33.5.VII) [Cross Section] 
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CROSS SECTION SETUP 

Before getting into the setup for cross 

sections, make sure that your options 

have the scale factors set to one (1) 

Cross Sections are always plotted at 

a 1:200 scale. 

 

 

The result of not setting the scale factor 

to one and forgetting to change the surface 

symbology of the new surface that was 

created to “PROPOSED” is shown here. The 

text locations are set up based on a scale 

factor of one and the surface symbology 

(PROPOSED) is to be a heavier lineweight than 

is shown here. 

 

1) CREATE CROSS SECTIONS 

CREATE CROSS SECTION > GENERAL 

The Set Name: will 

automatically populate 

with the corridor name, 

you may change it to 

provide a date and/or 

description. Subsequent 

cross section sets which 

are generated without 

removing the first set will 

have the corridor name 

with a number appended, 

in sequence, for each 

additional cross section 

trial. No two sets will have 

the same name. 

In Create: 

 Window and Data 

is selected. 



City of Brampton - Capital Works Contract Design Procedures – January 2017 

Pat Z. 
151 

Interval: is usually ten (10). The minimum requirement is twenty (20), however, ten 

gives you a better idea of what is happening and a more accurate end area volume 

calculation. When generating the PDFs later, for tender/construction, you can generate 

only the twenty meter interval sections along with any special circumstances. 

Left Offset: & Right Offset: will depend on the extent of the impact to the roadway. 

Obviously a ROW of 20m would not require a 60m wide cross section. There may be times 

when you will need only one side, the opposite side can be set at a minimal distance of 

maybe 5 or 10. These numbers will be adjusted to suit the conditions and requirements. 

Vertical Exaggeration: is always 2 for cross sections, scale for plotting is 1:200 

  Show Data Outside Elevation Range should be checked off 

Surfaces: select the surfaces to be displayed in the cross sections. The Utilities 

surface will be utilized by updating the sections later to show fences, property lines etc. by 

displaying projected lines. (You don’t want to display the surface line, only the utilities) 

Properties… when selected, will bring up the surface properties dialog, this allows 

you to make sure that the surfaces have the correct style associated with them, 

particularly the proposed surface. 

CREATE CROSS SECTION > SOURCE 

Select the source, i.e. 

the alignment for the sections 

to be derived from. 

Single Station can be 

used when information is 

needed at a specific location; 

it is also given a set name.  

Assign a name prior to 

generating cross sections to 

identify specific runs, if 

needed, by name and date. 

These dated sets are a good way to keep a timeline of work, and changes, being done. 

CREATE CROSS SECTION > INCLUDE 

Crossing Features and Components are to be displayed in the cross sections. 

Crossing features are features such as utilities and R.O.W 

Components, such as sidewalk, subgrade, will be displayed in the cross section and 

the volume calculations will be made around these components. 
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CREATE CROSS SECTIONS > CONTROLS > 

 > LIMITS 

Elevation limits can be set here if you want all sections to be a specific range, 

leaving this unchecked will allow InRoads to generate only the required height to 

encompass the 

elements in each 

section. In the Layout, 

space above and 

below section 

information can be 

dictated to provide 

clearance for labeling 

etc. 

Station limits can 

be set since most often 

you will not do the 

entire stretch of the alignment. Generally when the alignment is set up there is room at 

either end, just in case there is an extension to the project limits. Set the station limits to the 

functional portion of the horizontal/vertical alignments. 

> CRITICAL SECTIONS 

Check off the points 

you wish to include in your 

section set, generally 

Horizontal and Vertical Event 

Points. 

There may be 

instances where other Points 

need to be displayed as well. 

 

 

 

To generate a section set for HP locations that have been identified as event points on a 

duplicate alignment copied from the main alignment (“COLLECTOR-hydro”) 

Make sure “COLLECTOR-hydro” is identified as the alignment 

Interval is set to zero 

Horizontal event points are selected to display (under Controls>>Critical Sections). 
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> PLAN DISPLAY 

This section refers to lines that will be generated on the plan to represent the cross 

section locations. Normally these will be off; however, there may be instances where you 

need to have them displayed to be used for measuring perpendicular distances off the 

centerline for details in minutia. If this is the case, you can check off the Planimetric box 

under Symbology. The default is for them to be generated at zero elevation, to change 

this you will need to check the Planarize box and specify the elevation desired. These lines 

will be generated in this active design file, not the original plan design file. 

CREATE CROSS SECTION > CUSTOM > 

> GENERAL 

To this point, the series of 

cross sections generated will 

have all the same parameters 

i.e. same interval, offsets... In 

this dialog, ranges can be set 

with different parameters; 

sections can also be done 

perpendicular to the series at 

specified stations. Normally one 

set of parameters is adequate, 

but if there are areas in the 

contract requiring considerably wider sections or more sections 

within a specified area, this would be the place to identify them.  

> LAYOUT 

This dialog aligns the cross sections by either the left edge or at a specified offset. 

CREATE CROSS SECTION > LAYOUT > 

> GENERAL 

Sheet Mode will be selected 
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> SPACING 

Sections per Column: is set up as eight (8), but 

can be modified to suit the individual project 

requirements 

Horizontal distance is 20m between the right side 

of one section and the left side of the next column 

Vertical distance is 15m between the top of one 

section and the bottom of the one above it 

Window Clearance can be left at 3m or increased 

to provide room for underground work or other 

additional information required. Again, this is project 

dependant. 

Direction refers to which way the sections will be 

generated, one above the next (Bottom to Top) or one 

below the next (Top to Bottom) 

> SHEET BORDER 

New practice requires a cross section sheet base on each section. To that end, there are 

now cells with all the pertinent information for the sections. As before, they are to be 

printed on letter, legal or tabloid sized paper, one per sheet. 

 

 

 
The descriptions can be changed using the 

Find/Replace text function under Edit in Microstation, it 

can also be edited individually for any revisions done. 

The sections can be set up using the iPlot method to 

print enmasse or to create a PDF file. Set up an ips file 

with all of the individual sections, just as you would for 

the contract drawings. This allows any, or all, of them to 

be quickly generated into a PDF file any time there are 

changes without the need to fence each section again 

for printing. 

See PLOTTING CONTRACT DRAWINGS – USING IPLOT (SECTION 30.1)   

LATEST CITY LOGO / DEPARTMENT… 

LATEST CITY LOGO / DEPARTMENT… 
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> SHEET LAYOUT 

The main parameters for sheet setup are under sheet layout, getting the spacing 

correct between the bases and cross sections can take some tweaking. Select a small 

range of sections to play with to get the setup finalized for your particular needs. 

Each project is going to be different since sizes vary, as do changes in elevation 

and other structures and/or utilities that may need to be included on the cross sections. 

The values set up in the COLLECTOR.xin (renamed from BRAMPTON.xin) will get you 

started. Remember to save your preferences when you have a setup that works for the 

project. 

> SHEET GENERATOR 

Not currently utilized. 

> SHEET RANGE 

Not currently utilized. 

> SHEET ANNOTATION 

Not currently utilized. 

CREATE CROSS SECTION > AXES > 

> LEFT  /  > BOTTOM  /  > RIGHT  /  > TOP  /  > MIDDLE 

The axes parameters have been set up to City standards in BRAMPTON.xin. 

(Renamed COLLECTOR.xin at the beginning of the process. 
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CREATE CROSS SECTION > GRID > 

> GENERAL 

The grid perameters have been set up to City standards in the xin file. 

CREATE CROSS SECTION > DETAILS > 

> TITLE 

Type in a descriptive title for the cross sections, this will be displayed on the top of 

each cross section, generally it would include the project file name and date along with 

direction indicators. There are a limited number of characters available here for the title, 

however, if you put a place marker here it can be changed to something lengthier and 

more descriptive using the Find/Replace function in Microstation. 

For example, type in “Collector 24AUG13” and then replace it with “< < NORTH     

Collector St – 13-3251-213 -- 24AUG13     SOUTH > >” 

> LEGEND 

We don’t often use a legend, however, there may be occasions where one is 

required for special presentations or displays for councillors or the public sector. 

> SYMBOL AND DETAILS 

Not currently utilized. 

GENERATE THE CROSS SECTIONS 

Back under > Create Cross Section > General, make sure all the surfaces required in 

the cross sections have been identified and save the preferences before generating the 

sections. 

Preferences 

Save 

Close The changes will be saved to the loaded preference file i.e. “COLLECTOR.xin” 

 

Select APPLY and identify the 

location for the sections to be 

generated. As with the profile 

generation, the sections will 

be displayed relative to the 

top view so ensure that there 

is adequate clear space for 

the sections to be displayed.  



City of Brampton - Capital Works Contract Design Procedures – January 2017 

Pat Z. 
157 

27. CROSS SECTION ANNOTATION – INROADS | EVALUATION 

ANNOTATE CROSS SECTION > GENERAL 

Select the proposed surface to be annotated. Any features that have a point, or 

symbol, placed in the cross section can be annotated. 

If other points are required for a particular project, this can be accomplished in a 

couple of ways. For random additions, i.e. only a few points or sections involved, you can 

copy a point from another feature in the same section. It will then be annotated along 

with the others. 

To annotate an additional feature, or features, the feature style(s) can be modified 

to include annotation on the cross section. 

For our purposes, the edge of pavement, lanes, centerline and ditch lines will be 

included in the labeling and are set up in the preference file. 
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ANNOTATE CROSS SECTION > POINTS > 

> GENERAL 

Identify “Center” to be annotated, the prefix is set to display as “C/L” with a 

precision of three decimal places.  

 

 

 

 

 

 

 

The text symbology has been setup for 

level, colour, font etc. 

 

 

 

 

 

 

 

ANNOTATE CROSS SECTION > SEGMENTS > 

> GENERAL  /  > ANNOTATE 

As a general rule, segments are not annotated; labeling all segments creates a very 

cluttered cross section and makes reading any of the information difficult. Only those 

slopes that are non-standard, i.e. not 2% or 3:1, are labeled manually.  
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ANNOTATE CROSS SECTION > FEATURES > 

> GENERAL 

Similar to the Points annotation, the process is to identify the specific features to be 

annotated. 

> ANNOTATE 

Identify which features are to be annotated. A list of potential targets is shown, if the 

feature you wish to annotate is greyed out, it is not eligible for annotation. 

 

If an ineligable feature is needed for the specific project, the feature style will need 

to be modified to display annotation in the cross sections and the symbology parameters 

must be completed for the Cross Sections. 

See EDITING FEATURE STYLES (SECTION 28) 

ANNOTATE CROSS SECTION > FRAME > 

> GENERAL  /  > DETAILS  /  > COLLISION FREE  /  > POINTS  /  > SEGMENTS  /  > 

FEATURES  /  > SYMBOLOGY 

Since the text will be placed on the feature, no frames are required. 

The resulting annotation on the cross section will look like this…
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1) UPDATE CROSS SECTIONS 

The dialogs that follow are dynamic; they provide options and information relative 

to the selections made. 

Components and features associated with the selected surface will be shown, 

along with any available options. 

UPDATE CROSS SECTION > GENERAL 

Specify a station range to update if required, the default is for the entire group to be 

updated. The Start and Stop Stations will be displayed in each dialog that follows. 

The Mode: will be present in each dialog as well to allow you to… 

 Refresh -- a currently displayed surface/component/feature 

 Display On -- a surface/component/feature that is not currently displayed in the 

sections 

 Display Off -- a surface/component/feature that is currently displayed in the 

sections 

UPDATE CROSS SECTION > SURFACES 

A surface must be identified here prior to making component selections in the next 

dialog box. 

The next dialog is 

specific to the surface 

chosen. i.e. components 

of the selected surface 

are listed. 
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UPDATE CROSS SECTION > COMPONENTS 

The components in the surface “PROPOSED” are shown here, as it was selected in 

the previous dialog. The name(s) of any surface containing components will be displayed 

above the component list. 

 

By going back and selecting a different surface in the previous dialog, you can see 

that the components displayed will change. Since only the proposed surface has 

components, there are none to list for any of the other surfaces. 
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UPDATE CROSS SECTION > CROSSING FEATURES AND > PROJECTED FEATURES 

Identify the surface and then the crossing/projected features from the list 

displayed. Again, if it is greyed out it is not eligible for selection. By changing the Mode 

selected, the features listed will be modified to show eligible selections. 

Refresh will only allow selection of features that are already displayed; all others will 

be greyed out. 

Display On allows selection of features not yet displayed in the sections. 

Display Off will only allow selection of features already displayed. 

If a feature is greyed out in all modes, and if it is required to be displayed, it must be 

modified in the feature style. 

See EDITING FEATURE STYLES (SECTION 28) 

UPDATE CROSS SECTION > STORM & SANITARY 

Not currently utilized. 

FINAL NOTES – UPDATING CROSS SECTIONS  

Check each cross section for accuracy and functionality 

Modify the driveway sections or any ditch lines 

Add the center median as needed 

Elements in the cross sections may be adjusted to more accurately reflect the 

actual or desired conditions. 

 

As with the surface feature modifications, refreshing or re-displaying the surfaces on 

the cross sections will remove any changes made to them on the cross section and 

display the updated/current dtm surface.  If the surface has been modified (i.e. modifying 

features on the surface, triangulating and saving), refreshing it will update the cross 

section display of that surface. 

 

If extra points are required for annotation, they can be copied within each cross 

section to locations where the elevations are required. Subsequent annotations will place 

the elevation at the added point(s) along with the previously existing points. As a for 

instance, there may be times when elevations are required along the property line for 

developments to match the project design, a point can be copied from the e/p to the 

surface line at the property limits. The annotation is all on one level so there is not conflict 

with levels when copying these points. 
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If a component does not generate properly, which can happen at corridor 

clipping zones, it can be modified by inserting vertices to complete it. If done prior to 

calculating volumes, the modified component will be used in the End Area calculations. 

 

See END-AREA VOLUMES (SECTION 29) 

The proposed surface shown on the sections is set up in the preferences to be 

displayed by “features only” and that eliminates all the intermediate vertices that would 

be placed anywhere surface triangulation occurs. If there seem to be a lot of extra points, 

or the surface goes beyond the grading limit, ensure the surface properties are set 

correctly… 

See CHECK SURFACE PROPERTIES (SECTION 17.2) 

The values displayed will be based on the modified location of the surface, and 

sub-surface, lines in each cross section and will include any additional inserted vertices 

placed during modification. 

The modified cross section linework, however, will be utilized by Inroads to 

calculate the end area volumes. Adjustments made to match existing ground or correct 

incomplete components will be reflected in the calculated volumes and annotation. 
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28. EDITING FEATURE STYLES 

Nominally, since there are components displayed in the cross sections, for sidewalks 

and killstrips, they are not displayed as features. If you need to annotate or display them, 

the feature style must be modified. 

Edit Style… 

Will bring up the dialog where, under > Settings, 

 Crossing Points and/or 

 Annotation is selected. This will allow selection of these features in the dialogs. 

 

Under > Symbology, the Symbology Name is identified and can be edited. Selecting 

Edit… brings up the Point Symbology dialog which outlines the 

level/style/colour/symbol/cell and angle. These can be added, if necessary. If no 

symbology is named, one can be selected from the drop down, or a New… one can be 

added if necessary.
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29. END-AREA VOLUMES 

Volumes can be calculated by InRoads once sections have been completed and 

modified as necessary.  Adjustments are required in areas where surfaces do not meet, 

driveways where the curb needs to be depressed and driveway slopes need to be 

adjusted or any other specialized / problem area that requires individual manipulation. 

Make these adjustments prior to calculating your end area volumes and the changes will 

be included in the calculations. 

City of Brampton End area calculations are very basic and as such we will only be 

dealing with two of the headers under End Are Volumes. (General & Annotation) 

END-AREA VOLUMES > GENERAL 

In this area, select the two surfaces to compare in the calculations. This will be 

done twice, once for granular volumes, using PROPOSED & EXISTING surfaces, a second 

time for limestone volumes, using LIMESTONE & EXISTING surfaces. 

One surface must always be a design surface (one generated by InRoads), the 

other will be the existing surface. 

Select 

 Create XML Report 

and the Method 

 Correct for Curvature 

 

 

  



City of Brampton - Capital Works Contract Design Procedures - January 2017 

  Pat Z. 

166 

END-AREA VOLUMES > ANNOTATION 

The styles have been set up in the preference file and this information will display 

each time the volumes are generated (by selecting Apply), replacing the previous 

information. 

 

Each time Apply is selected volumes are generated and a report chart will be 

displayed with the information and totals. 

 

This chart provides the basic information that will be utilized for calculating the 

volumes, adjustments will need to be made for some areas. 

Print/save the appropriate form to a PDF for later use. 

With the alternate surface LIMESTONE, you can re-run the volumes to get the 

second calculations required, save this to a PDF for later use as well. 

Remember, each time you Apply to get values, previous information is removed. 
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CUT AND FILL SPREADSHEETS 

When doing a totally manual measure and calculate using the cross sections, it 

can be done either of two ways. 

Use the half scale version of the cut/fill spreadsheet, CUTFILL-HALFSCALE.xlsx, it 

includes two extra columns, which are to be hidden during printing. Input the measured 

areas from the cross sections in the hidden columns and they will be adjusted 

automatically for the printed portion. 

Using CUTFILL.xlsx, this adjustment is not made, remember the areas you measure 

on the cross sections will be twice the actual area due to the vertical exaggeration and 

will need to be adjusted before you put them in the spreadsheet. 

To make adjustments to the quantities, copy the file “CUTFILL.xlsx” or “CUTFILL-

HALFSCALE.xlsx” from the directory ...\Engineering Standard Setups\DESIGN 

SPREADSHEETS.  

With the spreadsheet and the EndAreaVolume printout, populate the spreadsheet 

using the printout and adjust as required. The initial calculation is for earthworks based on 

Granular backfill. If you have not done a second calculation using the LIMESTONE surface, 

you will need to adjust for Limestone by increasing the fill and decreasing the cut. 

Provide two earthworks spreadsheets, one Limestone, one Granular. When the 

adjustments/corrections to the Granular Spreadsheets have been made, copy the tabs to 

a Limestone version and make the necessary adjustments for the difference between 

Limestone and Granular quantities. 

Calculations will be made to include the component areas and ignore any 

stripping, as demonstrated below. 

Where F represents Fill, C = Cut, AF and AC represent the adjustment quantities for 

limestone vs. granular.  

  

F 
C 

A

F 
A

C 
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30. PLOTTING CONTRACT DRAWINGS 

1) USING IPLOT 

The contract drawings you will be plotting will consist of Plan & Profiles, Removals, 

Dimensions, Typicals and Details, Pavement Elevations as well as the Title Page and 

Drawings List. Since these will need to be plotted numerous times, 30% / 60% / 90% / 100% / 

tender / construction, as well as for intermittent checks and reviews, it is advantageous to 

set up an “ips” file using ProjectWise InterPlot Organizer.  

To begin, make sure you have the directory “PRINT FILES” in which to store the “i” 

files and the plot file (ips).  

It will eventually look very similar to the list shown here.  

Open each Contract 

drawing file, in turn, set up 

the drawing for plotting by 

turning the levels on or off as 

needed, turn on the 

overrides in the plan & 

profile drawings. 

Set up one view as it 

will be plotted and save the 

settings. This allows other 

users of the drawing, 

consultants perhaps, to see 

what is to be plotted when 

they open the file. 

Everything has been set up in the Seed-3D file to force the colours, for existing 

information, to dark grey for plotting using the level overrides.  

There have been a number of filters set up to help weed out the levels needed for 

each drawing. Begin by turning all levels off, then filtering for the various components to 

turn on the needed levels for each type of drawing. 

Once you have turned on/off the appropriate levels, save the settings (Ctrl S); 

fence the drawing by using tentative selection and picking the corner points outside the 

frame. The bases have been set up to allow plotting at full scale and at true half scale by 

using alternate corners. In View Attributes, turn on the Overrides. For the full size plots, 

leave the weights on and use the lower left and upper right points. For the half size plots, 

turn off the weights, in the View Attributes, and use the upper left and lower right points.  

>> File > IPLOT… 

Ctrl +F will bring up the dialog with 

plotting file options. The colour table 

attached to the seed file is 256PLOT.CTB, if 

this has been changed; make sure you 

select it as the one to use. It can be found 

in ...\Engineering Standard Setups\ 
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No Design Script or Pen Table is required. Close  this dialog box now. 

In the IPLOT main dialog window, select the 

 Printer: “HP800 or HP1100 or HP2300” 

 Plot Area: will be Fence 

 Units: = m 

 Scale: = 500:1 

 Rotation: is either 90 or 270 degrees for plotting directly 

You can leave the rotation at zero (0) to create the “i” files, this way the pdf 

generated using the ips file will have the sheets in a landscape position. 

 

 

 

 

 

 

 

 

 

In the IPLOT dialog window… 

>> File > Save As… 

…to save the IPARM file in the Print Files directory. This “i” file will contain the setup 

provided in the IPLOT dialog and provides a means to print these drawings at any time, to 

paper or PDF, without opening the drawing file and setting everything up again. 

When saving these ‘i’ files add the prefix‘FULL’ to the name, so this one would be 

called FULL-00-C1-8-20-TITLEPAGE.i  

Your drawing files will then be set up with the Sheet # in front of the Drawing # this 

makes it easier to order the files in the ips file for plotting in the proper sequence. 

For half size (1:1000 scale) on 11” x 17” paper there have been alternate points 

made for fence placement turn level weights off for the half scale, and use the points 

identified by the double arrows to create your ‘i’ file. These would be called HALF-00-C1-8-

20-TITLEPAGE.i… 

By putting the FULL / HALF designation in front of the drawing number, rather than 

at the end, the two groups will be sorted for you and easier to select as a group. 
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SETTING UP THE ORGANIZER 

When you have saved all the IPARM files to the PRINT FILES directory… 

Go to start… 

 

>>All Programs > Bentley > ProjectWise InterPlot Utilities > ProjectWise InterPlot Organizer 

 

   OK.  

Add 

Highlight the 

“i” files to be plotted 

and select Open 

The window will revert 

back to the Create Plots window 

with the list included under the 

Input files. 

Select OK and you will 

have the list in the Organizer, 

correct the sequence of 

drawings, if necessary. 

>> File > Save …assign a name - 

COLLECTOR.ips, you can add HALF/FULL to the name to reflect the scale that the ‘i’ files 

were generated for. 
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From this point you, or anyone else, can create a PDF file with any or all of the 

drawings and print that PDF to a large format plotter on 24” x 36” paper or to a 

printer/copier on 11”X17” size in just moments, or share the PDF with those who can not 

open Microstation files. Once the file is saved, you can activate the organizer by double 

clicking on the ips file. 

In the 

early stages 

you may be 

able to use one 

.ips file since 

you will have a 

limited number 

of drawings, 

however, at 

some point you 

may need to 

separate the 

full and half size 

drawings. 

Creating two separate .ips files will reduce the size of the files and the time it takes 

to open one for printing. It also allows you to ‘select all’ to choose the set when plotting. 

OOPS, SOMETHING’S WRONG WITH THE SCALE... 

If you find that the lineweights seem very heavy and scales have been changed to 

something other than what was set up in iplot, check the print setup and make sure that 

the printer identified there is one of the large format plotters. 

 

>> File > PRINT SETUP  

Change the Printer name to the HP800IP 

(or HP2300, or HP1100).  
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WHY DOES THIS HAPPEN? 

The default page size for the previous printer used may be letter size; the scale of 

the plot drawing is automatically changed to fit that size paper when the “i” file is 

imported or if the Print Setup is changed. The plots and “pdf” files will appear to have 

much heavier lineweights if plotted from this plot file. After changing the printer to one of 

the larger format plotters, newly imported plot files will be at the scale set in iplot, 

previously imported files will need to be adjusted. 

CORRECT THE SCALE ON PLOT FILES ALREADY IMPORTED 

To change individual plot files, double click on the Plot Name to bring up the 

information dialog box. Change the scale in the dialog box to the correct size for the plot 

and select OK. 

If there have been a lot of drawings imported before realizing there was a problem, 

you can delete the plot names and re-import the list once the print setup is corrected. This 

works if you have a variety of scales to be adjusted. 

Select the Create Plots icon and follow the procedure, as outlined previously, to re-

import your plot files. 

If all the files should have the same scale… 

Highlight all the plot names. 

Right click and Select Properties 

Change the scale in the dialog box and Select OK 
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2) USING PRINT (PRINT/PLOT) 

For those without iPlot, the approved “look” can be duplicated using the 

BRAMPTON.pltcfg file provided. This file, when used in conjunction with printplot, will 

produce drawings of City standard quality in both full and half sizes. Begin by setting up 

the drawing as you would for plotting using iPlot. i.e. levels/weights/overrides… 

Remember to turn off the weights before creating the half size plans.  

 

1- Identify Fence Area 

3- Select Printer / 

PDF program 

4- Select Config File 

No Pen Table or 

Script Required 

2- Select Print 
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31. FINAL CHECKLIST – COMPLETING THE PACKAGE 

1) BASIC INSTRUCTIONS 

 Label Dimension plans and Vertical Alignment (profile) 

 Create Storm Drainage Plan(s)(area-3-page) AND Storm Drainage Calculations 

 Propose Storm MH and CB locations and connections on plan as necessary and 

complete storm drainage calculation sheets 

 Add Storm information to Profile with dimensions, OPSD reference, pipe length, 

size and strength. 

 Tone or shade appropriate proposed works (plan & profile) 

 Plot Plan and Profile drawings 

 Send out 30%, 60% and 90%. Final PUCC submitted at 90% review 

 Incorporate information received 

 Calculate Quantities--Cut/Fill, Asphalt removal & Placement, sidewalks, storm… 

2) CONTRACT DRAWINGS TO BE CREATED AS REQUIRED 

 Title Pages – City Map on cover, drawings listed on second sheet (area-8-sheet) 

 Application plans (Gas, Railway, Conservation…as required) 

 Plan & Prof. Sheets 1:250 or 1:500 (area-street#-page) 

 Removals (area-8-page) 

 Dimensions (area-8-page) 

 Typical X-Sections and Details (area-8-page) 

 Pavement Elevation Details 1:250 scale(area-8-page) 

 Pavement Markings (in house…drawings set up by primary designer (area-8-

page), design to be completed by Traffic Section) 

 Traffic Signals 1:250 scale (design & drawings to be done and numbered by 

Traffic section) 

 Street Lighting (design & drawings to be done and numbered by Street Lighting 

section) 

 Cross Sections 1:200 scale Horizontally, vertical exaggeration of 2 [individually on 

legal or tabloid size pages] 

 Tree Inventory (to be done by landscape consultant) 

 Landscape drawings (to be done by consultant) 

 Structures drawings (to be done by consultant) 

 Traffic Control Plan(s) (to be done by contractor) 

3) APPLICATIONS / MEETINGS 

 Applications to MOE, TRCA, CVCA, GAS, and RAIL Authorities--drawings as 

required 

 Meetings to be set up with Utilities, Conservation Authorities … 

4) MOE DRAWINGS 

 3 copies of each of the following… 

 Drainage plan (Full Size) 

 Storm Calculations 

 Applicable Plan & Profile Sheets (Full Size)  
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5) RAILWAY DRAWINGS 

PLAN VIEW OF CROSSING – 1:2000 

 Location of tracks and R.O.W. of railway – 400m in each direction 

 Location of traveled portion of roadway – 100m in each direction 

 Location of R.O.W. of roadway – 100m in each direction 

 Width of railway R.O.W. 

 Width of roadway R.O.W. 

 Width of traveled portion of roadway 

 Width of roadway shoulders 

 Angle of crossing 

 Location of all railway crossing signs and warning devices 

 Sight lines and all obstructions to view within 400m 

 Drainage and utilities relating to crossing 

PROFILE OF RAILWAY – 1:5000H, 1:250V – 100M IN EACH DIRECTION 

 Elevation of the top of the lowest rail 

 Elevation of original ground at center line of track 

 PROFILE of roadway – 1:200H, 1:200V – 100m in each direction 

 Elevation of roadway surface 

 Gradients 

 Elevation of original ground surface 

TYPICAL CROSS SECTION – 1:200 

 Traveled portion of roadway 

 Shoulders 

 Drainage 

 Utilities and other information relevant to construction of crossing 

 Obstacles to construction…trees, buildings, retaining walls… 

6) GAS DRAWINGS 

LOCATION PLAN VIEW – 1:500 OR LARGER 

 Reference measurements to nearest road intersection, lot line, etc. 

 Width of Easement, location of pipeline and pipeline markers within easement 

 Curbs, guard rails, guy wires, poles fences 

 Lot lines, Road Limits 

PROFILE VIEW 

 Only required where encroachment parallel to facilities for a definable distance 

 Requirements the same as Section View 
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SECTION VIEW – 1:200H, 1:100V OR LARGER 

 Depth and location, diameter and material of all pipelines and casings 

 Location and clearance from pipelines of roads, rail lines, rivers, ditches… 

 Location of other buried appurtenances 

 Proposed depth/location of new facility with details regarding material, sizing 

slope (if sewer), pressure voltage drainage etc. as applicable 

32. TYPICAL LIST OF FILES 

...that would appear in the contract directory, for the example project, would 

include, but not be limited to… 

1) INROADS FILES… 

Collector.xin [preferences] 

Collector.itl [template library] 

Collector.rwk [roadworks – loads all applicable files when opened] 

Collector.alg [alignment geometry] 

Collector.ird [roadway library] 

Collector-base.dtm [surveyed surface] 

UTILITIES.dtm [surface for ROW & utilities to be displayed in cross sections] 

PROPOSED.dtm [surface] 

2) MICROSTATION FILES… 

**Collector-base.dgn 

**Collector-DESIGN.dgn 

**Collector-PROPERTY.dgn 

**Collector-PROFILE.dgn 

**Collector-PVMNT_SIGNS.dgn 

Collector-UTILITIES.dgn 

Collector-SECTIONS.dgn 

Collector-STORM.dgn 

Collector-STRIP.dgn 

Collector-SURFACE.dgn 

Collector-QUANTITIES.dgn 

Collector-WORKING.dgn 

01-B1-11-1.dgn 

02-C1-11-5.dgn TO 06-C1-11-1.dgn 

07-B2-12-12-ARTERIAL-A.dgn … 

15-C1-8-22_REMOVALS.dgn 

16-C1-8-23_REMOVALS.dgn 

17-C1-8-24_DIMENSIONS.dgn 

18-C1-8-25_DIMENSIONS.dgn 

19-C1-8-26_PVMNT_SIGNS.dgn 

20-C1-8-27_PVMNT_SIGNS.dgn 

21-C1-8-32_ELEV-ARTERIAL-A.dgn 

22-C1-8-33_ELEV-LITTLE-THRU.dgn 

23-C1-8-33_ELEV-SAMPLE-LOCAL.dgn 

**Drawings to be referenced to numbered drawings 

Anyone required to access the contract is able to determine, with no trouble, what 

each file contains and where the current files are. 
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3) FINAL NOTES 

 

There will not be a prompt for a name each time a file is saved, only the first time. 

 

For each process…>>Save when satisfied 

Create a surface…>>file >> save  >>surface…follow the prompts 

Create a geometry/alignment…>>file  >>save  >>geometry…follow the prompts 

Import surface features…>>file  >>save  >>surface 

Triangulate a surface…>>file  >>save  >>surface 

Modify an alignment…>>file  >>save  >>geometry  

Keep the names consistent…”Streetname***”.  In Inroads, each is a different type 

of file, they can all be given the same name; different extensions will be assigned by 

InRoads 

The exceptions are surfaces and alignments, which have their own naming 

structure. 

If you find that you are not being permitted to -Select a command on the MAIN 

MENU check to ensure THE LAST DIALOG BOX YOU HAD OPEN has been CLOSED. 

 For some operations, Inroads will not permit selection of an action on the Main 

Menu until it is the only box open. 
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33. APPENDICES 

1) APPENDIX 1 – LEVELS & SYMBOLOGY 

I. GENERAL LINEWORK AND TEXT LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

Default Default 0 0 0 0   0 

GENERAL LINEWORK and TEXT LEVELS 

ENG_BORDER OUTSIDE BORDER OF SHEETS 0 0 15 0   20 

ENG_DETAILS DETAIL DRAWINGS I.E. SANDBAG DAMS, CHECK DAMS, ISLAND DETAILS… 0 0 2 0   5 

ENG_DIMENSIONS DIMENSIONS TAPERS DETAILS etc 0 0 6 0   6 

ENG_GRID INTERIOR SECTIONS GRID & PROFILE GRID 0 1 0 0   1 

ENG_GRIDBORDER LEFT, RIGHT AND BOTTOM GRID LINES FOR SECTIONS AND PROFILE 0 0 3 0   5 

ENG_KEY KEY PLAN 0 0 0 0   2 

ENG_LEGEND LEGEND AND NOTES BORDER, LINEWORK - PLAN 0 0 5 0   20 

ENG_LIMITS LIMIT OF CONTRACT LINEWORK 0 0 20       

ENG_LOGO LOGO 0 0 0 0   1 

ENG_MATCH MATCH LINE 0 5 2 0     

ENG_REMOVALS REMOVALS X-OUT TREES ETC - PLAN 0 0 0 0   0 

ENG_REMOVALS-AREA HARD SURFACE REMOVALS-SIDEWALK, ASPHALT... 235 0 0 233   0 

ENG_REMOVALS-LINEAR REMOVALS - FENCING, CSPs ETC - PLAN 0 REMOVE 0 0   0 

ENG_REMOVALS-RELOCATE RELOCATION - ENCIRCLE ABOVE GROUND STRUCTURES - PLAN 0 2 2 0   5 

ENG_REVISIONS CLOUD FOR REVISION LOCATION 4 0 5       

ENG_TITLEBLOCK TITLEBLOCK LINEWORK, NORTH ARROW 0 0 1 0   10 

ENG_ISSUED_30 PERCENT TEXT FOR 30 PERCENT SUBMISSION 0 0 0 0   0 

ENG_ISSUED_60 PERCENT TEXT FOR 60 PERCENT SUBMISSION 0 0 0 0   0 

ENG_ISSUED_90 PERCENT TEXT FOR 90 PERCENT SUBMISSION 0 0 0 0   0 

ENG_ISSUED_100 PERCENT TEXT FOR 100 PERCENT SUBMISSION 0 0 0 0   0 

ENG_ISSUED_TENDER TEXT FOR ISSUED FOR TENDER 0 0 0 0   0 

ENG_ISSUED_CONSTRUCTION TEXT FOR ISSUED FOR CONSTRUCTION 0 0 0 0   0 

ENG_TX_BORDER DRAWING & SHEET NO. 0 0 0 0     

ENG_TX_DETAILS DIMENSIONS AND TEXT IN DETAIL DRAWINGS 0 0 0 0     

ENG_TX_DIMENSIONS NOTES AND LABELS 0 0 6 0   6 

ENG_TX_GRID LABELS, ELEVATIONS, TITLE AND OFFSETS FOR SECTIONS AND PROFILE 0 0 0 0   0 

ENG_TX_KEY TEXT IN KEY PLAN - PLAN 0 0 0 0   0 

ENG_TX_LEGEND LEGEND AND NOTES TEXT 0 0 0 0   0 

ENG_TX_LIMITS LIMIT OF CONTRACT 0 0 0 0   0 

ENG_TX_LOGO LOGO TEXT 0 0 0 0   0 

ENG_TX_MATCH MATCH LINE TEXT 0 0 0 0   0 

ENG_TX_REMOVALS NOTES AND LABELS 0 0 0 0   0 

ENG_TX_REMOVALS-LINEAR NOTES AND LABELS 0 0 0 0   0 

ENG_TX_REMOVALS-RELOCATE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_REVISIONS TEXT AND SHAPE FOR REV NUMBERS 4 0 4       

ENG_TX_TITLEBLOCK STREET NAME & DESCRIPTION, PROJECT NO., SCALE, DATES & NAMES 0 0 0 0   0 

ENG_TX_TITLE-DESC DRAWING DESCRIPTION ie "PROPOSED RECONSTRUCTION", "DETAILS" 0 0 0 0   0 

ENG_TX_TITLE-REV REVISION AND ""ISSUED FOR.."" NOTES 0 0 0 0     
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I I. WORKING & CALCULATION LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

WORKING & CALCULATION LEVELS 

-PRINT FULLSIZE Print border for Full Size (24x36) [NON PRINTING] 6 1 5       

-PRINT HALFSIZE Print border for Half Size (11x17) [NON PRINTING] 4 1 5       

-SCRAP Respository for Ghost/Residual Elements [NON PRINTING] 0 0 0 0   0 

ENG_WK_BREAKLINES BREAKLINES IMPORTED FOR SURFACE WORK 115 0 3       

ENG_WK_GROUND GROUND SHOTS IMPORTED FOR SURFACE WORK 55 0 1       

ENG_WK_MISC-1 MISCELLANEOUS WORKING LEVEL 0 0 1       

ENG_WK_MISC-2 MISCELLANEOUS WORKING LEVEL 1 0 2       

ENG_WK_MISC-3 MISCELLANEOUS WORKING LEVEL 2 0 3       

ENG_WK_MISC-4 MISCELLANEOUS WORKING LEVEL 3 0 4       

ENG_WK_MISC-5 MISCELLANEOUS WORKING LEVEL 4 0 5       

ENG_WK_MISC-6 MISCELLANEOUS WORKING LEVEL 5 0 6       

ENG_WK_MISC-7 MISCELLANEOUS WORKING LEVEL 6 0 7       

ENG_WK_MISC-8 MISCELLANEOUS WORKING LEVEL 87 0 8       

ENG_WK_MISC-9 MISCELLANEOUS WORKING LEVEL 88 0 9       

ENG_WK_MISC-10 MISCELLANEOUS WORKING LEVEL 89 0 10       

MISC WORKING & CALCULATION LEVEL 0 0 0       

I I I. PROPERTY LINEWORK AND LABELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

PROPERTY LINEWORK and LABELS 

ROW_DEV_LOTLINES DEVELOPER LOTLINES 80 3 5 0     

ROW_DEV_ROW DEVELOPER ROW 80 3 15 0     

ROW_ENG_GUYING_EASEMENT PROPOSED PERMANENT HYDRO GUYING EASEMENT 68 2 2 0   20 

ROW_ENG_HYDRO_EASEMENT PROPOSED PERMANENT EASEMENT LINEWORK ie HYDRO 68 2 10 0   20 

ROW_ENG_LOTLINES PROPOSED PROPERTY LINEWORK ie LOT LINES 80 0 5 0   10 

ROW_ENG_PERM_EASEMENT 
PROPOSED PERMANENT EASEMENT LINEWORK ie STRUCTURES, 

DRAINAGE 
123 2 10 0   20 

ROW_ENG_ROW PROPOSED RIGHT OF WAY 80 2 15 0   20 

ROW_ENG_TEMP_EASEMENT PROPOSED TEMPORARY EASEMENT LINEWORK ie GRADING 230 2 10 0   20 

ROW_ENG_TX_GUYING_EASEMENT IDENTIFICATION OF TYPE OF EASEMENT ie HYDRO GUYING 68 0 0 0     

ROW_ENG_TX_HYDRO_EASEMENT IDENTIFICATION OF TYPE OF EASEMENT ie HYDRO AERIAL 68 0 0 0     

ROW_ENG_TX_PERM_EASEMENT IDENTIFICATION OF TYPE OF EASEMENT ie STRUCTURES, DRAINAGE 123 0 0 0     

ROW_ENG_TX_PROPERTY NOTES AND LABELS 0 0 0 0     

ROW_ENG_TX_ROW PROPOSED RIGHT OF WAY 0 0 0 0     

ROW_ENG_TX_TEMP_EASEMENT IDENTIFICATION OF TYPE OF EASEMENT ie GRADING 212 0 0 0     

ROW_EXROW EXISTING STREETLINES - RIGHT OF WAY (TERANET LEVEL 1) 80 0 20 0     

ROW_LOTLINES EXISTING PROPERTY LOT LINES (TERANET LEVEL 1) 80 0 5 0     

ROW_REFPLANS REFERENCE PLANS (TERANET LEVEL 7) 4 2 0 0   0 

ROW_REGPLANS REGISTERED PLANS (TERANET LEVEL5) 5 3 0 0   0 

ROW_TX_OWNERS OWNER INFORMATION 0 0 0 0     

ROW_TX_PIN 9 DIGIT P.I.N. (TERANET LEVEL 17) , TXT=1.5 6 0 0 0     

ROW_TX_REFPLANS REFERENCE PLANS (TERANET LEVEL 8) 4 0 0 0   0 

ROW_TX_REGPLANS REGISTERED PLANS (TERANET LEVEL 6) 5 0 0 0   0 

ROW_TX_STNAMES EXISTING STREET NAME 80 0 0 0     
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IV. SURVEYED INFORMATION LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

SURVEYED INFORMATION LEVELS 

SVY_APRON CONC APRON 2 0 0 236   0 

SVY_BARRIER BARRIER (JERSEY / ARMOURSTONE) 100 0 0 236   0 

SVY_BELL BELL 70 0 0 236   0 

SVY_BENCH BENCH (PARK / BUS) 253 0 0 236   0 

SVY_BLANK BLANK (MISC SINGLE FEATURE) 0 0 0 236   0 

SVY_BOREHOLE BOREHOLE DATA 0 0 0 236   0 

SVY_BOULDER BOULDER - LARGE DECORATIVE 140 0 0 236   0 

SVY_BREAKLINES BREAKLINES 99 2 0 236   0 

SVY_BUILDING BUILDING 253 0 0 236   0 

SVY_CB CATCHBASIN AT GUTTERLINE 112 0 0 236   0 

SVY_CROSS_SEG CROSSING SEGMENTS 3 0 0 236   0 

SVY_CROWN-RD CROWN OF ROADWAY 4 0 0 236   0 

SVY_CSP CSP, PVC OR CONC PIPE 4 3 3 236   3 

SVY_CURB FACE of CURB 4 0 0 236   0 

SVY_CURBSTOP CURBSTOP PARKING 4 2 0 236   0 

SVY_DITCH DITCH OR SWALE LINE 124 4 0 236   0 

SVY_DRIVEWAY DRIVEWAY 100 0 0 236   0 

SVY_EDGE-WATER EDGE OF WATER (POND / RIVER) 124 0 0 236   0 

SVY_EPAVT EDGE OF PAVEMENT 115 0 0 236   0 

SVY_EXPANSION-JOINT BRIDGE EXPANSION JOINT 253 0 2 236   2 

SVY_FENCE FENCE 100 CLF 0 236   0 

SVY_FENCE-GATE FENCE GATE POST 100 0 0 236   0 

SVY_GABION GABION BASKET 66 0 0 236   0 

SVY_GARDEN GARDEN 245 0 1 236   1 

SVY_GAS GAS 70 0 0 236   0 

SVY_GROUND GROUND SHOTS 220 0 0 236   0 

SVY_GUIDERAIL GUIDE RAIL 115 7 0 236   0 

SVY_GUTT CURB GUTTER 4 0 0 236   0 

SVY_GUY_POLE GUY POLE 70 0 0 236   0 

SVY_GUY_WIRE GUY WIRE 70 0 0 236   0 

SVY_HEADWALL HEADWALL 253 0 0 236   0 

SVY_HYDRO HYDRO JUNCTION BOX 70 0 0 236   0 

SVY_KILLSTRIP KILLSTRIP 116 0 0 236   0 

SVY_LAYOUT-STAKE LAYOUT STAKE 43 0 0 236   0 

SVY_LEGAL LEGAL MONUMENTS 4 0 0 236   0 

SVY_LP LIGHT POLE 70 0 0 236   0 

SVY_MH MAN HOLE - STORM, SANITARY OR FDC 112 0 0 0   0 

SVY_MH_FDC MAN HOLE - FDC 112 0 0 236   0 

SVY_MH_SAN MAN HOLE - SANITARY 112 0 0 236   0 

SVY_MH_STM MAN HOLE - STORM 112 0 0 236   0 

SVY_NOISEWALL NOISEWALL - ANY MATERIAL 100 CLF 0 236   0 

SVY_OGCONT-MAJ CONTOURS OG MAJOR 4 0 3 236   3 

SVY_OGCONT-MIN CONTOURS OG MINOR 16 0 1 236   1 

SVY_OG-TIN ORIGINAL SURFACE TRIANGLES 1 0 0 236   0 

SVY_PCTRL PROJECT CONTROL 43 0 0 236   0 

SVY_PMK_LANE LANE MARKINGS 0 2 0 236   0 



City of Brampton - Capital Works Contract Design Procedures – January 2017 

Pat Z. 
181 

SURVEYED INFORMATION LEVELS 

SVY_PYCB CATCHBASIN - PYRAMID 112 0 0 236   0 

SVY_RAILROAD RAILROAD TRACKS OR WIGWAGS 253 0 0 236   0 

SVY_REFPT REFERENCE POINT 43 0 0 236   0 

SVY_RET-WALL RETAINING WALL 253 0 0 236   0 

SVY_RIPRAP RIPRAP 66 0 0 236   0 

SVY_SHELTER SHELTER, TELEPHONE BOOTH, OR SHED 253 0 0 236   0 

SVY_SHOULDER SHOULDER 4 0 0 236   0 

SVY_SIDEWALK CONC SIDEWALK 116 0 0 236   0 

SVY_SIGN SIGN 140 0 0 236   0 

SVY_SLOPE-B BOTTOM OF SLOPE 99 2 0 236   0 

SVY_SLOPE-T TOP OF SLOPE 98 0 0 236   0 

SVY_STRUCTURE-B BOTTOM OF STRUCTURE 253 1 0 236   0 

SVY_STRUCTURE-T TOP OF STRUCTURE 253 0 0 236   0 

SVY_SURFACE-PROF EXISTING SURFACE FOR PROFILE AND SECTIONS 4 3 3 236   5 

SVY_TRAFFIC TRAFFIC 70 0 0 236   0 

SVY_TV TV 70 0 0 236   0 

SVY_VEG VEGETATION 230 0 0 236   0 

SVY_WALKWAY EDGE OF WALKWAY 116 0 0 236   0 

SVY_WALL WALL - ENTRANCE FEATURE 100 0 0 236   0 

SVY_WATER WATER 111 0 0 236   0 

 

V. SURVEYED POINTS LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

SURVEYED POINTS LEVELS 

SVY_PT_APRON POINTS 2 0 0 236   0 

SVY_PT_BARRIER POINTS 100 0 0 236   0 

SVY_PT_BELL POINTS 70 0 0 236   0 

SVY_PT_BENCH POINTS 253 0 0 236   0 

SVY_PT_BLANK POINTS 0 0 0 236   0 

SVY_PT_BUILDING POINTS 253 0 0 236   0 

SVY_PT_CROWN-RD POINTS 4 0 0 236   0 

SVY_PT_CURB POINTS 4 0 0 236   0 

SVY_PT_CURBSTOP POINTS 4 2 0 236   0 

SVY_PT_DITCH POINTS 124 4 0 236   0 

SVY_PT_DRIVEWAY POINTS 100 0 0 236   0 

SVY_PT_EDGE-WATER POINTS 124 0 0 236   0 

SVY_PT_EPAVT POINTS 115 0 0 236   0 

SVY_PT_EXPANSION-JOINT POINTS 253 0 2 236   0 

SVY_PT_FENCE POINTS 100 0 0 236   0 

SVY_PT_FENCE-GATE POINTS 100 0 0 236   0 

SVY_PT_GABION POINTS 66 0 0 236   0 

SVY_PT_GARDEN POINTS 245 0 1 236   0 

SVY_PT_GAS POINTS 70 0 0 236   0 

SVY_PT_GUIDERAIL POINTS 115 7 0 236   0 

SVY_PT_GUTT POINTS 4 0 0 236   0 

SVY_PT_HEADWALL POINTS 253 0 0 236   0 

SVY_PT_HYDRO POINTS 70 0 0 236   0 
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SURVEYED POINTS LEVELS 

SVY_PT_KILLSTRIP POINTS 116 0 0 236   0 

SVY_PT_NOISEWALL POINTS 100 0 0 236   0 

SVY_PT_PMK_LANE POINTS 0 2 0 236   0 

SVY_PT_RAILROAD POINTS 253 0 0 236   0 

SVY_PT_RET-WALL POINTS 253 0 0 236   0 

SVY_PT_RIPRAP POINTS 66 0 0 236   0 

SVY_PT_SHELTER POINTS 253 0 0 236   0 

SVY_PT_SHOULDER POINTS 4 0 0 236   0 

SVY_PT_SIDEWALK POINTS 116 0 0 236   0 

SVY_PT_SIGN POINTS 140 0 0 236   0 

SVY_PT_SLOPE-B POINTS 99 2 0 236   0 

SVY_PT_SLOPE-T POINTS 98 0 0 236   0 

SVY_PT_STRUCTURE-B POINTS 253 1 0 236   0 

SVY_PT_STRUCTURE-T POINTS 253 0 0 236   0 

SVY_PT_SURFACE-PROF POINTS 0 0 0 236   0 

SVY_PT_TRAFFIC POINTS 70 0 0 236   0 

SVY_PT_TV POINTS 70 0 0 236   0 

SVY_PT_VEG POINTS 230 0 0 236   0 

SVY_PT_WALKWAY POINTS 116 0 0 236   0 

SVY_PT_WALL POINTS 100 0 0 236   0 

SVY_PT_WATER POINTS 111 0 0 236   0 

 

VI. SURVEY TEXT LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

SURVEY TEXT LEVELS 

SVY_TX_APRON NOTES AND LABELS 2 0 0 236   0 

SVY_TX_BARRIER NOTES AND LABELS 100 0 0 236   0 

SVY_TX_BELL NOTES AND LABELS 70 0 0 236   0 

SVY_TX_BENCH NOTES AND LABELS 253 0 0 236   0 

SVY_TX_BLANK NOTES AND LABELS 0 0 0 236   0 

SVY_TX_BOREHOLE NOTES AND LABELS 0 0 0 236   0 

SVY_TX_BOULDER NOTES AND LABELS 140 0 0 236   0 

SVY_TX_BREAKLINES NOTES AND LABELS 99 2 0 236   0 

SVY_TX_BUILDING NOTES AND LABELS 253 0 0 236   0 

SVY_TX_CB NOTES AND LABELS 112 0 0 236   0 

SVY_TX_CROWN-RD NOTES AND LABELS 4 0 0 236   0 

SVY_TX_CSP NOTES AND LABELS 4 3 3 236   0 

SVY_TX_CURB NOTES AND LABELS 4 0 0 236   0 

SVY_TX_CURBSTOP NOTES AND LABELS 4 2 0 236   0 

SVY_TX_DITCH NOTES AND LABELS 124 4 0 236   0 

SVY_TX_DRIVEWAY NOTES AND LABELS 100 0 0 236   0 

SVY_TX_EDGE-WATER NOTES AND LABELS 124 0 0 236   0 

SVY_TX_EPAVT NOTES AND LABELS 115 0 0 236   0 

SVY_TX_EXPANSION-JOINT NOTES AND LABELS 253 0 2 236   0 

SVY_TX_FENCE NOTES AND LABELS 100 0 0 236   0 

SVY_TX_FENCE-GATE NOTES AND LABELS 100 0 0 236   0 

SVY_TX_GABION NOTES AND LABELS 66 0 0 236   0 
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SURVEY TEXT LEVELS 

SVY_TX_GARDEN NOTES AND LABELS 245 0 1 236   0 

SVY_TX_GAS NOTES AND LABELS 70 0 0 236   0 

SVY_TX_GROUND NOTES AND LABELS 220 0 0 236   0 

SVY_TX_GUIDERAIL NOTES AND LABELS 115 7 0 236   0 

SVY_TX_GUTT NOTES AND LABELS 4 0 0 236   0 

SVY_TX_GUY_POLE NOTES AND LABELS 70 0 0 236   0 

SVY_TX_GUY_WIRE NOTES AND LABELS 70 0 0 236   0 

SVY_TX_HEADWALL NOTES AND LABELS 253 0 0 236   0 

SVY_TX_HYDRO NOTES AND LABELS 70 0 0 236   0 

SVY_TX_KILLSTRIP NOTES AND LABELS 116 0 0 236   0 

SVY_TX_LAYOUT-STAKE NOTES AND LABELS 43 0 0 236   0 

SVY_TX_LEGAL NOTES AND LABELS 4 0 0 236   0 

SVY_TX_LP NOTES AND LABELS 70 0 0 236   0 

SVY_TX_MH_FDC NOTES AND LABELS 112 0 0 236   0 

SVY_TX_MH_SAN NOTES AND LABELS 112 0 0 236   0 

SVY_TX_MH_STM NOTES AND LABELS 112 0 0 236   0 

SVY_TX_NOISEWALL NOTES AND LABELS 100 0 0 236   0 

SVY_TX_OGCONT-MAJ NOTES AND LABELS 4 0 3 236   0 

SVY_TX_OGCONT-MIN NOTES AND LABELS 16 0 1 236   0 

SVY_TX_OG-TIN NOTES AND LABELS 1 0 0 236   0 

SVY_TX_PCTRL NOTES AND LABELS 43 0 0 236   0 

SVY_TX_PMK_LANE NOTES AND LABELS 0 2 0 236   0 

SVY_TX_PYCB NOTES AND LABELS 112 0 0 236   0 

SVY_TX_RAILROAD NOTES AND LABELS 253 0 0 236   0 

SVY_TX_REFPT NOTES AND LABELS 43 0 0 236   0 

SVY_TX_RET-WALL NOTES AND LABELS 253 0 0 236   0 

SVY_TX_RIPRAP NOTES AND LABELS 66 0 0 236   0 

SVY_TX_SHELTER NOTES AND LABELS 253 0 0 236   0 

SVY_TX_SHOULDER NOTES AND LABELS 4 0 0 236   0 

SVY_TX_SIDEWALK NOTES AND LABELS 116 0 0 236   0 

SVY_TX_SIGN NOTES AND LABELS 140 0 0 236   0 

SVY_TX_SLOPE-B NOTES AND LABELS 99 2 0 236   0 

SVY_TX_SLOPE-T NOTES AND LABELS 98 0 0 236   0 

SVY_TX_STRUCTURE-B NOTES AND LABELS 253 1 0 236   0 

SVY_TX_STRUCTURE-T NOTES AND LABELS 253 0 0 236   0 

SVY_TX_SURFACE-PROF NOTES AND LABELS 4 0 0 236   0 

SVY_TX_TRAFFIC NOTES AND LABELS 70 0 0 236   0 

SVY_TX_TV NOTES AND LABELS 70 0 0 236   0 

SVY_TX_VEG NOTES AND LABELS 230 0 0 236   0 

SVY_TX_WALKWAY NOTES AND LABELS 116 0 0 236   0 

SVY_TX_WALL NOTES AND LABELS 100 0 0 236   0 

SVY_TX_WATER NOTES AND LABELS 111 0 0 236   0 
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VII. OTHER SOURCED INFORMATION 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

OTHER SOURCED INFORMATION 

GIS_ALIGNMENT BASELINE ALIGNMENTcenterline 246 4 3 236   3 

GIS_APRON CONC APRON 2 0 0 236   0 

GIS_BARRIER BARRIER (JERSEY / ARMOURSTONE) 100 0 0 236   0 

GIS_BELL BELL APPURTENANCES 70 0 0 236   0 

GIS_BENCH BENCH (PARK / BUS) 246 0 0 236   0 

GIS_BLANK BLANK (MISC SINGLE FEATURE) 0 0 0 236   0 

GIS_BLANKLINE BLANK (MISC LINE FEATURE) 0 0 0 236   0 

GIS_BOREHOLE BOREHOLE DATA 0 0 0 236   0 

GIS_BOULDER BOULDER - LARGE DECORATIVE 0 0 0 236   0 

GIS_BUILDING BUILDING 246 0 0 236   0 

GIS_CB CATCHBASIN 112 0 0 236   0 

GIS_CONTOG-MAJ CONTOURS OG MAJOR 4 0 3 236   3 

GIS_CONTOG-MIN CONTOURS OG MAJOR 16 0 1 236   1 

GIS_CROWN-RD CROWN OF ROADWAY 4 0 0 236   0 

GIS_CSP CULVERT 4 3 3 236   3 

GIS_CURB CURB 4 0 0 236   0 

GIS_CURBSTOP CURBSTOP PARKING 4 2 0 236   0 

GIS_DITCH DITCH LINE 124 4 0 236   0 

GIS_DRIVEWAY DRIVEWAY 100 0 0 236   0 

GIS_EDGE-WATER EDGE OF WATER (POND / RIVER) 124 0 0 236   0 

GIS_EPAVT EDGE OF PAVEMENT 115 0 0 236   0 

GIS_EXPANSION-JOINT BRIDGE EXPANSION JOINT 5 0 2 236   2 

GIS_FENCE FENCE 100 CLF 0 236   0 

GIS_FENCE-GATE FENCE GATE POST 100 0 0 236   0 

GIS_GABION GABION BASKET 66 0 0 236   0 

GIS_GARDEN GARDEN 245 0 1 236   1 

GIS_GAS GAS APPURTENANCES 3 0 0 236   0 

GIS_GROUND GROUND SHOTS 3 0 0 236   0 

GIS_GUIDERAIL GUIDE RAIL 115 7 0 236   0 

GIS_GUTT CURB GUTTER 4 0 0 236   0 

GIS_GUY POLE GUY POLE 247 0 0 236   0 

GIS_GUY WIRE GUY WIRE 247 0 0 236   0 

GIS_HEADWALL HEADWALL 231 0 0 236   0 

GIS_HYDRO HYDRO APPURTENANCES 246 0 0 236   0 

GIS_KILLSTRIP KILLSTRIP 116 0 0 236   0 

GIS_LEGAL LEGAL MONUMENTS 43 0 0 236   0 

GIS_LP LIGHT POLE 246 0 0 236   0 

GIS_MAIL MAILBOX 20 0 0 236   0 

GIS_MH_SAN SANITARY MAINTENANCE HOLE 4 0 0 236   0 

GIS_MH_STM STORM MAINTENANCE HOLE 4 0 0 236   0 

GIS_NOISEWALL NOISEWALL - ANY MATERIAL 100 CLF 0 0   0 

GIS_OG_TIN TIN ORIGINAL GROUND (TRIANGLES) 1 0 0 236   0 

GIS_PARKING_LOT PARKING LOT LIMITS 87 0 0 236   0 

GIS_PCTRL PROJECT CONTROL 43 0 0 236   0 

GIS_PMK_LANE LANE MARKINGS 0 2 0 236   0 

GIS_POND ALL LINEWORK WITHIN TH EPERIMETER OF A POND 0 0 0 0   0 
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OTHER SOURCED INFORMATION 

GIS_PT_BLANK POINTS 0 0 0 236   0 

GIS_PT_BREAKLINES POINTS 35 0 1 236   1 

GIS_PT_GRID POINTS 35 0 1 236   1 

GIS_PT_GROUND POINTS 3 0 0 236   0 

GIS_PYCB CATCHBASIN - PYRAMID 112 0 0 236   0 

GIS_RAILROAD RAILROAD TRACKS 224 0 0 236   0 

GIS_RASTER RASTER ATTACHMENTS 0 0 0 236   0 

GIS_REFPT REFERENCE POINT 43 0 0 236   0 

GIS_RET-WALL RETAINING WALL 3 0 0 236   0 

GIS_RIPRAP RIPRAP 66 0 0 236   0 

GIS_SHELTER BUS SHELTER/PAD 246 0 0 236   0 

GIS_SHOULDER SHOULDER 4 0 0 236   0 

GIS_SIDEWALK SIDEWALK 116 0 0 236   0 

GIS_SIGN SIGN 208 0 0 236   0 

GIS_SLOPE-B BOTTOM OF SLOPE 99 2 0 236   0 

GIS_SLOPE-T TOP OF SLOPE 98 0 0 236   0 

GIS_STRUCTURE-B BOTTOM OF STRUCTURE 5 1 0 236   0 

GIS_STRUCTURE-T TOP OF STRUCTURE 5 0 0 236   0 

GIS_TRAFFIC TRAFFIC 3 0 0 236   0 

GIS_TV TV OR ROGERS 96 0 0 236   0 

GIS_VEG VEGETATION WOODLOT OR HEDGE 230 0 0 236   0 

GIS_WALKWAY WALKWAY 116 0 0 236   0 

GIS_WALL WALL - ENTRANCE FEATURE 100 0 0 236   0 

GIS_WATER WATER 104 0 0 236   0 

VIII. OTHER SOURCED TEXT 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

OTHER SOURCED TEXT 

GIS_TX_ALIGNMENT NOTES AND LABELS 246 4 3 236   0 

GIS_TX_APRON NOTES AND LABELS 2 0 0 236   0 

GIS_TX_BARRIER NOTES AND LABELS 100 0 0 236   0 

GIS_TX_BELL NOTES AND LABELS 70 0 0 236   0 

GIS_TX_BENCH NOTES AND LABELS 246 0 0 236   0 

GIS_TX_BLANK NOTES AND LABELS 0 0 0 236   0 

GIS_TX_BLANKLINE NOTES AND LABELS 0 0 0 236   0 

GIS_TX_BOREHOLE NOTES AND LABELS 0 0 0 236   0 

GIS_TX_BOULDER NOTES AND LABELS 0 0 0 236   0 

GIS_TX_BUILDING NOTES AND LABELS 246 0 0 236   0 

GIS_TX_BUS NOTES AND LABELS 246 0 0 236   0 

GIS_TX_CB NOTES AND LABELS 112 0 0 236   0 

GIS_TX_CONTOG-MAJ NOTES AND LABELS 4 0 3 236   0 

GIS_TX_CONTOG-MIN NOTES AND LABELS 16 0 1 236   0 

GIS_TX_CROWN-RD NOTES AND LABELS 4 0 0 236   0 

GIS_TX_CSP NOTES AND LABELS 4 3 3 236   0 

GIS_TX_CURB NOTES AND LABELS 4 0 0 236   0 

GIS_TX_CURBSTOP NOTES AND LABELS 4 2 0 236   0 

GIS_TX_DITCH NOTES AND LABELS 124 4 0 236   0 

GIS_TX_DRIVEWAY NOTES AND LABELS 100 0 0 236   0 
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OTHER SOURCED TEXT 

GIS_TX_EDGE-WATER NOTES AND LABELS 124 0 0 236   0 

GIS_TX_EPAVT NOTES AND LABELS 115 0 0 236   0 

GIS_TX_EXPANSION-JOINT NOTES AND LABELS 5 0 2 236   0 

GIS_TX_FENCE NOTES AND LABELS 100 CLF 0 236   0 

GIS_TX_FENCE-GATE NOTES AND LABELS 100 0 0 236   0 

GIS_TX_GABION NOTES AND LABELS 66 0 0 236   0 

GIS_TX_GARDEN NOTES AND LABELS 245 0 1 236   0 

GIS_TX_GAS NOTES AND LABELS 3 0 0 236   0 

GIS_TX_GROUND NOTES AND LABELS 3 0 0 236   0 

GIS_TX_GUIDERAIL NOTES AND LABELS 115 7 0 236   0 

GIS_TX_GUTT NOTES AND LABELS 4 0 0 236   0 

GIS_TX_GUY POLE NOTES AND LABELS 247 0 0 236   0 

GIS_TX_GUY WIRE NOTES AND LABELS 247 0 0 236   0 

GIS_TX_HEADWALL NOTES AND LABELS 231 0 0 236   0 

GIS_TX_HYDRO NOTES AND LABELS 246 0 0 236   0 

GIS_TX_KILLSTRIP NOTES AND LABELS 116 0 0 236   0 

GIS_TX_LEGAL NOTES AND LABELS 43 0 0 236   0 

GIS_TX_LP NOTES AND LABELS 246 0 0 236   0 

GIS_TX_MAIL NOTES AND LABELS 20 0 0 236   0 

GIS_TX_MH_SAN NOTES AND LABELS 4 0 0 236   0 

GIS_TX_MH_STM NOTES AND LABELS 4 0 0 236   0 

GIS_TX_NOISEWALL NOTES AND LABELS 100 0 0 0   0 

GIS_TX_OG_TIN NOTES AND LABELS 1 0 0 236   0 

GIS_TX_PCTRL NOTES AND LABELS 43 0 0 236   0 

GIS_TX_PMK_LANE NOTES AND LABELS 0 2 0 236   0 

GIS_TX_POND NOTES AND LABELS 0 0 0 0   0 

GIS_TX_PYCB NOTES AND LABELS 112 0 0 236   0 

GIS_TX_RAILROAD NOTES AND LABELS 224 0 0 236   0 

GIS_TX_REFPT NOTES AND LABELS 43 0 0 236   0 

GIS_TX_RET-WALL NOTES AND LABELS 3 0 0 236   0 

GIS_TX_RIPRAP NOTES AND LABELS 66 0 0 236   0 

GIS_TX_SHOULDER NOTES AND LABELS 4 0 0 236   0 

GIS_TX_SIDEWALK NOTES AND LABELS 116 0 0 236   0 

GIS_TX_SIGN NOTES AND LABELS 208 0 0 236   0 

GIS_TX_SLOPE-B NOTES AND LABELS 99 2 0 236   0 

GIS_TX_SLOPE-T NOTES AND LABELS 98 0 0 236   0 

GIS_TX_STRUCTURE-B NOTES AND LABELS 5 1 0 236   0 

GIS_TX_STRUCTURE-T NOTES AND LABELS 5 0 0 236   0 

GIS_TX_TRAFFIC NOTES AND LABELS 3 0 0 236   0 

GIS_TX_TV NOTES AND LABELS 96 0 0 236   0 

GIS_TX_VEG NOTES AND LABELS 230 0 0 236   0 

GIS_TX_WALKWAY NOTES AND LABELS 116 0 0 236   0 

GIS_TX_WALL NOTES AND LABELS 100 0 0 236   0 

GIS_TX_WATER NOTES AND LABELS 104 0 0 236   0 
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IX. UNDERGROUND UTILITIES LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

UNDERGROUND UTILITIES LEVELS 

POPULATED AS PART OF PRE-
ENG RESEARCH (PUCC) 

NOTE:- Pipe sizes equal to, or greather than, 900mm shall be 
shown (in plan view) by offsetting linework to display an accurate 

diameter.  Center line to remain as the bylevel linestyle, outer 
linework will be changed to a linestyle of zero. 

            

UGS_BELL EXISTING BELL APPURTENANCES - PLAN & PROFILE 70 0 0 236   0 

UGS_BELL-UTIL EXISTING BELL UNDERGROUND LINEWORK - PLAN & SECTIONS 70 BELL 0 236   0 

UGS_CULVERT EXISTING CULVERT - PLAN, PROFILE & SECTIONS 4 2 5 236   5 

UGS_FIBRE UNIDENTIFIED FIBRE CABLES 0 0 0 236   0 

UGS_GAS EXISTING GAS APPURTENANCES - PLAN & PROFILE 3 0 0 236   0 

UGS_GAS-UTIL EXISTING GAS UNDERGROUND LINEWORK - PLAN & SECTIONS 3 GAS 0 236   0 

UGS_HYDRO EXISTING HYDRO APPURTENANCES - PLAN & PROFILE 246 0 0 236   0 

UGS_HYDRO-TELE EXISTING HYDROONE TELECOM UNDERGROUND LINEWORK - PLAN & SECTIONS 246 
HYDRO-

1-T 
0 236   0 

UGS_HYDRO-UTIL 
EXISTING HYDROONE BRAMPTON UNDERGROUND LINEWORK - PLAN & 

SECTIONS 
246 

HYDRO-
1-B 

0 236   0 

UGS_SANI EXISTING SANITARY APPURTENANCES - PLAN & PROFILE 4 0 3 236   3 

UGS_SANI-UTIL EXISTING SANITARY SEWER UNDERGROUND LINEWORK - PLAN & SECTIONS 4 0 5 236   5 

UGS_SH_HYDRO 
SHADING FOR UNDERGROUND HYDRO DUCTS - PROFILE - 'CONC_T', PA=0, 

PS=5, PD=0, AZ=-5 
246 0 0 236   0 

UGS_STORM EXISTING STORM APPURTENANCES - PLAN & PROFILE 4 0 3 236   3 

UGS_STORM-UTIL EXISTING STORM SEWER UNDERGROUND LINEWORK - PLAN & SECTIONS 4 0 5 236   5 

UGS_SUBDRAIN SUBDRAIN 4 3 2 236   0 

UGS_TCS EXISTING TRAFFIC APPURTENANCES - PLAN & PROFILE 3 0 0 236   0 

UGS_TCS-UTIL EXISTING TRAFFIC UNDERGROUND LINEWORK - PLAN & SECTIONS 3 0 0 236   0 

UGS_TV EXISTING TV OR ROGERS APPURTENANCES - PLAN & PROFILE 96 0 0 236   0 

UGS_TV-UTIL EXISTING TV OR ROGERS UNDERGROUND LINEWORK - PLAN & SECTIONS 96 TV 0 236   0 

UGS_UNKNOWN-UTIL UNIDENTIFIED UNDERGROUND UTILITY 0 0 0 236   0 

UGS_WATER EXISTING WATER APPURTENANCES - PLAN & PROFILE 124 0 0 236   0 

UGS_WATER-UTIL EXISTING WATER UNDERGROUND LINEWORK - PLAN & SECTIONS 124 WATER 0 236   0 

X. UNDERGROUND UTILITIES TEXT 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

UNDERGROUND UTILITIES TEXT 

UGS_TX_BELL NOTES AND LABELS 70 0 0 236   0 

UGS_TX_BELL-UTIL NOTES AND LABELS 70 0 0 236   0 

UGS_TX_CULVERT NOTES AND LABELS 4 0 5 236   0 

UGS_TX_FIBRE LABEL 'UNKNOWN FIBRE' 0 0 0 236   0 

UGS_TX_GAS NOTES AND LABELS 3 0 0 236   0 

UGS_TX_GAS-UTIL NOTES AND LABELS 3 0 0 236   0 

UGS_TX_HYDRO NOTES AND LABELS 246 0 0 236   0 

UGS_TX_HYDRO-TELE NOTES AND LABELS 246 0 0 236   0 

UGS_TX_HYDRO-UTIL NOTES AND LABELS 246 0 0 236   0 

UGS_TX_SANI NOTES AND LABELS 4 0 3 236   0 
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UNDERGROUND UTILITIES TEXT 

UGS_TX_SANI-UTIL NOTES AND LABELS 4 0 5 236   0 

UGS_TX_STORM NOTES AND LABELS 4 0 3 236   0 

UGS_TX_STORM-UTIL NOTES AND LABELS 4 0 5 236   0 

UGS_TX_SUBDRAIN NOTES AND LABELS 4 0 0 236   0 

UGS_TX_TCS NOTES AND LABELS 3 0 0 236   0 

UGS_TX_TCS_UTIL NOTES AND LABELS 3 0 0 236   0 

UGS_TX_TV NOTES AND LABELS 96 0 0 236   0 

UGS_TX_TV-UTIL NOTES AND LABELS 96 0 0 236   0 

UGS_TX_UNKNOWN-UTIL LABEL ""UNKNOWN U/G"" 0 0 0 236   0 

UGS_TX_WATER NOTES AND LABELS 124 0 0 236   0 

UGS_TX_WATER-UTIL NOTES AND LABELS 124 0 0 236   0 

XI. LEVELS RESERVED FOR CONSERVATION AUTHORITY INFORMATION 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

LEVELS RESERVED FOR CONSERVATION AUTHORITY INFORMATION 

RCA_FILL_LINE REGIONAL CONSERVATION AUTHORITY FILL LINE - PLAN 253 0 1 0   5 

RCA_FLOOD_LINE REGIONAL CONSERVATION AUTHORITY FLOOD LINE - PLAN 124 0 2 0   10 

RCA_REGULATION_LIMITS REGIONAL CONSERVATION AUTHORITY REGULATION LIMITS - PLAN 6 0 5 0   15 

RCA_TX_FILL_LINE NOTES AND LABELS 253 0 0 0     

RCA_TX_FLOOD_LINE NOTES AND LABELS 124 0 0 0     

RCA_TX_REGULATION_LIMITS NOTES AND LABELS 6 0 0 0     
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XII. ENGINEERING LEVELS USED FOR DESIGN ELEMENTS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

ENGINEERING LEVELS USED FOR DESIGN ELEMENTS 

NOTE:- Pipe sizes equal to, or greather than, 900mm shall be shown (in plan view) by offsetting linework to display an accurate diameter.  Center 
line to remain as the bylevel linestyle, outer linework will be changed to a linestyle of zero. 

ENG_ALIGNMENT BASELINE ALIGNMENTcenterline 246 4 3 0   3 

ENG_APRON PROPOSED CONC APRON - PLAN, PROFILE & SECTIONS 0 0 3 0   3 

ENG_ASHCURB-FACE PROPOSED ASPH CURB FACE - PLAN 0 0 2 0   0 

ENG_BARRIER PROPOSED BARRIER - JERSEY, ARMOURSTONE - PLAN 0 0 3 0   10 

ENG_BELL PROPOSED BELL APPURTENANCES - PLAN & PROFILE 70 0 0 0   10 

ENG_BELL-UTIL PROPOSED BELL UNDERGROUND LINEWORK - PLAN & SECTIONS 70 BELL 4 0   10 

ENG_BENCH PROPOSED BENCH -PARK, BUS - PLAN 0 0 4 0   10 

ENG_BOLLARD PROPOSED BOLLARD - PLAN 0 0 0 0   10 

ENG_BOREHOLE BOREHOLE DATA - PLAN & PROFILE 0 0 0 0   10 

ENG_BOULDER PROPOSED BOULDER - LARGE DECORATIVE - PLAN 0 0 2 0   10 

ENG_BOULEVARD PROPOSED TOP/BOTTOM OF SLOPE ON EDGE OF BOULEVARD 0 1 0 0   10 

ENG_BUSH-CON PROPOSED CONIFEROUS BUSH - PLAN 231 0 4 0   4 

ENG_BUSH-DEC PROPOSED DECIDUOUS BUSH - PLAN 230 0 4 0   4 

ENG_BUS-PAD PROPOSED BUS PAD & WAITING AREA - PLAN 0 0 4 0   10 

ENG_BUS-SHELTER PROPOSED BUS SHELTER - PLAN 0 0 4 0   4 

ENG_CB PROPOSED CATCHBASIN - PLAN 0 0 0 0   0 

ENG_CBMH PROPOSED CATCHBASIN MAINTENANCE HOLE - PLAN 0 0 0 0   0 

ENG_CB-SIDEINLET PROPOSED SIDE INLET CATCHBASIN - PLAN 0 0 0 0   0 

ENG_CC PROPOSED CUTCROSS - PLAN 0 0 0 0   0 

ENG_COMP-ASPH PAVT PROPOSED ASPHALT PAVEMENT COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-CONC PAVT PROPOSED CONCRETE PAVEMENT (BUS BAY) COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-CURB PROPOSED CURB COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-CUT PROPOSED CUT COMPONENT - SECTIONS 152 0 0 0   0 

ENG_COMP-DITCH PROPOSED DITCH COMPONENT - SECTIONS 124 0 0 0   0 

ENG_COMP-FILL PROPOSED FILL COMPONENT - SECTIONS 87 0 0 0   0 

ENG_COMP-GRANULAR PROPOSED GRANULAR COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-ISLAND PROPOSED ISLAND COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-KILLSTRIP PROPOSED KILLSTRIP COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-LIMESTONE PROPOSED LIMESTONE COMPONENT - SECTIONS 96 0 0 0   0 

ENG_COMP-MULTI-TRAIL PROPOSED TRAIL/BIKEPATH COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-SHOULDER PROPOSED SHOULDER COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-SIDEWALK PROPOSED SIDEWALK COMPONENT - SECTIONS 0 0 0 0   0 

ENG_COMP-TERRACE PROPOSED BOULEVARD COMPONENT - SECTIONS 5 0 0 0   0 

ENG_CONTPRO-MAJ PROPOSED CONTOURS - MAJOR - PLAN 0 0 3 0   10 

ENG_CONTPRO-MIN PROPOSED CONTOURS - MINOR - PLAN 3 0 1 0   5 

ENG_CROWN-RD PROPOSED CROWN OF ROADWAY - PLAN & PROFILE 0 4 2 0   2 

ENG_CULVERT PROPOSED CULVERT - PLAN, PROFILE & SECTIONS 0 2 5 0   15 

ENG_CURB PROPOSED PARKING CURBSTOP, CURB CUT - PLAN 0 0 3 0   10 

ENG_CURB-BACK PROPOSED BACK of CURB - PLAN 0 0 4 0   10 

ENG_CURB-FACE PROPOSED FACE of CURB - PLAN 5 0 0 0   0 

ENG_CURB-GUT PROPOSED CURB GUTTER - PLAN 5 0 0 0   0 

ENG_DCB PROPOSED CATCHBASIN - DOUBLE - PLAN 0 0 0 0   0 
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ENGINEERING LEVELS USED FOR DESIGN ELEMENTS 

ENG_DCB-SIDEINLET PROPOSED SIDE INLET DOUBLE CATCHBASIN - PLAN 0 0 0 0   0 

ENG_DICB-ANGLED PROPOSED ANGLED DITCH INLET CATCHBASIN - PLAN 0 0 0 0   0 

ENG_DICB-FLAT PROPOSED FLAT DITCH INLET CATCHBASIN - PLAN 0 0 0 0   0 

ENG_DITCH PROPOSED DITCH LINE - PLAN & PROFILE 124 4 3 0   10 

ENG_DRIVEWAY PROPOSED DRIVEWAY - PLAN 0 0 2 0   10 

ENG_EDGE-WATER PROPOSED EDGE OF WATER - POND, RIVER - PLAN 124 0 3 0   10 

ENG_EPAVT PROPOSED EDGE OF PAVEMENT - PLAN 0 0 4 0   10 

ENG_FDC PROPOSED STORM - FOUNDATION DRAIN COLLECTOR - PLAN 0 0 0 0   15 

ENG_FENCE PROPOSED FENCE - PLAN & SECTIONS 0 CLF 2 0   10 

ENG_FENCE_SILT PROPOSED SILT FENCE - PLAN & SECTIONS 0 6 4 0   10 

ENG_FENCE-GATE PROPOSED FENCE GATE POST - PLAN 0 0 2 0   10 

ENG_GABION PROPOSED GABION BASKET - PLAN & SECTIONS 4 0 2 0   10 

ENG_GARDEN PROPOSED GARDEN LINEWORK - PLAN & SECTIONS 146 0 1 0   5 

ENG_GAS PROPOSED GAS APPURTENANCES - PLAN & PROFILE 3 0 0 0   0 

ENG_GAS-UTIL PROPOSED GAS UNDERGROUND LINEWORK - PLAN & SECTIONS 3 GAS 4 0   10 

ENG_GRADING PROPOSED LIMIT OF GRADING - PLAN 87 GRADING 6 0   6 

ENG_GUIDERAIL-BEAM PROP STEEL BEAM GUIDE RAIL - PLAN & SECTIONS 0 GUARD 4 0   5 

ENG_GUIDERAIL-CABLE PROP CABLE GUIDE RAIL - PLAN & SECTIONS 0 GUARD 4 0   5 

ENG_HEADWALL PROP HEADWALL - PLAN & SECTIONS 0 0 3 0   10 

ENG_HYDRO PROPOSED HYDRO APPURTENANCES - PLAN & PROFILE 157 0 0 0   4 

ENG_HYDRO-TELE 
PROPOSED HYDROONE TELECOM UNDERGROUND LINEWORK - PLAN & 

SECTIONS 
157 

HYDRO-
1-T 

4 0   4 

ENG_HYDRO-UTIL 
PROPOSED HYDROONE BRAMPTON UNDERGROUND LINEWORK - PLAN & 

SECTIONS 
157 

HYDRO-
1-B 

4 0   4 

ENG_HZC HORIZONTAL CONTROL - PLAN 0 0 1 0   1 

ENG_KILLSTRIP PROPOSED KILLSTRIP - PLAN 0 0 4 0   10 

ENG_LANE PROPOSED LANE MARKINGS - PLAN 0 2 1 0   2 

ENG_LANEWAY PROPOSED LANEWAY - PLAN 0 2 1 0   10 

ENG_MAIL PROPOSED MAILBOX - PLAN 0 0 2 0   2 

ENG_MULTI-TRAIL PROPOSED MULTI USE TRAIL, BIKE TRAIL - PLAN 0 0 4 0   10 

ENG_NOISEWALL PROPOSED NOISEWALL - ALL MATERIALS - PLAN $ SECTIONS 0 CLF 5 0     

ENG_NOTES MISC NOTES AND LABELS THAT DON'T FALL UNDER OTHER LEVELS 0 0 0       

ENG_POND ALL LINEWORK WITHIN THE PERIMETER OF A POND 0 0 3 0   0 

ENG_PT_GROUND POINTS 0 0 0 0   0 

ENG_PYCB PROPOSED PYRAMID CB 0 0 0 0   0 

ENG_RET-WALL PROP RETAINING WALL - PLAN & SECTIONS 0 0 3 0   10 

ENG_RIPRAP PROP RIPRAP - PLAN 4 0 3 0   5 

ENG_SANI PROPOSED SANITARY APPURTENANCES - PLAN & PROFILE 0 0 0 0   0 

ENG_SANI-UTIL PROPOSED SANITARY SEWER UNDERGROUND LINEWORK - PLAN & SECTIONS 0 0 4 0   10 

ENG_SHOULDER PROPOSED EDGE OF SHOULDER - PLAN 0 0 2 0   10 

ENG_SIDEWALK PROPOSED CONC SIDEWALK - PLAN 0 0 4 0   10 

ENG_SIGN PROPOSED SIGN - PLAN 0 0 2 0   5 

ENG_SIGN-COM PROPOSED SIGN - COMMERCIAL - PLAN 0 0 2 0   5 

ENG_SLOPE-B PROPOSED BOTTOM OF SLOPE - PLAN 119 0 3 0   10 

ENG_SLOPE-T PROPOSED TOP OF SLOPE - PLAN 139 0 3 0   10 

ENG_STORM PROPOSED STORM INFORMATION - PROFILE 0 0 4 0   15 

ENG_STORM-AREA PROPOSED STORM CATCHMENT AREA - PLAN 0 7 10 0   20 

ENG_STORM-MH PROPOSED STORM APPURTENANCES - PLAN 0 0 0 0   0 

ENG_STORM-UTIL PROPOSED STORM SEWER UNDERGROUND LINEWORK - PLAN & SECTIONS 0 0 10 0   15 

ENG_STRUCTURE-B PROPOSED BOTTOM OF STRUCTURE - PLAN AND SECTIONS 0 1 3 0   5 
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ENG_STRUCTURE-T PROPOSED TOP OF STRUCTURE - PLAN & SECTIONS 0 0 3 0   5 

ENG_SURFACE-PROF PROPOSED SURFACE IN PROFILE and SECTIONS 0 0 4 0   15 

ENG_SWALE PROPOSED SWALE LINE - PLAN & PROFILE 124 4 3 0   10 

ENG_TCS PROPOSED TRAFFIC APPURTENANCES - PLAN & PROFILE 0 0 0 0   0 

ENG_TCS-UTIL PROPOSED TRAFFIC UNDERGROUND LINEWORK - PLAN & SECTIONS 0 0 0 0   0 

ENG_TIN-PRO PROPOSED SURFACE TRIANGLES - PLAN 120 0 1 0   1 

ENG_TITLEBLOCK TITLEBLOCK LINEWORK, NORTH ARROW 0 0 1 0   10 

ENG_TREE-CON PROPOSED CONIFEROUS TREE - PLAN 231 0 0 0   5 

ENG_TREE-DEC PROPOSED DECIDUOUS TREE - PLAN 230 0 0 0   5 

ENG_TV PROPOSED TV OR ROGERS APPURTENANCES - PLAN & PROFILE 96 0 4 0   0 

ENG_TV-UTIL PROPOSED TV OR ROGERS UNDERGROUND LINEWORK - PLAN & SECTIONS 96 TV 4 0   5 

ENG_VCB PROPOSED V TYPE CATCHBASIN 0 0 0 0   0 

ENG_WALKWAY PROPOSED WALKWAY - PLAN 0 0 4 0   10 

ENG_WALL PROPOSED WALL - ENTRANCE FEATURE - PLAN & SECTIONS 0 0 3 0   10 

ENG_WATER PROPOSED WATER APPURTENANCES - PLAN & PROFILE 124 0 4 0   4 

ENG_WATER-UTIL PROPOSED WATER UNDERGROUND LINEWORK - PLAN & SECTIONS 124 WATER 4 0   4 

ENG_XBOUNDARY PROPOSED EXTERIOR BOUNDARY 0 7 5 0   5 

XIII. ENGINEERING TEXT LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

ENGINEERING TEXT LEVELS 

ENG_TX_ALIGNMENT NOTES AND LABELS - STATIONING 0 0 0 0   0 

ENG_TX_APRON NOTES AND LABELS 0 0 0 0   0 

ENG_TX_ASHCURB-FACE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BARRIER NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BELL NOTES AND LABELS 70 0 0 0   0 

ENG_TX_BELL-UTIL NOTES AND LABELS 70 0 0 0   0 

ENG_TX_BENCH NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BOLLARD NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BOREHOLE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BOULDER NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BOULEVARD NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BUSH-CON NOTES AND LABELS 231 0 0 0   0 

ENG_TX_BUSH-DEC NOTES AND LABELS 230 0 0 0   0 

ENG_TX_BUS-PAD NOTES AND LABELS 0 0 0 0   0 

ENG_TX_BUS-SHELTER NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CB NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CBMH NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CB-SIDEINLET NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CC NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CONTPRO-MAJ NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CONTPRO-MIN NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CROWN-RD NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CULVERT NOTES AND LABELS 0 0 0 0   0 

ENG_TX_CURB NOTES AND LABELS 0 0 0 0   0 

ENG_TX_DCB NOTES AND LABELS 0 0 0 0   0 

ENG_TX_DCB-SIDEINLET NOTES AND LABELS 0 0 0 0   0 
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ENGINEERING TEXT LEVELS 

ENG_TX_DICB-ANGLED NOTES AND LABELS 0 0 0 0   0 

ENG_TX_DICB-FLAT NOTES AND LABELS 0 0 0 0   0 

ENG_TX_DITCH NOTES AND LABELS 124 0 0 0   0 

ENG_TX_DRIVEWAY NOTES AND LABELS 0 0 0 0   0 

ENG_TX_EDGE-WATER NOTES AND LABELS 124 0 0 0   0 

ENG_TX_EPAVT NOTES AND LABELS 0 0 0 0   0 

ENG_TX_FDC NOTES AND LABELS 0 0 0 0   0 

ENG_TX_FENCE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_FENCE-GATE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_FENCE-SILT NOTES AND LABELS 0 0 0 0   0 

ENG_TX_GABION NOTES AND LABELS 4 0 0 0   0 

ENG_TX_GARDEN NOTES AND LABELS 146 0 0 0   0 

ENG_TX_GAS NOTES AND LABELS 3 0 0 0   0 

ENG_TX_GAS-UTIL NOTES AND LABELS 3 0 0 0   0 

ENG_TX_GRADING NOTES AND LABELS 248 0 0 0   0 

ENG_TX_GROUND NOTES AND LABELS 0 0 0 0   0 

ENG_TX_GUIDERAIL-BEAM NOTES AND LABELS 0 0 0 0   0 

ENG_TX_GUIDERAIL-CABLE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_HEADWALL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_HYDRO NOTES AND LABELS 157 0 0 0   0 

ENG_TX_HYDRO-TELE NOTES AND LABELS 157 0 0 0   0 

ENG_TX_HYDRO-UTIL NOTES AND LABELS 157 0 0 0   0 

ENG_TX_HZC NOTES AND LABELS 0 0 0 0   0 

ENG_TX_KILLSTRIP NOTES AND LABELS 0 0 0 0   0 

ENG_TX_LANE NOTES AND LABELS 0 0 0 0   0 

ENG_TX_LANEWAY NOTES AND LABELS 0 0 0 0   0 

ENG_TX_MAIL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_MULTI-TRAIL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_NOISEWALL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_POND NOTES AND LABELS 0 0 0 0   0 

ENG_TX_PYCB NOTES AND LABELS 0 0 0 0   0 

ENG_TX_RET-WALL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_RIPRAP NOTES AND LABELS 4 0 0 0   0 

ENG_TX_SANI NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SANI-UTIL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SHOULDER NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SIDEWALK NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SIGN NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SIGN-COM NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SLOPE-B NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SLOPE-T NOTES AND LABELS 0 0 0 0   0 

ENG_TX_STORM NOTES AND LABELS 0 0 0 0   0 

ENG_TX_STORM-AREA NOTES AND LABELS 0 0 0 0   0 

ENG_TX_STORM-MH NOTES AND LABELS 0 0 0 0   0 

ENG_TX_STORM-UTIL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_STRUCTURE-B NOTES AND LABELS 0 0 0 0   0 

ENG_TX_STRUCTURE-T NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SURFACE-PROF NOTES AND LABELS 0 0 0 0   0 

ENG_TX_SWALE NOTES AND LABELS 124 0 0 0   0 

ENG_TX_TCS NOTES AND LABELS 0 0 0 0   0 
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ENGINEERING TEXT LEVELS 

ENG_TX_TCS-UTIL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_TIN-PRO NOTES AND LABELS 0 0 0 0   0 

ENG_TX_TREE-CON NOTES AND LABELS 231 0 0 0   0 

ENG_TX_TREE-DEC NOTES AND LABELS 230 0 0 0   0 

ENG_TX_TV NOTES AND LABELS 96 0 0 0   0 

ENG_TX_TV-UTIL NOTES AND LABELS 96 0 0 0   0 

ENG_TX_VCB NOTES AND LABELS 0 0 0 0   0 

ENG_TX_WALKWAY NOTES AND LABELS 0 0 0 0   0 

ENG_TX_WALL NOTES AND LABELS 0 0 0 0   0 

ENG_TX_WATER NOTES AND LABELS 124 0 0 0   0 

ENG_TX_WATER-UTIL NOTES AND LABELS 124 0 0 0   0 
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XIV. SHADING AND PATTERNING LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

SHADING AND PATTERNING LEVELS 

'HATCH'=Hatch, Crosshatch or Pattern name, 'OPAQUE'=Solid Shape 

PA=Pattern Angle          PS=Pattern Scale          PD=Pattern Delta(spacing) 

AZ=Active Z Value 

RCA_SH_REGULATION_LIMITS 
REGIONAL CONSERVATION AUTHORITY LANDS, HATCH, PA=90, PS=1, 

PD=6.0 
6 0 0 0     

ROW  SHADING is set up for 1:1000 scale property drawings 

ROW_ENG_SH_GUYING_EASEMENT 

PROPOSED PERMANENT HYDRO GUYING EASEMENT, OPAQUE WITH 
HYDRO HATCH ON PRIVATE LANDS, OPAQUE SHAPE WITHOUT HATCH ON 
CITY LANDS, SEE  G:\wtdesign\CONSULTANTs CD burn\Appendix-A v8i\Property 
Closeout Report\IPRP Template.dgn FOR APPLICATION OF SHADING FOR 
GUYING EASEMENT 

68 0 0       

ROW_ENG_SH_HYDRO_EASEMENT 
PROPOSED PERMANENT EASEMENT ie HYDRO, AERIAL, ON 

DEVELOPER/PRIVATE LANDS, HATCH, PA=45, PS=1, PD=1 
68 0 2       

ROW_ENG_SH_PERM_EASEMENT 
PROPOSED PERMANENT EASEMENT ie STRUCTURES, DRAINAGE, 

CROSSHATCH, PA=45/-45, PS=1, PD=1/1 
123 0 2       

ROW_ENG_SH_ROW PROPOSED RIGHT OF WAY (FEE SIMPLE), HATCH, PA=45, PS=1, PD=0.65 117 0 2       

ROW_ENG_SH_TEMP_EASEMENT 
PROPOSED TEMPORARY EASEMENT ie GRADING, CROSSHATCH, PA=45/-

45, PS=1.O, PD=1.5/1.5 
212 0 0       

ENG SHADING is set up for 1:500 scale contract drawings 

ENG_SH_ASPHALT 
PROPOSED SHADING FOR ASPH SURFACE - PLAN - Opaque Shape - AZ= -

15 
235 0 0 233   0 

ENG_SH_CONCRETE 
PROPOSED CONCRETE AREA PATTERN (INCLUDES BUS BAY) - PLAN - 

HATCH, PA=45, PS=1, PD=0.5, AZ= -5 
3 0 1 0   1 

ENG_SH_DRIVEWAY 
PROPOSED DRIVEWAY PATTERN - PLAN - 'ASPH', PA=0, 

REINSTATEMENT->PS=1.0 | RELOCATION or NEW->PS=0.5, PD=0, AZ= -5 
0 0 1 0   1 

ENG_SH_GABION 
PROPOSED GABION HATCH PATTERN - PLAN - 'GABION', PA=0, PS=0.5, 

PD=0, AZ= -5 
4 0 1 0   1 

ENG_SH_GRASS 
PROPOSED GRASSED AREA PATTERN - PLAN - 'GRASS', PA=0, PS=1.0, 

PD=0, AZ= -5 
246 0 1 0   1 

ENG_SH_GRIND 
PROPOSED HATCH FOR ASPHALT GRIND SURFACE - PLAN - HATCH, PA=-

45, PS=1.0, PD=0.75, AZ= -5 
0 0 2 0   2 

ENG_SH_IMPRESSED 
PROPOSED IMPRESSED CONC PATTERN - PLAN - 'CONC_T', PA=30, 

PS=2.0, PD=0, AZ= -5 
3 0 1 0   1 

ENG_SH_ISLAND 
PROPOSED SHADING FOR ISLAND SURFACE - PLAN - Opaque Shape - AZ= 

-10 [Can also be used behind text within patterned areas - AZ=-4] 
250 0 0 8   0 

ENG_SH_KILLSTRIP 
PROPOSED CONCRETE KILLSTRIP and MEDIAN PATTERN - PLAN - 

'CONCRT', PA=0, PS=0.5, PD=0, AZ= -5 
3 0 0 0   0 

ENG_SH_MULTI-TRAIL 
PROPOSED ASPH MULTI-USE TRAIL OR WALKWAY HATCH PATTERN - 

PLAN - CROSSHATCH, PA=45 / -45, PS=1, PA=0.3 / 0.3, AZ= -5 
32 0 0 0   0 

ENG_SH_RIPRAP 
PROPOSED RIP RAP AREA PATTERN - PLAN - 'GRAVEL', PA=0, PS=1.0, 

PD=0, AZ= -5 
4 0 1 0   1 

ENG_SH_SANI 
PROPOSED SANITARY PIPE HATCH - PROFILE - HATCH, PA= -60, PS=1, 

PD=1.0, AZ= -5 
3 0 1 0   1 

ENG_SH_SIDEWALK 
PROPOSED SIDEWALK HATCH PATTERN (INCLUDES BUS PAD) - PLAN - 

HATCH, PA= -45, PS=1, PD=0.3, AZ= -5 
3 0 1 0   1 

ENG_SH_STORM 
PROPOSED STORM PIPE HATCH - PROFILE - HATCH, PA=60, PS=1, 

PD=1.0, AZ= -5 
3 0 1 0   1 

ENG_SH_WATER 
PROPOSED WATERMAIN PIPE HATCH - PROFILE - HATCH, PA= -60, PS=1, 

PD=0.5, AZ= -5 
3 0 1 0   1 
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XV. PAVEMENT MARKINGS LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

PAVEMENT MARKINGS LEVELS 

PMK_CENTRELINE LANE MARKINGS 2 0 1 0   4 

PMK_LANE LANE MARKINGS 2 0 0 0   4 

PMK_LANE_1-1 LANE MARKINGS 2 1-1 0 0   4 

PMK_LANE_3-3 LANE MARKINGS 2 2-2 0 0   4 

PMK_LANE_3-6 LANE MARKINGS 2 3-6 0 0   4 

PMK_LANE-ARROW TURNING ARROWS 2 0 0 0   4 

PMK_LANE-LABEL LANE IDENTIFIERS 2 0 0 0   4 

PMK_LANE-REMOVALS LANE MARKINGS TO BE REMOVED 208 0 0 0   4 

PMK_LANE-SYMBOL LANE SYMBOLS 2 0 0 0   4 

PMK_LEGEND LEGEND OUTLINE 0 0 0 0   4 

PMK_SIGN-LABEL SIGN SYMBOLS 0 0 0 0   4 

PMK_TRAFFIC-SIGN TRAFFIC SIGN 2 0 0 0   4 

PMK_TX_CENTRELINE NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE_1-1 NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE_3-3 NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE_3-6 NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE-ARROW NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE-LABEL NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LANE-REMOVALS NOTES AND LABELS 208 0 0 0   0 

PMK_TX_LANE-SYMBOL NOTES AND LABELS 2 0 0 0   0 

PMK_TX_LEGEND LEGEND TEXT 0 0 0 0   0 

PMK_TX_SIGN-LABEL NOTES AND LABELS 0 0 0 0   0 

PMK_TX_TRAFFIC-SIGN NOTES AND LABELS 2 0 0 0   0 
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XVI. STREET LIGHTING LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

STREET LIGHTING LEVELS 

STL_ABANDON ABANDON 4 2 2 0   2 

STL_BACKGUY BACKGUY 3 0 2 0   2 

STL_CONDUCTORS_OH NEW OVERHEAD CONDUCTORS 90 0 2 0   5 

STL_CONDUIT_UG_100mm 100mm CONDUIT 90 3 4 0   5 

STL_CONDUIT_UG_50mm 50mm CONDUIT 90 2 4 0   5 

STL_ELECTRICAL_CHAMBER NEW ELECTRICAL CHAMBER 3 0 2 0   2 

STL_EXIST_CONDUIT_UG_100mm EXISTING 100mm CONDUIT 236 3 2 236   0 

STL_EXIST_CONDUIT_UG_50mm EXISTING 50mm CONDUIT 236 2 2 236   0 

STL_EXISTING_CONDUCTORS_OH EXISTING OVERHEAD CONDUCTORS 236 0 1 236   0 

STL_EXISTING_ELECTRICAL_CHAMBER EXISTING ELECTRICAL CHAMBER 236 0 0 236   0 

STL_EXISTING_FIXTURES EXISTING FIXTURES 236 0 0 236   0 

STL_EXISTING_POLES EXISTING POLES 236 0 0 236   0 

STL_EXISTING_POWER_SUPPLY EXISTING STREET LIGHT POWER 236 0 0 236   0 

STL_EXISTING_TRANSFORMERS EXISTING TRANSFORMERS 236 0 0 236   0 

STL_FIXTURES NEW FIXTURES 3 2 2 0   5 

STL_FUSE IN-LINE FUSE 3 0 2 0   5 

STL_GND_PLATE GROUND PLATE 3 0 2 0   5 

STL_ID STREET LIGHT IDENTIFICATION TAG 0 0 2 0   5 

STL_POLES NEW POLES 3 0 2 0   5 

STL_POWER_SUPPLY NEW STREET LIGHT POWER SUPPLY 3 0 2 0   5 

STL_REMOVE REMOVAL 4 0 2 0   5 

STL_TRANSFORMERS NEW TRANSFORMERS 3 0 2 0   5 

STL_TX_ABANDON ABANDON 4 0 0 0   0 

STL_TX_BACKGUY BACKGUY 3 0 0 0   0 

STL_TX_CONDUCTORS_OH NEW OVERHEAD CONDUCTORS 90 0 0 0   0 

STL_TX_ELECTRICAL_CHAMBER NEW ELECTRICAL CHAMBER 3 0 0 0   0 

STL_TX_EXISTING_CONDUCTORS_OH EXISTING OVERHEAD CONDUCTORS 236 0 0 236   0 

STL_TX_EXISTING_ELECTRICAL_CHAMB
ER 

EXISTING ELECTRICAL CHAMBER 236 0 0 236   0 

STL_TX_EXISTING_FIXTURES EXISTING FIXTURES 236 0 0 236   0 

STL_TX_EXISTING_POLES EXISTING POLES 236 0 0 236   0 

STL_TX_EXISTING_POWER_SUPPLY EXISTING STREET LIGHT POWER 236 0 0 236   0 

STL_TX_EXISTING_TRANSFORMERS EXISTING TRANSFORMERS 236 0 0 236   0 

STL_TX_FIXTURES NEW FIXTURES 3 0 0 0   0 

STL_TX_FUSE IN-LINE FUSE 3 0 0 0   0 

STL_TX_GND_PLATE GROUND PLATE 3 0 0 0   0 

STL_TX_ID STREET LIGHT IDENTIFICATION TAG 0 0 0 0   0 

STL_TX_POLES NEW POLES 3 0 0 0   0 

STL_TX_POWER_SUPPLY NEW STREET LIGHT POWER SUPPLY 3 0 0 0   0 

STL_TX_REMOVE REMOVAL 4 0 0 0   0 

STL_TX_TRANSFORMERS NEW TRANSFORMERS 3 0 0 0   0 

STL_WIRING WIRING 236 0 0 0   0 
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XVII. TRAFFIC SIGNAL LEVELS 
CITY OF BRAMPTON - LEVEL SETUP & SYMBOLOGY BY-LEVEL OVER-RIDE 

LEVEL NAME DESCRIPTION CO STYLE WT CO LC WT 

TRAFFIC SIGNAL LEVELS 

TCS_100mm-EXIST EXISTING TRAFFIC 100mm RIGID PVC 235 4 2 236   0 

TCS_100mm-NEW PROPOSED TRAFFIC 100mm RIGID PVC 90 3 5 0     

TCS_50mm-EXIST EXISTING TRAFFIC 50mm RIGID PVC 235 0 2 236   0 

TCS_50mm-NEW PROPOSED TRAFFIC 50mm RIGID PVC 90 1 5 0     

TCS_75mm-EXIST EXISTING TRAFFIC 75mm RIGID PVC 235 6 2 236   0 

TCS_75mm-NEW PROPOSED TRAFFIC 75mm RIGID PVC 90 2 5 0     

TCS_BACKGUY PROPOSED TRAFFIC BACKGUY 3 0 2 0     

TCS_CONTROLLER PROPOSED TRAFFIC CONTROLLER 3 0 2 0     

TCS_ELEC-CHAMBER-EXIST EXISTING ELECTRICAL CHAMBER 235 0 2 236   0 

TCS_ELEC-CHAMBER-NEW PROPOSED ELECTRICAL CHAMBER 3 0 2 0     

TCS_FUSE PROPOSED TRAFFIC FUSE 0 0 2 0     

TCS_HYDROSUPPLY PROPOSED HYDRO TRANSFORMER 3 0 2 0     

TCS_LEGEND TRAFFIC LEGEND 0 0 1 0     

TCS_LOOP PROPOSED TRAFFIC LOOPS 3 2 1 0     

TCS_LUMINAIRE-EXIST EXISTING TRAFFIC LUMINAIRE 235 2 0 236   0 

TCS_LUMINAIRE-NEW PROPOSED TRAFFIC LUMINAIRE 3 0 2 0     

TCS_OPTICOM PROPOSED TRAFFIC OPTICOM DETECTOR 3 0 2 0     

TCS_PAV PROPOSED PAVEMENT MARKING 200 0 2 0     

TCS_PLATE PROPOSED TRAFFIC GROUND PLATE 0 0 2 0     

TCS_POLE-EXIST EXISTING TRAFFIC POLE 235 0 0 236   0 

TCS_POLE-NEW PROPOSED TRAFFIC POLE 3 0 2 0     

TCS_POWER PROPOSED TRAFFIC POWER SUPPLY 3 0 2 0     

TCS_PUSHBUTTON PROPOSED TRAFFIC PEDESTRIAN PUSHBUTTON POLE 3 0 2 0     

TCS_RADAR PROPOSED RADAR OR WAVETRONIX DETECTOR 3 0 1 0     

TCS_REMOVAL INDICATES REMOVAL 4 0 3 0     

TCS_SCHEMATIC PROPOSEDSCHEMATIC WIRING LINEWORK 0 0 0 0   0 

TCS_SCHEMATIC-EXIST EXISTING SCHEMATIC WIRING LINEWORK 0 2 0 0   0 

TCS_SIGN PROPOSED REGULATORY OR INFORMATION SIGNAGE 0 0 0 0     

TCS_SIGNALHEAD 
PROPOSED TRAFFIC SIGNAL HEAD INCLUDING PEDESTRIAN SIGNAL HEAD 

& PUSH BUTTON 
3 0 2 0     

TCS_SPAN-EXIST EXISTING AERIAL SPAN CABLE 235 2 2 236   0 

TCS_SPAN-NEW PROPOSED AERIAL SPAN CABLE 3 0 1 0     

TCS_TSP-EVP PROPOSED TSP/EVP ANTENNA 3 0 2 0     

TCS_TX_100mm-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_100mm-NEW PROPOSED NOTES AND LABELS 90 0 0 0     

TCS_TX_50mm-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_50mm-NEW PROPOSED NOTES AND LABELS 90 0 0 0     

TCS_TX_75mm-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_75mm-NEW PROPOSED NOTES AND LABELS 90 0 0 0     

TCS_TX_BACKGUY PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_CONTROLLER PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_ELEC-CHAMBER-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_ELEC-CHAMBER-NEW PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_FUSE PROPOSED NOTES AND LABELS 0 0 0 0     

TCS_TX_HYDROSUPPLY PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_LEGEND NOTES AND LABELS 0 0 0 0     

TCS_TX_LOOP PROPOSED NOTES AND LABELS 3 0 0 0     



City of Brampton - Capital Works Contract Design Procedures - January 2017 

  Pat Z. 

198 

TRAFFIC SIGNAL LEVELS 

TCS_TX_LUMINAIRE-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_LUMINAIRE-NEW PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_PAV PROPOSED NOTES AND LABELS 200 0 0 0     

TCS_TX_PLATE PROPOSED NOTES AND LABELS 0 0 0 0     

TCS_TX_POLE-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_POLE-NEW PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_POWER PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_PUSHBUTTON PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_RADAR PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_REMOVAL NOTES AND LABELS 4 0 0 0     

TCS_TX_SCHEMATIC NOTES AND LABELS 0 0 0 0   0 

TCS_TX_SCHEMATIC-EXIST NOTES AND LABELS 0 0 0 0   0 

TCS_TX_SIGN PROPOSED NOTES AND LABELS 0 0 0 0     

TCS_TX_SIGNALHEAD PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_SPAN-EXIST EXISTING NOTES AND LABELS 235 0 0 236   0 

TCS_TX_SPAN-NEW PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_TSP-EVP PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_VIDEO PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX_WIFI PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_TX-OPTICOM PROPOSED NOTES AND LABELS 3 0 0 0     

TCS_VIDEO PROPOSED TRAFFIC VIDEO DETECTOR 3 0 2 0     

TCS_WIFI PROPOSED WIRELESS HUB 3 0 2 0     
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2) APPENDIX 2 – CELL LIBRARY 

BRAMPTON CELLS V8I.CEL 

This library contains both survey cells and engineering cells. It also includes cells, created 

in the ENG levels, based on OPSD for CBs, DCBs and DICBs in all the alternatives (these 

can be used in the profile to work around other utilities or to show non-standard 

positioning of leads. 

For initial survey cleanup process, survey cells and level symbology, refer to the 

Survey Section’s manual for base plan preparation. 

 

City of Brampton Standard Cell Library – BRAMPTON CELLS V8i.cel 

CELL NAME 
USED IN 

VIEW… 
DESCRIPTION CELL W/ORIGIN 

45OUT PLAN 45 Degree Concrete Outlet 

 

90OUT PLAN 90 Degree Concrete Outlet 

AREA PLAN 
Storm Drainage Identifier 

with area, co-efficient & area # 

 

CO_HA PLAN 
Storm Drainage Identifier 

with area & co-efficient 

ARMOUR 
PLAN / 

PROFILE 
Pattern for Armour Stone 

 

ARRODI PLAN Arrow for Existing Ditch Line 
 

ARROSA PLAN Arrow for Existing Sanitary Line 

 ARROST PLAN Arrow for Existing Storm Line 

ARROW PLAN Generic Arrow 
 

 

 
 

ARROWDI PLAN Arrow for Proposed Ditch Line 

ARROWSA PLAN Arrow for Proposed Sanitary Line 

ARROWST PLAN Arrow for Proposed Storm Line 

ASPH PLAN Pattern for Driveway Reinstatement 

 

BIKE PLAN Bike Path Paint Symbol 
 

BORE-HOLE PLAN Proposed Borehole - With text 

                   

BRHOLE PLAN Proposed Borehole - No Text 

BOREHOLE PLAN Surveyed Borehole 

BOULDER PLAN Existing Boulder 
 

BUSH-CON PLAN Existing Coniferous Bush 
 

BUSH-DEC PLAN Existing Deciduous Bush 
 

CBUSH PLAN 
Linear  Pattern for group of 

Coniferous Trees 
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City of Brampton Standard Cell Library – BRAMPTON CELLS V8i.cel 

CELL NAME 
USED IN 

VIEW… 
DESCRIPTION CELL W/ORIGIN 

CONC_T 
PLAN / 

PROFILE 

Area Pattern for Impressed Concrete 

Killstrip / Median 
 

CONCRT PLAN 
Area Pattern for Concrete Killstrip / 

Median 

 

CONIF PLAN Existing Coniferous Tree 

 

CUTCROSS PLAN Survey Cut Cross 
 

DBUSH PLAN 
Linear Pattern for group of 

Deciduous Trees 
 

DECID PLAN Existing Deciduous Tree 

 

END_GAS 

END_SAN 

END_STM 

END_WM 

PROFILE 
Profile Pipe Ends for Existing 

Underground Services 

 

END_P_SANI 

END_P_STM 
PROFILE 

Profile Pipe Ends for Proposed 

Sanitary / Storm Underground Pipes 

 

GABION 
SECTIONS / 

PROFILE 
Area Pattern for Existing Gabion Walls 

 

GRASS PLAN 
Area Pattern for Proposed Grassed 

Areas 

 

GRAVEL PLAN Area Pattern for Proposed Rib Rap 

 

GROUND PLAN Point for Spot Elevations 
 

GUY PLAN Hydro Anchor 

 GWIRE PLAN Hydro Anchor & Guy Wire 

HCM PLAN Horizontal Control Monument 
 

HP_no PLAN Hydro Pole with Number 
 

HPT PROFILE High Point 

              LPT PROFILE Low Point 

HYDRANT PLAN Existing Water Hydrant 

 

INTERSECTION PROFILE Cross Road Identification for Profile 

 

LT TURN PLAN Left Turn Lane 
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City of Brampton Standard Cell Library – BRAMPTON CELLS V8i.cel 

CELL NAME 
USED IN 

VIEW… 
DESCRIPTION CELL W/ORIGIN 

THRU PLAN Through Lane Marking 

NARROW PLAN North Arrow 

 

NOTE PLAN 
"This Drawing to be Used for Road 

and Storm Sewer Works Only" 

 

P-HYD PROFILE Proposed Water Hydrant for Profile 

 

P_CB PLAN Proposed Catchbasin 

 

P_CB-SIDEINLET PLAN Proposed Side Inlet Catchbasin 

P_CBMH PLAN 
Proposed Catchbasin Maintenance 

Hole 

 

P_DCB PLAN Proposed Double Catchbasin 

 

P_DCB-SIDEINLET PLAN 
Proposed Side Inlet Double 

Catchbasin 

 

P_DICB-ANGLED PLAN 
Proposed Angled 

Ditch Inlet Catchbasin 

 

 

P_DICB-FLAT PLAN 
Proposed Flat 

Ditch Inlet Catchbasin 

P_GUY PLAN Proposed Guy Wire 
 

P_HP PLAN 
Proposed Hydro Pole with Number 

Data Field 

 

P_MH PLAN Proposed Maintenance Hole 

 

P_PYD_CB PLAN Proposed Pyramid Catchbasin 

 

P_SLOPE PLAN 
Linear Pattern for Proposed Slope 

Identification 

 

PI PROFILE Point of Intersection 

 

PI_STA PROFILE 
Point of Intersection with Station Data 

Field 

 

POINT PLAN Generic Point 

 

POLE PLAN Generic Pole 

RAIL PLAN Linear Pattern for Guide Rail 
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City of Brampton Standard Cell Library – BRAMPTON CELLS V8i.cel 

CELL NAME 
USED IN 

VIEW… 
DESCRIPTION CELL W/ORIGIN 

REMOVE PLAN 
Removals Drawing Relocation 

Symbol 

 

RIP-RAP PLAN Area Pattern for Existing Rip Rap 

 

SLOPE PLAN 
Linear Pattern for Existing Slope 

Identification 

 

SOUND PLAN Sounding Point 

 

SPOT PLAN Ground Shots with Text Tags 

 

SPOT-ELEV PLAN Ground Shots with Text Tags 

 

TEST-PIT PLAN Proposed Test Pit with Text 

 

 

TESTPIT PLAN Existing Test Pit with Text 

TICK PLAN 
 

 

TWSI PLAN Tactile Walking Surface Indicator 

 

X_BAR SECTIONS Barrier - No Cross Fall 

 
OPSD 911.130 

 

X_BARL SECTIONS Barrier - Left Cross Fall 

X_BARR SECTIONS Barrier - Right Cross Fall 

X_BELL SECTIONS Existing Bell Service Location 

 

X_BLDG SECTIONS Existing Building Location 

 

X_BRDG SECTIONS Existing Bridge Location 

 

X_BUSH SECTIONS Existing Edge of Woodlot 

 

X_CONIF SECTIONS Existing Coniferous Tree 

           
X_CSHRUB SECTIONS Existing Coniferous Shrub 

X_DECID SECTIONS Existing Deciduous Tree 

                 
 

X_DSHRUB SECTIONS Existing Deciduous Shrub 
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City of Brampton Standard Cell Library – BRAMPTON CELLS V8i.cel 

CELL NAME 
USED IN 

VIEW… 
DESCRIPTION CELL W/ORIGIN 

X_FENC SECTIONS Existing Fence Location 

 

X_FLOOD SECTIONS Regional Conservation Flood Line 

 

X_GAB SECTIONS Existing Gabion Wall 

 

X_GAS SECTIONS Existing Gas Service Location 

 

X_GRDN SECTIONS Existing Garden Location 

 

X_GUIDERAIL SECTIONS Existing Guide Rail Location 

 

X_HEAD SECTIONS Existing Headwall Location 

 

X_HEDG SECTIONS Existing Hedge Location 

 

X_HP SECTIONS Existing Hydro Pole Location 

 

X_HYDRO SECTIONS 
Existing Hydro Underground Service 

Location 

 

X_LBARRIER SECTIONS 
Proposed Island Barrier Curb 

(Left Side) 

 

 
OPSD 600.080 

X_RBARRIER SECTIONS 
Proposed Island Barrier Curb 

(Right Side) 

X_LBBK SECTIONS 
Proposed 1.5m Bike Path 

(Left Side) 
 

 

X_RBBK SECTIONS 
Proposed 1.5m Bike Path 

(Right Side) 

X_LBC SECTIONS 
Proposed Curb & Gutter 

(Left Side) 

 
OPSD 600.040 

X_RBC SECTIONS 
Proposed Curb & Gutter 

(Right Side) 

X_LBKS SECTIONS 
Proposed 1m Killstrip 

(Left Side) 
 

X_RBKS SECTIONS 
Proposed 1m Killstrip 

(Right Side) 

X_LBKS-H SECTIONS 
Proposed 0.5m Killstrip 

(Left Side) 

               X_RBKS-H SECTIONS 
Proposed 0.5m Killstrip 

(Right Side) 
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X_LBRCURB SECTIONS 
Proposed Parking Lot 

Barrier Curb (Left Side) 

 
OPSD 600.110 

X_RBRCURB SECTIONS 
Proposed Parking Lot 

Barrier Curb (Right Side) 

X_LBSW SECTIONS 
Proposed 1.5m Sidewalk 

(Left Sidewalk) 

 

X_RBSW SECTIONS 
Proposed 1.5m Sidewalk 

(Right Sidewalk) 

X_LCURB SECTIONS 
Proposed Bus Bay Curb 

(Left Side) 
 

            
OPSD 600.030 Depressed X_RCURB SECTIONS 

Proposed Bus Bay Curb 

(Right Side) 

X_PROW SECTIONS Proposed Property Line Location 

        
X_ROW SECTIONS Existing Property Line Location 

X_RBBK-MU SECTIONS Proposed 3.0m Bike Path (Right Side) 
 

X_RCA SECTIONS Proposed Regulation Limits 

 

X_RET SECTIONS Existing Retaining Wall Location 

 

X_RR 
SECTIONS / 

PROFILE 
Existing Rail Road Rail Symbol 

 

X_SANI SECTIONS Existing Sanitary Service Location 

 

X_SANMH 
SECTIONS / 

PROFILE 

Existing Sanitary 

Maintenance Hole Location 

X_STM SECTIONS 
Existing Storm 

Service Location 

             

X_STMMH 
SECTIONS / 

PROFILE 

Existing Storm Maintenance 

Hole Location 

X_STORM SECTIONS 
Proposed Storm 

Service Location 

X_STR-BOT SECTIONS Existing bottom of structure location 

 
X_STR-TOP SECTIONS Existing top of structure location 

X_TBRDG SECTIONS Existing Top of Bridge Location 

 

X_TV SECTIONS Existing TV / Rogers Service Location 

 

X_V SECTIONS Proposed 800mm wide V Curb 
 

X_WC SECTIONS 
Existing Water 

Chamber Location 

                   
X_WM SECTIONS 

Existing Water 

Service Location 

XP_BELL SECTIONS Proposed Bell Service Location 
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XP_FENCE SECTIONS Proposed Fence Location 

 

XP_GAS SECTIONS Proposed Gas Service Location 

 

XP_HYDRO SECTIONS Proposed Hydro Service Location 

 

XP_NOISE SECTIONS Proposed Noise Wall 

 

XP_RAIL-BEAM SECTIONS Proposed Beam Guide Rail 

 

XP_RAIL-CABLE SECTIONS Proposed Cable Guide Rail 

XP_SAN SECTIONS Proposed Sanitary Service Location 

 

XP_STM SECTIONS Proposed Storm Service Location 

 

XP_TV SECTIONS 
Proposed TV / Rogers Service 

Location 

 

XP_WM SECTIONS Proposed Water Service Location 

 

X-SEC BASE-LTR 

X-SEC BASE-LGL 

X-SEC BASE-TAB 

SECTIONS 

Border setup for cross sections 

Created in 3 sizes 

Letter, Legal & Tabloid (11x17) 

(Insertion point on left border level 

with titleblock frame) 

 

X-SEC BASE  LTR 

X-SEC BASE  LGL 

X-SEC BASE  TAB 

SECTIONS 

Border setup for cross sections 

Created in 3 sizes 

Letter, Legal & Tabloid (11x17) 

(Insertion point inset from left border 

and above titleblock frame) 
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3) APPENDIX 3 - DOCUMENT TEMPLATES 

I. BLANK LETTERHEAD.DOCX 

Generic letterhead for Capital Works group. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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I I. GENERAL MEMO FORM.DOCX 

Generic memo form for Capital Works group. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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I I I. GENERAL TRANSMITTAL FORM.DOCX 

Generic transmittal form for Capital Works group. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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IV. GENERAL UTILITIES MARKUP REQUEST.DOCX 

Standard form letter to be used to circulate plan(s) to utilities for non-capital works. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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V. PUCC-1 - PRE-ENG LETTER.DOCX 

Standard form letter to be completed and provided digitally to the Senior 

Secretary (Lucia) 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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VI. PUCC-2 – FINAL SUBMISSION FORM.DOCX 

Form to be completed with project & contact information and provided to the 

PUCC Co-ordinator (Shamsul), with 13 folded copies of the project. 
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VII. CAPITAL PROJECTS - DESIGN CIRCULATION-INTERNAL.DOCX 

Circulation list to be used for 30%/60%/90% Capital Design circulations. 
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VIII. CAPITAL PROJECTS - DESIGN CIRCULATION-UTILITIES.DOCX 

Circulation list to be used for 30%/60%/90% Capital Design circulations. 
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IX. JOINT PROJECT GUIDELINES FOR CIRCULATION.XLSX 

This form is to be used ONLY for Joint Region of Peel Project circulations
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X. PUCC – CONSULTANT CIRCULATION – MEMO.DOCX 

Standard form letter to be used when providing a PUCC package for review by the 

consultant doing a capital project. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XI. SITEPLAN – CONSULTANT CIRCULATION – MEMO.DOCX 

Standard form letter to be used when providing a siteplan package for review by 

the consultant doing a capital project. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XII. SITEPLAN – INTERNAL CIRCULATION - MEMO.DOCX 

Standard form letter to be used when providing a siteplan for review by other 

internal departments i.e. traffic, lighting… 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XIII. SITEPLAN REVIEW – SP XXX-XX – COMMENTS.DOCX 

Letter to be used to provide siteplan review comments to the Development group.  

LATEST CITY LOGO / 

DEPARTMENT… 
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XIV. SUBDIVISION – CONSULTANT CIRCULATION – MEMO.DOCX 

Standard form letter to be used when providing a development package for 

review by the consultant doing a capital project. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XV. SUBDIVISION - INTERNAL CIRCULATION – MEMO.DOCX 

Standard form letter to be used when providing a subdivision package for review 

by other internal departments i.e. traffic, lighting… 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XVI. SUBDIVISION REVIEW – DSRXX-XX-XX –COMMENTS.DOCX (LETTER) 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XVII. DRAWING REVISIONS LOG.DOCX (CHART)  

LATEST CITY LOGO / 

DEPARTMENT… 
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4) APPENDIX 4 –PROJECT CHECKLISTS 

I. IN HOUSE DESIGN CRITERIA.DOCX 

To be completed by Technologist and confirmed by Project Manager   

LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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I I. IN HOUSE DESIGN – KICKOFF AND 30 CHECKLIST.DOCX 

   
LATEST CITY LOGO / 

DEPARTMENT… 
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I I I. IN HOUSE DESIGN – 60 CHECKLIST.DOCX 

These items should be completed by the 60% circulation stage.  

LATEST CITY LOGO / 

DEPARTMENT… 
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IV. IN HOUSE DESIGN – 90 CHECKILIST.DOCX 

These Items should be completed by the 90% circulation stage 

  
LATEST CITY LOGO / 

DEPARTMENT… 
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V. DESIGN CIRCULATION-COMMENTS.XLSX 

Form to be provided to circulated stakeholders, used to log comments and 

returned to Project Coordinator (Shamsul). One spreadsheet containing all comments is to 

be completed, prior to next design circulation.  
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VI. INHOUSE DESIGN – IFT-IFC-PACKAGE CHECKLIST.DOCX 

  

LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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VII. CONSULTANT – DESIGN CRITERIA.DOCX 

To be completed by Consultant and confirmed by Project Manager   

LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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VIII. REVIEW OF DESIGNS COMPLETED BY CONSULTANTS-30.DOCX 

  
LATEST CITY LOGO / 

DEPARTMENT… 
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IX. REVIEW OF DESIGNS COMPLETED BY CONSULTANTS-60.DOCX  

LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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X. REVIEW OF DESIGN COMPLETED BY CONSULTANTS-90TO100.DOCX  

LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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XI. REVIEW OF DESIGN COMPLETED BY CONSULTANTS-IFT-IFC.DOCX  

LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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XII. DESIGN HANDOVER CD CHECKLIST.DOCX 

Checklist for CD provided at ‘Issued for Construction’ stage and ‘Issued for As 

Construction’ stage. 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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XIII. REVIEW OF AS CONSTRUCTED SUBMISSIONS BY CONSULTANT.XLSX 

  
LATEST CITY LOGO / 

DEPARTMENT… 
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XIV. REVIEW OF AS CONSTRUCTED SUBMISSION.DOCX 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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5) APPENDIX 5 - EXAMPLES 

I. REALTY PLANS 

IPRP - PORTRAIT 

 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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IPRP - LANDSCAPE 

 

  

LA
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M
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T…
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IPRP - MULTIPLE 

 

  

LA
TE

ST
 C

IT
Y 

LO
GO

 /
 

DE
PA

RT
M

EN
T…
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I I. DESIGN CRITERIA CHECKLIST 

  
LATEST CITY LOGO / 

DEPARTMENT… 

LATEST CITY LOGO / 

DEPARTMENT… 
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I I I. DRAWING NUMBERS LIST / SPREADSHEET 
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IV. 3D LINEWORK – ISO VIEWS 
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V. STORM INFORMATION CHARTS FOR DESIGN DRAWINGS & QUANTITIES 

STORM MAINTENANCE HOLES CHART 

 

STORM CATCHBASINS CHART 
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VI. PARTIAL LIST OF QUANTITIES PROVIDED TO PM FOR TENDER FORM 
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VII. CROSS SECTION  
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VIII. ENGINEERING – CONSTRUCTION DRAWING 
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IX. REVISIONS INFORMATION IN TITLEBLOCK 

  

LATEST CITY LOGO / 

DEPARTMENT… 
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X. ENGINEERING - AS-CONSTRUCTED DRAWING 
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XI. TRAFFIC – CONSTRUCTION DRAWING 
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XII. TRAFFIC – AS-CONSTRUCTED DRAWING 

 

  

LA
TE

ST
 C

IT
Y 

LO
G

O
 

/ 
DE

PA
RT

M
EN

T…
 



City of Brampton - Capital Works Contract Design Procedures – January 2017 

Pat Z. 
251 

XIII. LIGHTING – CONSTRUCTION DRAWING 
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XIV. LIGHTING – AS-CONSTRUCTED DRAWING 
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6) APPENDIX 6 – COMMON OPSD 

MOST COMMONLY USED OPSD FOR DESIGN AND CONSTRUCTION 

200 - GRADING SECTIONS 

219.180 Straw Bale Flow Check Dam 

219.210 Rock Flow Check Dam V-Ditch 

219.211 Rock Flow Check Dam Flat Bottom Ditch 

300 - SIDE ENTRANCES 

310.010 Concrete Sidewalk 

310.020 Concrete Sidewalk Adjacent to Curb and Gutter 

310.030 Concrete Sidewalk Ramps at Intersections 

400 - FRAMES AND GRATES 

400.010 Cast Iron, Square Frame with Square Overflow Type Dished Grate for Catch 

Basins, Herring Bone Openings 

400.020 Cast Iron, Square Frame with Square Flat Grate for Catch Basins, Herring 

Bone Openings 

400.030 Cast Iron, Square Frame with Square V Grate for Catch Basins, Herring Bone 

Openings 

400.081 Cast Iron, Curb Inlet Frame with Two-Piece Raised Cover for Catch Basins 

Out of Roadway 

400.110 Cast Iron, Square Frame with Square Overflow Type Flat Grate for Catch 

Basins, Perforated Openings 

400.120 Cast Iron, Square Frame with Birdcage Grate for Catch Basins 

401.010 Cast Iron, Square Frame with Circular Closed or Open Cover for 

Maintenance Holes 

403.010 Galvanized Steel, Honey Comb Grating for Ditch Inlets 

404.020 Aluminum Safety Platform for Circular Maintenance Holes 

405.020 Maintenance Hole Steps, Solid 

500 - PAVING 

512.011 Concrete Steps, Slab on Grade 

561.010 Interlocking Concrete Pavers on Granular Base 

600 - CURBS AND GUTTERS 

600.030 Concrete Mountable Curb with Wide Gutter [depressed at Zum bus bays] 

600.040 Concrete Barrier Curb with Standard Gutter [roadways] 
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600.060 Concrete Semi-Mountable Curb with Standard Gutter [depressed at bus 

bays] 

600.080 Concrete Barrier Curb with Narrow Gutter [median curbs] 

600.090 Concrete Semi-Mountable Curb with Narrow Gutter 

600.110 Concrete Barrier Curb [parking lots] 

601.010 Asphalt Curb and Asphalt Gutter 

603.020 Precast Concrete Curb 

604.010 90⁰ Concrete Outlet for Concrete Curb with Gutter 

604.020 90⁰ Asphalt Outlet for Asphalt Gutter 

605.010 45⁰ Concrete Outlet for Concrete Curb with Gutter 

605.020 30⁰ and 45⁰ Asphalt Outlets for Asphalt Gutter 

605.040 Asphalt Spillways 

700 - C. BASINS AND M. HOLES 

701.010 Precast Concrete Maintenance Hole, 1200mm Diameter 

701.011 Precast Concrete Maintenance Hole, 1500mm Diameter 

701.012 Precast Concrete Maintenance Hole, 1800mm Diameter 

701.013 Precast Concrete Maintenance Hole, 2400mm Diameter 

701.014  Precast Concrete Maintenance Hole, 3000mm Diameter 

701.015  Precast Concrete Maintenance Hole, 3600mm Diameter 

701.021 Maintenance Hole Benching and Pipe Opening Alternatives 

705.010 Precast Concrete Catch Basin, 600 x 600 mm 

705.020 Precast Concrete Twin Inlet Catch Basin, 600 x 1200 mm 

705.030 Precast Concrete Ditch Inlet, 600 x 600 mm 

706.010 Precast Concrete Ditch Inlet, 600 x 1200 mm with 1500mm Diameter Flat Cap 

706.020 Precast Concrete Ditch Inlet, 600 x 1200 mm with 1800mm Diameter Flat Cap 

708.010 Catch Basin Connection for Rigid Main Pipe Sewer 

708.020 Support for Pipe at Catch Basin or Maintenance Hole 

800 - CULVERTS AND DRAINS 

801.020 End Section Details, Corrugated Steel Pipe 

802.010 Flexible Pipe Embedment and Backfill, Earth Excavation 

802.020 Flexible Pipe Arch Embedment and Backfill, Earth Excavation 

802.030 Rigid Pipe Bedding, Cover, and Backfill, Type 1 or 2 Soil – Earth Excavation 

804.030 Concrete Headwall for Pipe Less Than 900mm 

804.040 Concrete Headwall for Sewer or Culvert Pipe Outlet 
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804.050 Grating for Concrete Headwall 

810.010 Rip-Rap Treatment for Sewer and Culvert Outlets 

810.020 Rip-Rap Treatment for Ditch Inlets 

900 - FENCING,  GUIDE RAILS 

911.140 Guide Rail System, Concrete Barrier, Precast I-Lock Connection Installation, 

Temporary and Permanent 

911.233 Guide Rail System, Concrete Barrier, Precast Temporary End Section 

Installation 

912.101 Guide Rail System, Steel Beam, Rail, Component 

912.102 Guide Rail System, Steel Beam, Channel, Component 

912.401 Guide Rail System, Steel Beam, Structure Connection, Component – Rail and 

Channel 

922.401 Energy Attenuator, End Treatment, Eccentric Loader Terminal System, 

Component – Loader Assembly 

922.402 Energy Attenuator, End Treatment, Eccentric Loader Terminal System, 

Component – Rail and Cable Attachment 

922.410  Energy Attenuator, End Treatment, Eccentric Loader Terminal System, 

Assembly – Loader Detail 

922.430 Energy Attenuator, End Treatment, Eccentric Loader Terminal System, 

Installation – Layout and Post 

922.530 Energy Attenuator, End Treatment, Steel Beam Energy Attenuating Terminal, 

Extruder Terminal System with Wooden Posts, Installation 

971.101 Fence, Highway, In Earth, Shale, Loose Rock or Friable Rock, Installation 

972.102 Fence, Chain-Link, Component – Gate 

972.130 Fence, Chain-Link, Installation – Roadway 

1000 - SANITARY SEWERS, MANHOLES & CATCH BASINS 

1003.010 Cast-in-Place Maintenance Hole Drop Structure Tee 

1003.020 Cast-in-Place Maintenance Hole Drop Structure Wye 

3000 - STRUCTURES 

3120.100 Walls, Retaining, Concrete Toe Wall 

3121.150 Walls, Retaining, Backfill, Minimum Granular Requirement 

3190.100 Walls, Retaining and Abutment, Wall Drain 

3940.150 Figures in Concrete, Warning Message, Layout 

3940.151 Figures in Concrete, Warning Message, Letters 
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7) APPENDIX 7 – RECORD OF CHANGES, UPDATES & CORRECTIONS 

2011 

JUNE 2011 

Level 10 description corrected 

JULY 2011 

Level Structure replaced 

AUGUST 2011 

Note added RE orange error colour under Roadway library, corridors and modeler / 

Point Controls 

Cells updated throughout including cell library name  

OCTOBER 2011 

Cells updated to include new Regional Conservation Limit and spot elevation cells 

NOVEMBER 2011 

Section added at end for As Constructed drawing preparation. PDF version 

contains examples of a pre- and a post-as constructed drawing 

Levels modified to accommodate engineering foundation drain collector MHs text 

and linework 

DECEMBER 2011 

Level symbology modified for some ROW levels 

2012 

JANUARY 2012 

ENG_SH_KILLSTRIP description changed to include pattern for asphalt surfaces 

Missing SVY Levels added 

Note added regarding alignments under a Geometry Project in section “Multiple 

Alignments within a Geometry Project” 

MAY 2012 

Section added for Property Plans outlining requirements and file names 

JUNE 2012 

Levels added for Developer ROW and Lot Lines 

Target Aliasing sections moved to more logical order 

JULY 2012 
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Borehole and test pit cells added to list of cells 

Typical City streetscape components section added 

Hydro One Brampton procedures modified 

AUGUST 2012 

Patterning elevations synchronized between explanation of patterning method 

and chart of patterning parameters. 

Communications folder contents modified. 

Five new levels added for stages of submissions i.e. 30/60/90/tender/construction 

Note added about title page and drawing list page and the levels to be turned 

on/off for each submission. 

SEPTEMBER 2012 

Updates to file structure descriptions and example provided of typical contract 

directory. 

Hyperlink corrections 

Note correction in 3D patterning section. 

Changed file structure to move “CD FOR HANDOVER” to main directory 

OCTOBER 2012 

Expanded  >>COMMUNICATIONS folder description 

Expanded Manage Corridors 

Expanded >>CD FOR HANDOVER folder description 

Expanded >>>E-MAIL “project number” folder description 

Expanded In Microstation…Final Drawing Cleanup 

Added Annotating the Centerline 

Added Quick List of Process 

Added Other Drawings to be Created or Modified 

DECEMBER 2012 

Roadway Modeller Interface section added 

30, 60 & 90 Percent Submissions clarified 

Page references updated 

Sample As Constructed drawings added 

Procedures added for CADD review of capital projects being completed by 

Consultants 

Procedures added for CADD review of as constructed drawings being completed 

by Consultants 
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2013 

JANUARY 2013 

Explanation of requirements for “as constructed” traffic drawings added to 

“Drafting Requirements for as Constructed drawings” 

Additional explanation of traffic requirements for “as constructed” drawings 

MARCH 2013 

“NOTES” page added at the front of the manual for jotting down reminders. 

“Drafting requirements for ‘As Constructed’ Drawings” expanded to include 

requirements for lighting and traffic sections. 

Added note to “Drafting requirement for ‘As Constructed’ Drawings” general 

requirements RE the Engineer’s Stamp. 

Added note outlining stages where an engineer’s stamp is required. (Engineering 

Submissions) 

Added Most Commonly used OPSD standards. 

Added alternate method for clipping references. (Clipping Information for Drawing 

Sheets / Creating Drawing Sheets) 

Added standardized verbiage for contract circulation / distribution e-mail. (Digital 

Submissions) 

Added notes to identify that only plan and profile drawings are required for final 

PUCC submission. (Engineering Submissions) 

Added reference to CD Handover Checklist for digital drawings. (Standard File 

Structure / CD for HANDOVER) 

Added an example of a cross section after “Cross Sections-Display”. 

Expanded “Patterning in 3D” to include tips on working in 3D, renamed “Working 

and Patterning in 3D”. 

“Property Plans” expanded to better explain process of creating property strip plan 

and IPRPs. 

Prologue updated. 

Removed Levels from Street Lighting List and adjusted colours and weights. 

Added note referencing spreadsheets available for Reviewing the CADD 

component of As Constructed drawings and outsourced Capital projects. (CADD Review 

of…) 

Added note identifying implementation of various standard requirements... 

georeferencing, 3D elements, leveling systems. (CADD Review of As Constructed 

Development Drawings) 

Added samples of –  

IPRP drawings 

Design Criteria Sheet 

Milestones Checklists 
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Iso Views demonstrating Poor and Proper 3D work 

Digital Drawings Checklist for Handover at Issued for Construction and Pre As Constructed stages 

As Constructed requirements drawing for Engineering drawings 

As Constructed Engineering drawing 

As Constructed requirements drawing for Traffic drawings 

As Constructed Traffic drawings 

As Constructed requirements drawing for Lighting drawings 

As Constructed Lighting drawings 

Removed references to G:\drive information and provided generic directions to 

accommodate external projects and updated Standard File Structure to match CD Burn 

directory. 

Updated names for cell library, template library and preference file 

(BRAMPTON CELLS V8i.cel, BRAMPTON.itl, and BRAMPTON.xin) 

In Seed-3DUTM.dgn 

Override colours for existing survey information changed to 236 

Override colour for ENG_SH_ASPHALT changed to 233 

Added level in Survey section for crossing segments 

In BRAMPTON CELLS V8i.cel 

“SLOPE” re-oriented by 180 degrees 

“DBUSH”, “CBUSH” and “GPOST” modified 

“ARRODI”, “ARROSA”, “ARROST” modified to display hollow 

“ARROW” and “Point” level changed to MISC 

Added cells for proposed flow arrows, solid shapes 

2013 – 2014 

APRIL 2013 – JULY 2014   16 JULY 2014 CIRCULATED 

 Manual re-organized, re-structured and expanded to more clearly identify process 

and requirements for In House Capital projects, Consultant Capital projects, 

Consultant “As-Constructed” Capital projects and Consultant “As-Constructed” 

Development projects 

 Reworded the Prologue to include all drawings received by the Planning and 

Infrastructure Services i.e. Capital, Development, As Constructed 

 Changes throughout to reflect new City organization…Works & Trans replaced with 

Planning & Infrastructure Services 

 Samples modified to show new departmental logo information 

 Cell library changes… 

 Cell library updated (BRAMPTON CELLS V8i.cel) 

 New cell library added (COB-BORDER.cel) – contains City border cells 

 Cells created in BRAMPTON CELLS V8i for bases to be used in cross section 

production, explanation added to Cross Sections for use of the new cross section 

borders 
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 Level changes… 

 Removal and addition of some ROW levels 

 Removal and addition of levels in the Traffic and Lighting sections 

 Removal and addition of levels in Engineering section 

 Added notes to define PA, PD etc. in shading levels section 

 Example Project (13-3251-213 - Collector St – Arterial Rd A to Arterial Rd B) created 

and utilized throughout “In House Process for Capital Works Design” section to 

demonstrate required practices 

 OPSDs added to list of commonly used standards for New Jersey type barriers 

 Note added in “As-Constructed” sections for quality assurance checks of mylars 

received by the City, prior to acceptance of package 

 Note added in Engineering Submissions to describe use of distribution list, sample 

added to Sample Forms and Drawings 

 Common verbiage for email notification of impending XX% circulation of design 

drawings expanded 

 PUCC circulation requirements modified to include the possibility of circulating pdf 

format on CD instead of, or as well as, 13 folded hard copies 

 PUCC circulation process change noted 

 InRoads changes… 

o Updates to InRoads working sections to reflect upgraded software 

o Alternate surface creation (LIMESTONE) instructions added to Roadway 

Modeller section 

o Parametric Constraints sections added to Roadway Modeller section 

o Secondary Alignments expanded 

 Property drawing instructions expanded 

2014 – 2015 

OCTOBER 2014 – JULY 2015 20 JULY 2015 CIRCULATED 

REORGANIZTION 

 Changes to As Built section including note to direct users to the new Development 

As-Built Requirements Manual 

 Improved heading labels 

 Revised direction of manual to apply to Captial works only 

 Revised terminology…’As Built’ replaced by ‘As Constructed’ throughout 

document 

 Project identifiers - Project No. / Contract No. changed to File No. / Bid Call No. 

throughout document 

 Identified the new sub-folders in Engineering Standard Setups folder. These were 

created to make it easier to find the correct templates/drawings etc. 

 Reordered sections to put them in a more logical order 

 Reorganized manual to group reference materials in Appendices 

 References to the appropriate appendix or section added throughout to allow user 

to locate information more efficiently 

 Clarified at what stage the drawing numbers need to be assigned 

 Clarified general requirements for Capital ‘as constructed’ drawings 

 Added note to define proper display of pipe utilities over 900mm 
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 ‘Maintenance & Operations’ throughout document updated to ‘Public Works’ 

 ‘Captures’ updated throughout document as required for departmental name 

changes 

LEVELS 

 Hilighted levels to be used for ‘as constructed’ work 

 Added new levels for Unidentified Fibre cables, including text 

 Added new patterning for Tactile Walking Surface Indicator – to be placed on level 

ENG_SH_IMPRESSED 

 Added new cell for Tactile Walking Surface Indicator to BRAMPTON CELLS v8i.cel  – 

‘TWSI’ 

NEW SECTIONS 

 Added section [CIRCULATION FORMS] outlining standard templates to be used for 

circulation of PUCCs, Site Plans and Subdivision Plans received for review 

 Added section [CHECKLISTS] outlining checklists to be used by design group for 

reviews 

 Expanded on review procedures for PUCC, Site Plan and Development Plan 

submissions 

 Added instructions with respect to Appendix A and the preparation of CDs for 

consultants working on Capital projects 

SAMPLES  EXAMPLES 

 Document Templates (Appendix 3) added showing all circulation letters to be 

utilized by design group 

 Checklists (Appendix 4) added showing all checklists to be utilized by design group 

 Sample drawings replaced, as needed, to reflect new project identifiers 

 Updated cross section capture in volume calculations section to better illustrate the 

basis for volume calculations 

2015 – 2017 

AUGUST 2015 TO JANUARY 2017 16 JAN 2017 CIRCULATED 

 New simplified file structure for Consultant Submissions [Section 4-1] 

 Additional clarification of file structure for handover CD [Section 4-2] 

 Greater emphasis placed on the final property plan requirements [Section 9] 

 Expansion of descriptions defining property strip plan, roll plans & IPRPs [Section 9] 

 Circulation process better defined with expanded explanations [Sections 2&3] 

 Section Numbers added to make it easier to define the location of  information 

 Expanded & clarified CAD requirements & deliverables for each stage [Section 6] 

 New product name CAPITAL WORK DELIVERABLES used throughout, to replace 

Appendix A package to reduce confusion between the Appendix A document 

and the complete package 

 City departmental designations updated throughout 

 Added Levels for InRoads template works and scrap 

 Added levels for print areas 

 Levels re-organized to allow links to each group [Section 33-1-I to xvii] 
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 Searchable PDF Manual, links maintained for table of contents 

 Document containing additional descriptions with respect to information required 

to be shown on each type of drawing sheet, is referenced in Section 21-1 
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